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Notification System

Printer-friendly version

The Notification System allows you to completely manage all of your notification messages. Using the various
screens, you can retrieve archived messages, manage any queued messages with errors, create or modify
notification templates, search and view the notification templates set up for your institution, manually re-queue
messages, and so much more.

Note: If your institution used the alert system, you will need to have institution option UNST (Use Notification
System) set up in order to transfer alerts and messages over to using the Notification system.

Check out our QuickStart Guide to learn how to quickly create automatic emails. Creating Automatic
Emails

See the following descriptions of the screens within the Notification System to learn more about what you can
accomplish using each screen.

Notification Screens
Archive Manager Screen
Client Text Notifications Screen
Manual Notification Handler Screen
Queue Error Manager Screen
Relocation Tool Screen
Right-click Menu Notification Pop-up Screen
Solutions by Text History Screen
Solutions by Text Mapping Screen
Templates Screen
Texting History Screen
Triggers Screen
Wrappers Screen

Archive Manager Screen
Use the Archive Manager screen to retrieve archived messages. Archived messages include any message that

the Notification Processor has transmitted. This screen also allows you to search through messages using a

specific date range. When an archived message is selected, the details of the message are displayed on the

lower part of the screen. Learn More

Client Text Notifications Screen
Use the Client Text Notifications screen to search for and view text message conversations. You can also use
this screen to send and receive text messages with your customers. Learn More

Manual Notification Handler Screen
Use the Manual Notification Handler screen to manually re-queue messages. Messages with errors are sent to

this screen from the Queue Error Manager screen and archived messages are sent to this screen from the

Archive Manager screen. Learn More

https://secure.goldpointsystems.com/gpsdocs/customers/Notification/NotificationSystem.pdf
https://secure.goldpointsystems.com/gpsdocs/customers/Notification/NSQuickStart_CreatingAutomaticEmails.pdf
https://secure.goldpointsystems.com/gpsdocs/customers/Notification/NSQuickStart_CreatingAutomaticEmails.pdf
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Queue Error Manager Screen
Use the Queue Error Manager screen to search for and display all queue error messages and queued

messages that have errors. Queue errors are for messages that the Notification Processor failed to transmit.

This screen displays a maximum of 100 messages with errors at a time. When a message is selected, the

message details are displayed on the lower portion of the screen. You can select more than one message and

right-click to reattempt all of the selected messages. Note: You cannot re-queue more than one message

because the Manual Notification Handler can only handle one message at a time. Learn More

Relocation Tool Screen
Use the Relocation Tool screen to export and import notification templates and wrappers. This tool makes it
easy to export notification templates and wrappers that you were testing on your Beta machine and import
them onto your Production machine so that you don't have to re-enter any data. You simply select the the
notification templates and wrappers that you want from one machine (e.g., your Beta machine), save them as
a file on your computer, and then import that file into another machine (e.g., your Production machine). The
Relocation Tool screen also enables you to save a backup file of all your notification templates and wrappers
on your computer. Learn More

Solutions by Text History Screen
Use the Solutions by Text History screen to retrieve archived text messages and view the details of those

messages. Archived text messages include any text message that has been created. Note: This screen is

used only for third-party texting and for those institutions with Institution Option USBT set up. Learn More

Solutions by Text Mapping Screen
Use the Solutions by Text History screen to select a Solutions by Text template and map it to a specific

template within the Notification System. You can also create new mapped templates, delete mapped

templates no longer used, and modify mapped templates. Note: This screen is used only for third-party texting

and for those institutions with Institution Option USBT set up. Learn More

Templates Screen
Use the Notification Templates screen to create, modify, or delete notification templates. You can also use
this screen to view the notification templates set up for your institution, delete notification templates, activate
inactive notification templates, and to render a test notification to ensure that the body, subject, etc. of a
notification have been set up correctly. This screen combines the functionality of the Template Detail screen
and the Template Summary screen. Learn More

Texting History Screen
Use the Texting History screen to retrieve archived text messages and view the details of those messages.

Archived text messages include any text message that has been created. This screen also allows you to

narrow your search of text messages using a variety of search parameters. When an archived text message is

selected, the details of the message are displayed in a pop-up dialog. You can also save your data to a CSV

file. Learn More

Triggers Screen



Notification System8

© 2021 GOLDPoint Systems.Last updated: 2/17/2021

Use the Triggers screen to build, manage, and test notification triggers. Triggers allow you to automatically

send notifications (texts, emails, and HTML emails) at scheduled times to a list of accounts. For example, you

can use this screen to send a text to all text-capable borrowers at 9:00 AM their time every time a payment is

five days late or you could set up a trigger to send an email to all borrowers every month. Notification triggers

make it so that you no longer have to worry about manually sending notifications, everything is automatic.

Learn More

Wrappers Screen
Use the Notification Wrappers screen to create, modify, or delete notification wrappers. You can also use this
screen to view the notification wrappers set up for your institution, search for a specific wrapper, activate
inactive notification wrappers, and to render a test wrapper to ensure that the header, footer, etc. of a wrapper
have been set up correctly. Wrappers are the institution branding that is applied to the notifications. Wrappers
display your institution's logos, advertising, and selected wording in the header and footer of the notification.
Learn More

Back to Top

This Notification System is accessed by going to the Notification section in CIM GOLD.

Notification System in the CIM

GOLD Tree View

Back to Top
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System Basics

Use these help sections to become familiar with the basic terminology used in CIM GOLD help documentation.

This help section also contains information about common CIM GOLD functions and general information about

the program.

See the help sections below to learn more system basics:

Basic CIM GOLD Concepts and Terminology

Customer Search Screen

Right-Click Functionality

General Navigation Information

Using Help
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Basic CIM GOLD Concepts and Terminology

This help section explains basic concepts essential to understanding CIM GOLD.

Afterhours Processing

Alert Bar

Dollar and Rate Amounts

Error Provider Icon

Field

File Maintenance

List Icon and List View

Mnemonic

Security

Warning Provider Icon

Afterhours Processing

Afterhours Processing refers to the information processing that occurs during the night. This processing

typically includes printing reports and statements, sending ACH transmissions, amortizing fees, generating

notices, processing late charges, assigning delinquency statuses, and much more. Afterhours processing is

automatically performed by GOLDPoint Systems programs. Many Update Functions are set up when

institutions first convert onto GOLDPoint Systems. Update Functions are set up by GOLDPoint Systems

and they tell the system when certain activity should occur in the afterhours (such as when to assess late

charges or when to automatically charge off severely delinquent accounts).

Back to top

Alert Bar

The red alert bar at the top of screens explains certain alerts and account statuses. For more information,

see the Account Status topic in the Loans system.

Back to top

Dollar and Rate Amounts

Generally, the system enters decimal points and commas in numeric Fields as necessary. However, these

symbols can also be added manually. Do not forget to proofread data before saving, particularly in regards to

changes on customer accounts.

https://secure.goldpointsystems.com/gpsdocs/loans/LoansCIMGOLD/index.asp?accountstatus.asp
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Back to top

Error Provider Icon

These icons appear on CIM GOLD screens to indicate which which Fields are mandatory (or require an error

correction). If this icon appears on any screen, data cannot be saved until all errors are corrected. If this icon

appears on next to a field on any screen, you will not be able to save any changes until all errors are

corrected. If you hover your cursor over the error provider, the system gives you additional information as to

what is causing the error, as shown below:

Back to top

Field

Field is the term used to describe a location on a CIM GOLD screen where data is entered (either by a user

or the system) and/or displayed. See File Maintenance below for more information about how fields are

populated with information.

CIM GOLD field examples

There are 6 basic types of CIM GOLD fields:
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· Alphanumeric/Numeric: Data input fields where numbers and/or letters are entered and displayed
(see GOLDTrak PC Application # field in the example screenshot above).

· Checkbox: Square fields that are either populated with a checkmark or left blank to indicate whether
a certain function/option) is present/active (see Purchased/Dealer field in the example screenshot
above).

· Date: Calendar input fields that allow the user to select a date (see Conversion Date field in the
example screenshot above).

· Drop-down Menu: Fields that are populated by making a selection from a menu that appears when
the field button is clicked (see Origination Code field in the example screenshot above).

· List View: A table that display information relevant to the current screen, divided into columns and
rows (see table at the bottom of the example screenshot above). Data is typically added to list views
(and can often be edited) via other CIM GOLD fields. Right-Clicking on most list views opens up a
menu that allows the user to access editing, printing, exporting, and resizing functions. Clicking
column headers in most list views organizes the list view's information by that column's information
type (either in alphabetical or numeric order).

· Radio Button: Similar to checkbox fields; circular fields that are either selected or left blank to
indicate whether a certain function (or option) is present (or active). Radio buttons are typically used in
pairs or groups where only one can be selected at a time (see Percent and Dollar fields in the
example screenshot above).

Back to top

File Maintenance

File Maintenance (commonly abbreviated as "F/M") is the term used to describe information being entered or

changed in CIM GOLD Fields. If information can be manually added to a Field by the user, it is considered

file maintainable. Not all CIM GOLD Fields are file maintainable, and Field-Level Security can be set up to

limit the file maintenance on certain Fields depending on your institution's needs. Some Fields are file

maintained by the system and populated automatically.

Back to top

List Icons and List Views

For many fields in CIM GOLD, you click a list icon  to view and select possible entries for that field.

Information for these lists are populated by GOLDPoint Systems, or in some cases, by someone at your

institution who sets up information using the Loans > System Setup Screens or one of the Deposits >

Definitions screens.

The following is an example of a list that appears after a user clicks the list icon:

https://secure.goldpointsystems.com/gpsdocs/loans/LoansCIMGOLD/index.asp?fieldlevelsecurityscreen.asp
https://secure.goldpointsystems.com/gpsdocs/loans/LoansCIMGOLD/index.asp?systemsetupscreen.asp
https://secure.goldpointsystems.com/gpsdocs/deposits/DepositCIMGOLD/index.asp?depdefinitionsmasterhelp.asp
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List views are tables of information about a given account. They usually appear at the top of many screens,

as shown below:

You can right-click any list view to export the data to a spreadsheet. For more about list view tables, see

Right-click Functionality.

Back to top
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Mnemonic

A mnemonic is a code number assigned to a Field. Mnemonics are mainly used by GOLDPoint Systems

personnel. See the GOLDWriter User's Guide on DocsOnWeb for more information. The mnemonics of CIM

GOLD fields are indicated alongside the fields in Help tables, as shown below. The Mnemonic Dictionary

button at the top-right of the F1 Help dialog opens the GOLDWriter Mnemonic Dictionary in a separate

dialog. This dictionary provides the CIM GOLD source location for GOLDWriter field mnemonics.

Back to top

Security

CIM GOLD requires a user name and security code, which must be set up by your institution for individual

employees. See the CIM GOLD Security topic for more information.

In addition, Field-level Security can be set up to limit the File Maintenance on certain Fields depending on

your institution's needs (see also the Security > Setup screen help). For example, if a certain employee's

job does not require data entry of any kind, your institution can limit that employee's use of CIM GOLD to

simply viewing customer information rather than editing it.

Back to top

Warning Provider Icon

This icon functions similarly to the Error Provider icon (above). Warning provider icons appear on CIM

GOLD screens (as yellow triangles, see below) to indicate which Fields contain potentially problematic

errors. Hover your cursor over the icon to view additional information about the cause of the error. The main

difference between these icons and Error Provider icons is that changes to the current CIM GOLD screen

can still be saved if a warning provider icon is present.

https://secure.goldpointsystems.com/gpsdocs/reports/GOLDWriter/index.asp
https://secure.goldpointsystems.com/gpsdocs/reports/GOLDWriter/index.asp?goldwriterfielddefmain.asp
https://secure.goldpointsystems.com/gpsdocs/reports/GOLDWriter/index.asp?goldwriterusersguide.asp
https://secure.goldpointsystems.com/gpsdocs/other/SecurityCIMGOLD/index.asp?securityscreensmasthelp.asp
https://secure.goldpointsystems.com/gpsdocs/other/SecurityCIMGOLD/index.asp?fieldlevelsecurityscreen.asp
https://secure.goldpointsystems.com/gpsdocs/other/SecurityCIMGOLD/index.asp?securitysetupscreen.asp
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Back to top

See the help pages below to learn more system basics:

Right-Click Functionality

General Navigation Information

Using Help
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Customer Search Screen

The Customer Search screen is the first screen that appears when CIM GOLD is opened in the standard

interface. It can also be accessed from the top of the CIM GOLD tree view.

Use this screen enter selection criteria to find an account owner, account number, address, or card number.

After pressing <Enter> or clicking the <Submit> button, results are displayed in the Search Results list view

(and Names Downloaded fields) to the right. Single-clicking an item in this box will reveal additional customer

information in the Account Numbers list view.

See the following example of the Customer Search screen.

CIM GOLD Customer Search Screen

You will likely be able to find the customer's information you want just by entering information in the Name

field. However, if your search returns too much information, you can limit the search by entering more search

criteria in the fields. You may first need to click , and then new information in any of the following

field groups:
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CIF Search Parameter

Account Parameters

LOC Card Parameter

Individual ID Parameter

Card Parameters

If your search returns more accounts than can be shown in the Search Results list view, click the

 or  buttons to scroll through the list of accounts.

Note: You can set up an option to limit the number of account that can be shown

on the Search Results list view. This option, Max Nbr to Display in Customer

Search, is set up under the Options > User Preferences menu.

The Displaying field shows the range of search results you are looking at. The list view can only show up to 50

results at a time, so this field explains which numbers are displayed. For example, for the first 50 names, this

field would display "0 thru 50 hits." If you click , this field would then display  "50 thru 100

hits," and so on (see example below).

Tips on Searching

The following are a few hints to help you use the Customer Search screen:

· If you are unsure of the spelling of a name, type at least the first two letters of the last name in the
Name field. For example, if you know your customer's last name begins with Sm (such as Smith or

Smythe), type "SM," and then click . 

· You can limit a name search by typing the last name, a space, and the first letter of the first name in
the Name field. For example, to look up John Smith, type "Smith J."

· Clicking  at the bottom of the screen will quickly clear all data in search fields and list
views.

Note: If you do not have security to view employee accounts (set up on the

Security > Setup screen), then balance information will be blank for any names

marked as an employee. If the Is Employee field (NDISEM), the Is Officer field

(NDISOF), or both fields are checked for a customer on the Customer Relationship

Management > Households screen, then the system will read accounts tied to that

customer as employee accounts.

https://secure.goldpointsystems.com/gpsdocs/other/CIMGOLD/index.asp?userpreferences_cgug.asp
https://secure.goldpointsystems.com/gpsdocs/other/SecurityCIMGOLD/index.asp?securitysetupscreen.asp
https://secure.goldpointsystems.com/gpsdocs/customers/CIFCIMGOLD/index.asp?householdsscreen.asp
https://secure.goldpointsystems.com/gpsdocs/customers/CIFCIMGOLD/index.asp?householdsscreen.asp
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Security

In order to use this screen, your institution must:

· Subscribe to it on the Security > Subscribe To Mini-Applications screen.

· Set up employees and/or profiles with either Inquire (read-only) or Maintain (edit) security for it on

the CIM GOLD tab of the Security > Setup screen.

https://secure.goldpointsystems.com/gpsdocs/other/SecurityCIMGOLD/index.asp?subscribetomini-applicationsscreen.asp
https://secure.goldpointsystems.com/gpsdocs/other/SecurityCIMGOLD/index.asp?cimgoldtab_secsets.asp
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CIF Search Parameters field group

The fields in this field group on the Customer Search Screen are used to search for accounts based on

customer information, including names, identification numbers, phone numbers, and addresses.

To further refine your search, use the Account Parameters fields.

The fields in this field group are as follows:

Field Description

Name To search for an account by a customer's last name, type in all or part of the

name in this field. To perform the search, press <Enter> or click <Submit>. Any

matching results will be displayed in the list view to the right.

You will likely be able to find the customer's information you want just by entering

information in this field. However, if your search returns too much information, you

can limit the search by entering more search criteria in the other fields in this field

group. You can also limit a name search by typing the last name, a space, and

the first  letter of the first name in the Name field. For example, to look up John

Smith, type "Smith J."

SSN/EIN/IDN/Card

Last 4 Radio Buttons

Use the SSN, EIN, IDN, or Card Last 4 to search for a specific customer using a

type of identification number.

· SSN is for Social Security number.

· EIN is for Employee Identification number.

· IDN is for the customer's identification number, as set up on the

Customer Profile screen. The IDN is defined and assigned by your

institution. See also the Individual ID Parameter Number.

· Card Last 4 is for the last 4 digits of a customer's card number (if

applicable).
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After selecting the appropriate radio button, enter the actual number in the text

field below.

To perform the search, press <Enter> or click <Submit> and any matching

results will be displayed in the list view to the right.

These fields will not be file maintainable if Default Office is marked.

Phone To search for an account by a customer's telephone number, type the number in

this field. This can be a business, home, cell, or other phone number tied to the

account holder in the CIF system. Hint: You only need to type in numbers, and

the system will add dashes or parenthesis.

If you check the Foreign Phone checkbox, the system will only search for

phone numbers designated as foreign (as set up on the Customer Relationship

Management > Households screen).

This field will not be file maintainable if Default Office is marked, unless Foreign

Phone is also marked.

To perform the search, press <Enter> or click <Submit> and any matching

results will be displayed in the list view to the right.

Address/Email You can search by address or e-mail address by selecting the appropriate radio

button, and then entering the address in the text field belowd. 

· For physical address, this can be a business, home, P.O. box, or other

address tied to the account holder in the CIF system. To update physical

addresses, use the Customer Relationship Management (CIF) >

Households screen, Addresses tab.

· For e-mail address, any part of the e-mail address can be entered in this

field. For example, if an e-mail address was "maryjones@email.com,"

you could just enter "maryjones" and the system would find it. Or you

could enter the complete address. However, only 13 spaces are

available, so e-mail addresses will likely need to be shortened. E-mail

addresses are set up for customers using the Customer Relationship

Management (CIF) > Households screen, Email tab.

To perform the search, press <Enter> or click  and any matching results

will be displayed in the Search Results list view to the right.

Email options will not be available if Default Office is marked.

View Closed

Accounts

Check this box if you want to include closed accounts in your search. Closed

accounts are accounts that have not been sent to archives, but have closed due

https://secure.goldpointsystems.com/gpsdocs/customers/CIFCIMGOLD/index.asp?householdsscreen.asp
https://secure.goldpointsystems.com/gpsdocs/customers/CIFCIMGOLD/index.asp?addressestabcrmh.asp
https://secure.goldpointsystems.com/gpsdocs/customers/CIFCIMGOLD/index.asp?emailtabcrmh.asp
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to a payoff, charge off, or write off. Your institution determines when closed

accounts are moved to archives (institution option ARCM). Another institution

option, OFLM, determines when archived accounts are completely removed from

the system and can no longer be searched for.

This option can also be set through the User Preferences screen (Under Options

in the top menu bar in CIM GOLD).

View Released

Accounts

Checking View Release Accounts includes accounts that have been released

(LNRLSD = "Yes") in your search.

This option can also be set through the User Preferences screen (Under Options

in the top menu bar in CIM GOLD).

View Unopened

Accounts

Check the View Unopened Accounts box if you want to include accounts that

have not been opened in your search. This could include accounts where the loan

process was initiated in GOLDTrak, but the loan wasn't funded and opened.

This option can also be set through the User Preferences screen (Under Options

in the top menu bar in CIM GOLD).

View Archived

Accounts

Check the View Archived Accounts box if you want to include accounts that

have been archived. Your institution determines when closed accounts are moved

to archives (institution option ARCM). Another institution option, OFLM,

determines when archived accounts are completely removed from the system and

can no longer be searched for.

This option can also be set through the User Preferences screen (Under Options

in the top menu bar in CIM GOLD).

https://secure.goldpointsystems.com/gpsdocs/other/CIMGOLD/index.asp?userpreferences_cgug.asp
https://secure.goldpointsystems.com/gpsdocs/other/CIMGOLD/index.asp?userpreferences_cgug.asp
https://secure.goldpointsystems.com/gpsdocs/other/CIMGOLD/index.asp?userpreferences_cgug.asp
https://secure.goldpointsystems.com/gpsdocs/other/CIMGOLD/index.asp?userpreferences_cgug.asp
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Account Parameters field group

The Account Parameters fields on the Customer Search Screen can be used to search for accounts based

on the office or account number.

To search for an account by a customer's office number, type the number in the Office field. Hint: You do not

need to type zeros that come first in the office number. For example, if the office number were "0001," you can

enter just "1" in this field and the system will automatically add the preceding zeros.

To search for an account by a customer's account number, type the number in the Account field. Hint: You do

not need to type zeros that come first in the account number. For example, if the account number were

"000000009," you can enter just "9" in this field and the system will automatically add the preceding zeros.

Marking the Default Office checkbox field will automatically enter the office number you are signed on with in

the Office field. Marking this field disables the SSN/EIN/IDN/Card Last 4, Phone, Email, LOC Card Parameter,

Individual ID Parameter, and Card Parameter fields.

To perform the search, press <Enter> or click <Submit> and any matching results will be displayed in the list

view to the right.



Notification System 23

© 2021 GOLDPoint Systems. Last updated: 2/17/2021

LOC Card Parameter field group

This field is only available if Institution Option HSLC is set up for your institution. Use this field to indicate a

LOC card number to search the system for on the Customer Search Screen.

To perform the search, press <Enter> or click  and any matching results will be displayed in the

Search Results list view to the right.

This field will not be file maintainable if Default Office is marked.

https://secure.goldpointsystems.com/gpsdocs/other/InstitutionOptions/oio18.asp?zoom_highlight=HSLC
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Individual ID Parameter field group

This field is only available if Institution Option HSID is set up for your institution.

The Individual ID Number is a master number given to a single customer. The Individual Identification

Number links all deposit accounts, loan accounts, LOC cards, safe deposit boxes, etc., for a customer. 

To search for an account by a customer's Individual ID Number, type the number in this field. This number is

tied to the account owner in the CIF system (found on the Customer Relationship Management (CIF) >

Households screen > Names tab > Detailed Personal Information tab).

To perform the search, press <Enter> or click  and any matching results will be displayed in the

Search Results list view to the right.

This field will not be file maintainable if Default Office is marked.

https://secure.goldpointsystems.com/gpsdocs/other/InstitutionOptions/oio18.asp?zoom_highlight=HSID
https://secure.goldpointsystems.com/gpsdocs/customers/CIFCIMGOLD/index.asp?detailedpersonalinfocrmh.asp
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Card Parameters field group

These fields are only available if Institution Option HSCP is set up for your institution. Use these fields to

indicate card information to search the system for on the Customer Search Screen. An ANSI Nbr and/or Card

Number can be indicated.

To perform the search, press <Enter> or click  and any matching results will be displayed in the

Search Results list view to the right.

These fields will not be file maintainable if Default Office is marked.

https://secure.goldpointsystems.com/gpsdocs/other/InstitutionOptions/oio18.asp?zoom_highlight=hscp
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Customer Search list views

The Search Results list view at the top right of this screen displays all search results matching the search

parameters indicated in the fields on the Customer Search screen. It shows the customer's name as well as

information about the associated SSN/EIN/IDN, household, sequence and telephone numbers. The Match

column shows which of your search criteria the returned item matched. To print the list, right-click on the list

view and use the print menu options that appear.

When you have found the customer you were searching for, single-click on the name and information about all

accounts tied to that name will appear in the Account Numbers list view at the bottom right of this screen.

· If you click on an account number in this list, it will highlight that account. 

· If you double-click an account in this list, it takes you to the main screen in deposits or loans

(depending on which type of account you clicked). 

· To print the list, right-click on the list view and use the print menu options that appear.

Above the Account Numbers list view are fields displaying the number of names that were Downloaded and

which accounts are currently displayed in the Search Results list view (Displaying). That list view can only

show up to 50 results at a time, so the Displaying field explains which numbers are displayed. For example,

for the first 50 names, this field would display "0 thru 50 hits." If you click , this field would then

display "50 thru 100 hits," and so on (see example below).
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Right-Click Functionality

Depending on where you click in CIM GOLD, and what additional features you have, different pop-up selections
appear when right-clicking in CIM GOLD.

Right-clicking on List View Tables

Right-clicking on most list view tables in CIM GOLD opens up a menu, as shown below:

The functions accessed from this menu are as follows:

Edit Use this menu to copy cell data (or select all cell data to be copied). Once list view

data is copied, it can be pasted into another program (such as Microsoft® Excel.

Printing Use this menu to print information from a list view. Printer/paper setup, print previews,
page orientation, and margin settings can all be set from this menu.

Export Use this menu to export the list view directly to another file or program. The three
possible export choices are:

· Export to Report Manager: Select this function to export the data in the list view to
the GOLDPoint Systems Report Manager program.

· Export Selection to Tab Delimited Text File: Select this function to save the
selected portion of the list view as a tab-delimited text file. Any tab-delimited

program (or even Microsoft® Word, Wordpad, or Notepad) can then be used to
review the selection.

· Export All To Tab Delimited Text: Select this function to save the entire list view

as a tab-delimited text file. Any tab-delimited program (or even Microsoft® Word,
Wordpad, or Notepad) can then be used to review the selection.

Auto
Resize

Use the this menu to resize the list view table in order to display all data. The three
possible resize choices include:

· Auto Resize Grid: Resizes the entire list view (both columns and rows) to fit the
data.

https://secure.goldpointsystems.com/gpsdocs/reports/ReportManager/orm.asp
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· Auto Resize Columns: Resizes columns only.

· Auto Resize Rows: Resizes rows only.

Find Use this function to enter terms to use in searching the list view. After <Find> is
clicked, the system displays all matching information in a table. Select an item in the
table to be redirected to that item in the original list view.

Right-clicking on Tree Navigation

Right-clicking on the left tree navigation allows you to bring up a pop-out screen of CIM GOLD. See

Pop-out Screens in the General Navigation Information section for more information.

Right-clicking on Screens

After finding and selecting an account, and then accessing any screen in CIM GOLD, you can right-click

the screen and a pop-up menu appears. This pop-up menu may be different depending on which features

your institution has set up.

For example, if your institution uses File Services Plus, the following menu appears:

For more information on File Services Plus, see the user's guide in DocsOnWeb.

https://secure.goldpointsystems.com/gpsdocs/other/FileServicesPlus/index.asp?fileservicesplusscreen.asp
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Notice the Send Alert selection:

This function allows you to send either an email or text alert to the account owner. This is part of the

Notification System. For more information, see the Right-click Menu Notification Pop-up Screen topic in

the Notification System User's Guide.

GOLD Document Imaging

If your institution uses GOLDDocument Imaging, then the following functions appear when you right-click

a screen in CIM GOLD:

GOLDPoint Systems is phasing out GOLDDocument Imaging to use File Services Plus instead.

See these other help pages to learn more system basics:

Basic CIM GOLD Concepts and Terminology

General Navigation Information

Using Help

https://secure.goldpointsystems.com/gpsdocs/customers/Notification/index.asp?rightclickmenupopupnmnh.asp
https://secure.goldpointsystems.com/gpsdocs/other/FileServicesPlus/index.asp?fileservicesplusscreen.asp
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General Navigation Information

This topic provides general instructions for navigating in CIM GOLD. See the following subtopics:

Navigating CIM GOLD

Pop-out Screens

Finding Customer Accounts

Navigating CIM GOLD

In CIM GOLD, the tree view on the left side of the screen is used to access all CIM GOLD screens, as

shown below:

CIM GOLD tree view

There are two ways to navigate this tree view:

· Manually click through the tree view by expanding screen groups until you locate the desired screen. For

example, in order to access the Account Detail screen, the Loans screen group must be expanded (by

clicking on the grey "+" symbol to the left), followed by the Account Information screen group. The

Account Detail screen is part of the Account Information screen group.

https://secure.goldpointsystems.com/gpsdocs/loans/LoansCIMGOLD/index.asp?loansaccountinformation.asp
https://secure.goldpointsystems.com/gpsdocs/loans/LoansCIMGOLD/index.asp?loansdocsonwebmain.asp
https://secure.goldpointsystems.com/gpsdocs/loans/LoansCIMGOLD/index.asp?loansaccountinfomasterhelp.asp
https://secure.goldpointsystems.com/gpsdocs/loans/LoansCIMGOLD/index.asp?loansaccountinformation.asp
https://secure.goldpointsystems.com/gpsdocs/loans/LoansCIMGOLD/index.asp?loansaccountinfomasterhelp.asp
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· Use the search function beneath the tree view. Enter search terms in the search field, and the system

will search for matching screen names. For example, entering "Collateral" in the search field will locate

the Loans > Collateral Detail screen.

All CIM GOLD Help screens indicate the navigation necessary to locate the selected screen, tab, or field

group by using breadcrumb navigation as shown below:

Navigation information provided on help screen

Back to top

Pop-out Screens

One nice feature about the left tree navigation is that each screen can be opened separately in a pop-out

window. The great thing about this feature is that you can be working on one screen with one account, pop

that screen out on its own, then navigate back to CIM GOLD to other screens or to view other accounts. 

To pop-out a screen, simply right-click the screen name in the left tree navigation. The following dialog

appears:

https://secure.goldpointsystems.com/gpsdocs/loans/LoansCIMGOLD/index.asp?collateraldetailscreen.asp
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When you select "Open Screen in new CIM," the screen opens in a separate window with the selected

account displayed. You can go back to the previous CIM GOLD instance and access other screens and

accounts. The pop-out screen will remain on the account that was selected at the time. In the example

screenshot below, see that one pop-out instance of CIM GOLD has been created and set to view one client's

information on the Account Detail screen while the original instance of CIM GOLD is able to view another

client's information on the Additional Loan Fields screen:

Back to top

Finding Customer Accounts

The first screen that appears after the user logs in to CIM GOLD (and the screen at the top of the tree view)

is the Customer Search screen. Use this screen to find the person or account whose information you want

to view or edit

Additionally, there are several buttons and fields at the top CIM GOLD that allow the user to access a

customer account quickly, as shown below:

https://secure.goldpointsystems.com/gpsdocs/customers/CIFCIMGOLD/index.asp?customersearchscreen.asp
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· Clicking First takes the user to the (numerically) first account in your institution's system.

· Clicking Previous takes the user to the (numerically) previous account.

· The Fast Goto Account fields can be used to manually enter the desired account number.

· Clicking Next takes the user to the (numerically) subsequent account.

· Clicking Last takes the user to the (numerically) last account in your institution's system.

The two green arrow buttons to the left of the First button can be used to cycle through your CIM GOLD

usage history since login. They function identically to the "Back" and "Forward" functions in standard

Internet browsers.

Back to top

For information about the menus in CIM GOLD, see help for the Main Menu Bar. See the help pages below to

learn more system basics:

Basic CIM GOLD Concepts and Terminology

Right-Click Functionality

Using Help

https://secure.goldpointsystems.com/gpsdocs/other/CIMGOLD/index.asp?menubar_cgug.asp
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Using Help

To view help documentation for specific field groups, tabs, or screens directly from CIM GOLD, place your

cursor in the desired field (or, for screen help, make sure no field is selected in the opened screen) and press

<F1> on your keyboard (or select Mini-Application Help from the Help menu on the Main Menu Bar). A new

F1 Help dialog will open (an example is shown below).

CIM GOLD <F1> Help Example Page

CIM GOLD help documentation provides information about the use of fields and screens in CIM GOLD and also

typically includes mnemonic information (as explained in Basic CIM GOLD Concepts and Terminology) as well

as breadcrumb navigation information (as explained General Navigation Information). The table of contents on

the left side of the dialog can be used to locate other CIM GOLD help documentation and is organized

identically to the CIM GOLD tree view.

CIM GOLD help documentation is organized into screens, tabs, and field groups. Information about individual

fields is organized into tables which can be viewed on field group/tab help pages. Pressing F1 with your cursor

in a CIM GOLD field will open F1 Help to the selected field's location on the relevant help page.

Searching Help

· To search only the current CIM GOLD system for certain keywords, use the Search tab above the table

of contents on the F1 Help dialog.

· To search the entire CIM GOLD help database, select "Master Help Search" from the Help menu on

the Main Menu Bar to open the Master Help File (shown below) and navigate to the Search tab there. 

https://secure.goldpointsystems.com/gpsdocs/other/CIMGOLD/index.asp?menubar_cgug.asp
https://secure.goldpointsystems.com/gpsdocs/other/CIMGOLD/index.asp?menubar_cgug.asp
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Follow the instructions below to optimize your search.

CIM GOLD Master Help File

1. On the Search tab (shown below), enter search terms in the search field and click <Display>. The

system will search for matching text within the help system. Placing quotation marks around a search

phrase (e.g., "amortization method") forces the system to only find terms matching that exact phrase.

The screen the field is found on is displayed in the Location column. There may be more than one

instance of that term, therefore, the Location may come in handy to quickly find the information you

are looking for. See below:
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In the example above, the term "amortization method" was searched. After selecting the Location of

Amortizing Fees and Costs screen, each instance of "amortization method" is highlighted.

2. The system will display a list consisting of the Title, Location, and relevancy Rank of all help topics

that include the search term. Click any column header to organize the list by that column's information

type.

3. Select a help topic in the list to view that topic on the main help screen (the master help search

function and help topic list will still be visible on the left). All phrases matching the search phrases will

be highlighted blue within the text of the help topic.

To tailor a search further:

· Use the Search previous results field to indicate whether the search is performed within the results of

your previous search.

· Use the Match similar words field to indicate whether search results should include any words similar

to the search terms entered.



Notification System 37

© 2021 GOLDPoint Systems. Last updated: 2/17/2021

· Use the Search titles only field to indicate whether the system search should only return results within

help topic titles (not main text)

Clicking the arrow button to the right of the search field reveals a list containing the words AND, OR, NEAR,

and NOT. These words can be used to qualify terms entered in the search field and function as follows:

· AND - The system will only display results containing both words, not necessarily together.

· OR - The system will display results containing either word.

· NEAR - The system will display results in which both words appear close to each other.

· NOT - The system will display results in which the first word appears and the second word does not.

Help Options

The Back and Forward buttons can be used to cycle through your F1 Help usage history. They function

identically to the "Back" and "Forward" functions in standard Internet browsers.

See the help pages below to learn more system basics:
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Basic CIM GOLD Concepts and Terminology

Right-Click Functionality

General Navigation Information
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Archive Manager Screen

Use the Archive Manager screen to retrieve archived messages. Archived messages include any message that

the Notification Processor has transmitted. This screen also allows you to search through messages using a

specific date range. When an archived message is selected, the details of the message are displayed on the

lower part of the screen.

How To Items
This screen allows you to:

· Export a report of the archived messages

· Print a report of the archived messages

· Render an archived message

· Re-size columns and rows in the Archive Manager list view

· Search for archived messages by account number

· Search for archived messages by date

· Search for archived messages by template ID

· Search the results in the Archive Manager list view

· Select an archived message to edit and resend using the Manual Notification Handler screen

· View the details of an archived message

Additional Information

For an example of this screen and definitions of each of the fields on this screen, see the Notification Archive

Manager Screen Details section. 

This screen is accessed by going to Notification > Archive Manager in the CIM GOLD tree view.
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Notification Archive Manager Screen

See also:

Notification Archive Manager Screen Details

Manual Notification Handler Screen

Notification System
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Archive Manager Screen Details

Use the Archive Manager screen to retrieve archived messages. Archived messages include any message that
the Notification Processor has transmitted. 

This screen also allows you to search through messages using a specific date range. When an archived

message is selected, the details of the message are displayed on the lower part of the screen.

See the following example of this screen followed by field and button descriptions.

Notification Archive Manager Screen

Field Descriptions

Field Description

Start Date Enter a beginning date to use for your search parameter. Enter the

date using MM/DD/YYYY format, or use the drop-down calendar to

select the date.

End Date Enter an ending date to use for your search parameter. Enter the date

using MM/DD/YYYY format, or use the drop-down calendar to select

the date.

Account Enter an account number in this field to search the Archived

Messages database and display archived messages that were sent

with the account number entered in this field.
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Field Description

Recipient Enter a phone number or email address for a recipient in this field to

search the Archived Messages database and display archived

messages that were sent with the recipient entered in this field.

Template ID Enter a template ID number in this field to search the Archived

Messages database and display archived messages that were sent

with the template ID number entered in this field.

Wrapper ID Enter a wrapper ID number in this field to search the Archived

Messages database and display archived messages that were sent

with the wrapper ID number entered in this field.

Template Type Select a template type from this drop-down field to search the

Archived Messages database and display archived messages that

were sent with the selected template type.

Archive Manager List View This list view displays all the archived messages that meet the

parameters entered in the Selection Criteria fields. Archived

messages include any message that the Notification Processor has

transmitted.

The following columns appear in this list view and can be used to sort:

· Archive ID: This displays the archive identification number

assigned to the archived message.

· Account Number: This displays the account number that the

message is tied to.

· Time Sent: This displays the last time the message was sent.

· Template ID: This displays the identification number of the

template.

· Wrapper ID: This displays the identification number of the

wrapper.

· Template Description: This displays the description of the

template.

· Template Type: This displays the type of template used to create

the message.

· Effective Date: The displays the date the message became

effective in MM/DD/YYYY format.

· Has Errors: This displays whether or not the message has errors

(a check in this column indicates that the message has errors).

· Sent: This displays whether or not the message has been sent (a

check in this column indicates that the message was sent). If the

status of a notification is "Restricted" or "Failed," the Sent box is

not checked and the row will be highlighted red.

· Recipient: This displays the email address or phone number of

the message's intended recipient.
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Field Description

Account Number Display This field displays the account number that the message is tied to.

Destination Address This field displays the destination server address.

Subject This field displays the subject line of the notification.

Status Details This field displays the status of the notification and the status

message.

Message This field displays the body of the message.

Template ID Display This field displays the identification number of the template.

Template Type Display This field displays the type of template used to create the message.

Destination Port This field displays the destination port.

Errors This field displays the error code and a description of the error that

occurred.

Effective Date This field displays the date the message became effective in

MM/DD/YYYY format.

Back to Top

Button Descriptions

Button Description

<Read> Click this button to read the Notification Processor and display all the

queue error messages and queued messages with errors that fit the

search parameters. See the Search for Archived Messages section for

more details.

<Previous> Click this button to search for messages that match the selection

criteria before your current selection.

<Next> Click this button to search for messages that match the selection

criteria after your current selection.

<View Message> Click this button to display the message as it would render (display in

an HTML renderer) if the processor uses the current effective

template. See the Render a Message section for more details.

<Edit/Resend Message> Click this button to open the selected archived message with the

Manual Notification Handler screen with all of the data populated so

the message can be altered and re-queued. See the Select a

Message to Edit/Resend section for more details.
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Back to Top

See also:

View Message Details

Search for Archived Messages

Select a Message to Edit/Resend

Notification Archive Manager Screen
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Export or Print a Report

You can create a report of the archived messages in the Archive Manager list view using the Archive Manager

screen.

This screen allows you to:

· Export a report of the archived messages

· Print a report of the archived messages

Export an Archived Messages Report

There are three different ways to export the Archive Manager Report:

1. Export to Report Manager

2. Export Selection to Tab Delimited Text File

3. Export All to Tab Delimited Text

Export to Report Manager

To export a report of the archived messages in the Archive Manager list view to Report Manager:

1. Right-click on the Archive Manager list view.

Right-click Menu with Export to Report Manager Selected

2. Select Export > Export to Report Manager to open the Save As dialog.
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Save As Dialog

3. Enter the name of the report in the File name: field and click <Save>.

4. The report is saved and automatically opens in Report Manager.

Archive Manager Report in Report Manager

Back to Top

Export Selection to Tab Delimited Text File

To export a report of a single archived message from the Archive Manager list view to a tab delimited text file:

1. Select a message in the Archive Manager list view.

2. Right-click on the selected message to open the Right-click menu.
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Right-click Menu with Export Selection to Tab Delimited Text File Selected

3. Select Export > Export Selection to Tab Delimited Text File to open the Save As dialog.

Save As Dialog

4. Enter the name of the report in the File name: field and click <Save>.

5. The report is saved.

Archive Manager Selection Report in Tab Delimited Text File

Back to Top

Export All to Tab Delimited Text File

To export a report of the archived messages in the Archive Manager list view to a tab delimited text file:
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1. Right-click on the Archive Manager list view.

Right-click Menu with Export All to Tab Delimited Text Selected

2. Select Export > Export All to Tab Delimited Text to open the Save As dialog.

Save As Dialog

3. Enter the name of the report in the File name: field and click <Save>.

4. The report is saved.

Archive Manager Report in Tab Delimited Text File
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Back to Top

Print an Archived Messages Report

To print a report of the archived messages in the Archive Manager list view:

1. Right-click on the Archive Manager list view.

Right-click Menu with Printing Selected

2. Select Printing > Page Setup to open the Page Setup dialog.

Page Setup Dialog

3. The Archive Manager Report is a wide report, so you will want to change the orientation to Landscape

and narrow the margins to 0.5 to fit the report on the page.

4. Click <OK> to apply the new settings.

5. Right-click on the Archive Manager list view again.
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Right-click Menu with Printing Selected

6. Select Printing > Print to print the Archive Manager Report. Note: You can select Printing > Print

Preview to preview the report before actually printing it. You can also change the printer that you are

using and the printer's settings by selecting Printing > Printer Settings.

7. The Archive Manager Report is printed using the printer set up in Printing > Printer Settings.

Archive Manager Report Example

Back to Top

See also:

Search for Archived Messages

Notification Archive Manager Screen

Notification Archive Manager Screen Details
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Render a Message

You can render an archived message using the Archive Manager screen. This is useful if you want send an

archived notification again. Using the render tool, you can view the notification to ensure that it is the correct

notification that you want sent again. You can also see if any changes need to be made before it is sent. The

render tool can also be used to see how the archived messages looked to customers when they were sent as

notifications.

To render an archived message using the Archive Manager screen:

1. Select an archived message in the Archive Manager list view.

Archive Manager List View

2. Click the <View Message> button, or double-click on the message, to render a notification in a new

window. Note: The <View Message> button is enabled only if a message is selected in the Archive

Manager list view.
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Rendered Archived Message

3. Click <OK> to close the rendered archive message window.

Back to Top

See also:

Notification Archive Manager Screen

Notification Archive Manager Screen Details
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Re-size Archive Manager List View

The Archive Manager screen gives you the ability to manipulate and re-size the Archive Manager list view.

· Re-size the width of the Archive Manager list view columns

· Re-size the height of the Archive Manager list view heading row

· Manipulate the Archive Manager list view to view data that has been cut off 

Re-size Column Width

To re-size the width of the columns in the Archive Manager list view:

1. Hover between the column headings of the list view to bring up the double-arrow icon.

Archive Manager List View

with Double-arrow Icon

2. Press and hold down the left-click button and drag to the right or left to increase or decrease the

column width. In the following example the width of the Archive ID column has been decreased.

Archive Manager List

View with Column Width

Decreased

Back to Top

Re-size Heading Row Height

To re-size the height of the heading row of the Archive Manager list view:

1. Hover on the bottom border of the heading row in the list view to bring up the double-arrow icon.
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Archive Manager List

View with Double-arrow

Icon

2. Press and hold down the left-click button and drag down or up to increase or decrease the heading row

height.

Archive Manager List

View with Column Height

Increased

Back to Top

Manipulate the Archive Manager List View to See Data that has been Cut Off

To view text that has been cut off:

1. Hover between the column headings of the list view to bring up the double-arrow icon.

Archive Manager List

View with Text Cut Off
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2. Press and hold down the left-click button and drag to the right to increase the column width. In the

following example the width of the Time Sent column has been increased to display the entire date

and time.

Column Width Increased in

Archive Manager List View

Back to Top

See also:

Notification Archive Manager Screen

Notification Archive Manager Screen Details
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Search for Archived Messages

You can search for archived messages using the Archive Manager screen.

This screen allows you to:

· Search by date

· Search by account number

· Search by template identification number

· Search by wrapper identification number

· Search by recipient

· Search by template type

· Search using multiple search criteria

Search by Date

To search for archived messages by the date they were effective:

1. Enter a beginning date to use for your search parameter in the Start Date field. Enter the date using

MM/DD/YYYY format, or use the drop-down calendar to select the date.

2. Enter an ending date to use for your search parameter in the End Date field. Enter the date using

MM/DD/YYYY format, or use the drop-down calendar to select the date.

Dates Entered in the Selection Criteria

3. Click the <Read> button ( ). The system searches for any archived message that has an

effective date within the range specified in the Start Date and End Date fields.

4. The results are displayed in the Archive Manager list view.

Search by Date Results Displayed in the Archive Manager List View

Back to Top
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Search by Account Number

To search for archived messages by account number:

1. Enter the account number that you want to search for in the Account field. Note: Entering partial

account numbers searches for any archived messages that include the partial numbers entered.

Account Field in the Search Criteria

2. Click the <Read> button ( ). The system searches for any archived message that has an

account number that matches the number entered in the Account field.

3. The results are displayed in the Archive Manager list view.

Search by Account Results Displayed in the Archive Manager List View

Back to Top

Search by Template Identification Number

To search for archived messages by template identification (ID) number:

1. Enter the template ID number that you want to search for in the Template ID field. Note: You must

enter the complete ID number. Partial numbers cannot be used to search.

Template ID Field in the Search Criteria

2. Click the <Read> button ( ). The system searches for any archived message that has a

template ID number that matches the number entered in the Template ID field.

3. The results are displayed in the Archive Manager list view.
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Search by Template ID Results Displayed in the Archive Manager List View

Back to Top

Search by Wrapper Identification Number

To search for archived messages by wrapper identification (ID) number:

1. Enter the wrapper ID number that you want to search for in the Wrapper ID field. Note: You must

enter the complete ID number. Partial numbers cannot be used to search.

Wrapper ID Field in the Search Criteria

2. Click the <Read> button ( ). The system searches for any archived message that has a

wrapper ID number that matches the number entered in the Wrapper ID field.

3. The results are displayed in the Archive Manager list view.

Search by Wrapper ID Results Displayed in the Archive Manager List View

Back to Top

Search by Recipient

To search for archived messages by the intended recipient's email address or phone number:
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2. Enter the email address or phone number that you want to search for in the Recipient field. Note:

You can enter a partial email address or phone number.

Recipient Field in the Search Criteria

4. Click the <Read> button ( ). The system searches for any archived message that has an

email address or phone number that matches what was entered in the Recipient field.

5. The results are displayed in the Archive Manager list view.

Search by Recipient Results Displayed in the Archive Manager List View

Back to Top

Search by Template Type

To search for archived messages by template type:

3. Select the template type that you want to search for from the Template Type drop-down list.

Template Type Field in the Search Criteria

6. Click the <Read> button ( ). The system searches for any archived message that has a

template type that matches the type selected from the Template Type drop-down list.

7. The results are displayed in the Archive Manager list view.
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Search by Template Type Results Displayed in the Archive Manager List View

Back to Top

Search Using Multiple Search Criteria

To search for archived messages using multiple search criteria:

4. Enter all of the search criteria that you want to use to narrow your search in the Selection Criteria

fields. In our example, we entered information in the Start and End Date fields, the Recipient field,

and the Template Type field.

Multiple Fields Used in the Search Criteria

8. Click the <Read> button ( ). The system searches for any archived message that

matches all of the search criteria entered.

9. The results are displayed in the Archive Manager list view. In our example the archived messages that

appear in the results were sent within the time frame specified by the Start and End Date fields, the

recipient's email address matches the one entered in the Recipient field, and the template type is

"HTML Email" which was specified using the Template Type field.

Search by Multiple Search Criteria Results Displayed in the Archive Manager List View

Back to Top
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See also:

Notification Archive Manager Screen

Notification Archive Manager Screen Details
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Search the Results

To search the results in the Archive Manager list view using the Archive Manager screen:

1. Perform a search to populate the Archive Manager list view. 

Archive Manager List View

2. Right-click inside the Archive Manager list view to bring up the Right-click Menu.

Right-click Menu

3. Select "Find" from the menu to open the Find dialog.

Find Dialog

4. Enter the text to search for in the Search field. In the following example, we will search for the text,

"Dealer."

Enter text in the Search Field
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5. Click <Find> to populate the Find list view with the results from the search. In our example we found

all the archived messages that involved a "Dealer" application. Note: To narrow the results, enter more

specific text in the Search field.

Find List View Populated w ith the Results of the Search

The Find list view displays all of the items that include the text entered in the Search field. It also lists what

row number they are on in the Archive Manager list view, the name of the column that the search text was

found in, and the field that contained the search text.

Double-clicking on an item in the Find list view closes the Find dialog and displays the Archive Manager list

view with that item automatically selected.

Another effective way to use the Find dialog is to use it to search for archived messages set up with a specific

email address (see the example below).

Results for a Search for the Part of an Email Address

Back to Top

See also:

Notification Archive Manager Screen

Notification Archive Manager Screen Details

Search for Archived Messages
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Select a Message to Edit/Resend

To select an archived message to edit and/or resend using the Archive Manager screen:

1. Perform a search to populate the Archive Manager list view. 

Archive Manager List View

2. Select an archived message in the Archive Manager list view.

Archived Message Selected to Edit and/or Resend

3. Click <Edit/Resend Message> to open the message on the Notification > Manual Notification Handler

screen. Once the message is on the Manual Notification Handler screen, you can add to, change, and

re-queue the message.
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Selected Message on the Manual Notification Handler Screen

Back to Top

See also:

Notification Archive Manager Screen

Notification Archive Manager Screen Details

Manual Notification Handler Screen

Search for Archived Messages
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View Message Details

To view the details of an archived message using the Archive Manager screen:

1. Perform a search to populate the Archive Manager list view. 

Archive Manager List View

2. Select an archived message in the Archive Manager list view to display the details of the message in

the fields below the Archive Manager list view.

Details of Archived Message Displayed

In addition to viewing the details of a message, you can also render the message or send the message to the

Manual Notification Handler screen to edit and/or re-queue the message.

Back to Top

See also:



Notification System68

© 2021 GOLDPoint Systems.Last updated: 2/17/2021

Notification Archive Manager Screen

Notification Archive Manager Screen Details

Search for Archived Messages

Render a Message

Select a Message to Edit/Resend
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Client Text Notifications Screen

Use the Client Text Notifications screen to search for and view text message conversations. You can also use

this screen to send and receive text messages with your customers.

The Client Text Notifications screen allows your employees to contact borrowers using two-way texting from

directly within CIM GOLD. Two-way texting shows conversations between the borrower and your institution via

text. For example, if the system sends the borrower a reminder text for payments, and the borrower responds

by doing what the text requested, you can view the conversations of both the system and the borrower.

Two-way texting works with our own Notification System, or we can interface with Solutions by Text, where the

texts route through their system and back to CIM GOLD.

To find out how to send text messages on any screen in CIM GOLD, see the help for the Right-click Menu Pop
Up screen.

How To Items
This screen allows you to:

· Delete Conversations
· Filter Conversations by Phone
· Filter Conversation Threads by Message
· Search for Conversations
· Send a Free-form Text
· Send a Text Message
· Send a Text Using a Template
· Send a Text Using a Wrapper
· View Conversation Threads

Additional Information

For an example of this screen and definitions of each of the fields on this screen, see the Client Text

Notifications Screen Details section.

Options

There are several options available for texting including, No Saturday Texts, No Sunday Texts, Minutes

Required Between Texts, etc. These options can help you stay in compliance with federal and state

regulations. If you are interested in setting up additional options, please contact your GOLDPoint Systems

client solutions specialist.

This screen is accessed by going to Notification > Client Text Notifications in the CIM GOLD tree view.
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Client Text Notifications Screen

See also:

Client Text Notifications Screen Details

Notification System
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Client Text Notifications Screen Details

Use the Client Text Notifications screen to search for and view text message conversations. You can also use
this screen to send and receive text messages with your customers.

See the following example of this screen followed by field and button descriptions.

Client Text Notifications Screen

Field Descriptions

Field Description

Branch Enter a branch number in this field to limit your search to

conversations by branch.
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Field Description

Phone Enter a phone number in this field to limit your search to only the

conversations associated with that phone number. Note: You must

enter a complete phone number to be able to search.

Start Enter or use the up and down arrows or calendar to select a starting

date and time to limit your search to conversations that occurred

within a specific time period. You can select a part of the date or a

section of the time and use the up and down arrows to increase or

decrease the number. You can also select a part of the date or time

and manually enter in the number you want in that spot. In addition,

you can press the large down arrow to open the calendar to select a

date.

End Enter or use the up and down arrows or calendar to select an ending

date and time to limit your search to conversations that occurred

within a specific time period. You can select a part of the date or a

section of the time and use the up and down arrows to increase or

decrease the number. You can also select a part of the date or time

and manually enter in the number you want in that spot. In addition,

you can press the large down arrow to open the calendar to select a

date.

Filter By Phone Use this field to filter the results by phone number. As you type a

phone number into this field the search results will automatically

adjust to show only those conversations that match the numbers you

are typing in.

Conversations List View The Conversations list view displays the conversations that meet the

search parameters entered. You can filter the results by phone

number using the Filter By Phone field.

Selecting a conversation in this list view opens and displays that

conversation in the Conversation Thread Message Display.

The following information is displayed in the Conversations list view:

· Branch Number: The branch number is displayed in the circle

on the left. You can use the Branch search parameter to limit

your results by branch number.

· Phone Number: Displays the phone number associated with

the conversation. You can use the Phone search parameter to

limit your results by phone number. 

· Account Number: Displays the account number associated

with the conversation.
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Field Description

· Date: Displays the date (in MM/DD/YYYY format) of the

conversation. You can use the Start and End fields to limit your

results to a specific time period.

Filter By Message Use this field to filter the conversation thread by parts of a message.

As you type into this field the conversation thread will automatically

adjust to show only those parts of the conversation that match the

characters you are typing in. Note: This field is not case sensitive.

For example, if you type "payments" into this field, only the threads

that contain the word "payments" will remain in the Message Display

box.

Message Display This display box displays the conversation threads for the

conversation selected in the Conversations list view. You can filter the

conversations threads by the contents of the messages using the

Filter By Message field. You can also add more threads to the

conversation using the Text Message field.

Free Form Check this box to type your text message using free form. This will let

CIM GOLD know that you do not want to include a template or a

wrapper.

See Conversations Across

Branches

Check this box to view the conversations for this thread across all

branches instead of only seeing the conversations for this thread for a

single branch.

Template Select a template from this drop-down list to use a template for your

text message.

Wrapper Select a wrapper from this drop-down list to use a wrapper for your

text message.

Text Message Use this field to type a text message to be sent to the phone number

selected in the Conversations list view. You can send a plain

message or you can use prefabricated templates and wrappers.

Back to Top

Button Descriptions

Button Description

<Search Conversations> Click this button to search for conversations that meet the conditions

set by the search parameters.
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Button Description

<Send> Click this button to send a text message to the phone number

selected in the Conversations list view. 

<Clear> Click this button to erase the text entered in the Text Message field.

<Close Conversation> Click this button to close the conversation. Warning: Clicking this

button with end the conversation and remove it from the Conversations

list view, making it so that you can no longer access the conversation.

<Refresh> Click this button to refresh the conversation in the Message Display

box.

<Auto Refresh> Click this button to force CIM GOLD to automatically refresh the

conversation in the Message Display box.

Back to Top

See also:

Client Text Notifications Screen

Notification System
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Delete Conversations

To delete a conversation using the Client Text Notifications screen:

1. Search for a conversation. All of the conversations that match the search parameters are displayed in

the Conversations list view.

2. Select the conversation that you want to delete in the Conversations list view. This displays the

conversation in the Message Display.

3. Click on the <Close Conversation> button. Warning: This deletes the conversation and completely

removes it. You will no longer be able to search for the conversation once it has been deleted.

Conversations Displayed

4. The conversation is removed from the Conversations list view and can no longer be searched for.
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Selected Conversation Removed from Conversations List View

Back to Top

See also:

Client Text Notifications Screen

Client Text Notifications Screen Details

Search for Conversations

Notification System
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Filter Conversations by Phone

To filter conversations by phone number using the Client Text Notifications screen:

1. Search for a conversation. All of the conversations that match the search parameters are displayed in

the Conversations list view.

Conversations Displayed

2. Enter a phone number into the Filter by Phone field. As you enter in the number, the conversations are

automatically filtered.

3. Once the entire phone number is entered, only conversations by that phone number appear in the

Conversations list view.

Conversations Filtered by Phone Number

4. Now you can click on a conversation to view the conversation thread.
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Back to Top

See also:

Client Text Notifications Screen

Client Text Notifications Screen Details

Search for Conversations

View Conversations Threads

Notification System
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Filter Conversation Threads by Message

Filtering a conversation thread can help you to quickly find the specific information that you are looking for. To

filter a conversation thread using the Client Text Notifications screen:

1. Search for a conversation. All of the conversations that match the search parameters are displayed in

the Conversations list view.

Conversations Displayed in Conversations List View

2. Select the conversation that you want to view in the Conversations list view. This displays the

conversation thread in the Message Display.
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Conversation Thread Displayed in the Message Display

3. Begin typing text into the Filter by Message field. As you enter in the text, the conversation threads

are automatically filtered to display only those threads that contain the text typed in the Filter by

Message field.
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Filtered Conversation Thread Displayed

Back to Top

See also:

Client Text Notifications Screen

Client Text Notifications Screen Details

Search for Conversations

View Conversation Threads

Notification System
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Search for Conversations

You can use the Client Text Notifications screen to search for conversations.

· Search for a Conversation by Date and Time

· Search for a Conversation by Branch

· Search for a Conversation by Phone Number

Search Overview

Search for a Conversation by Date and Time

1. Select a starting date and time using the Start field.

2. Select an ending date and time using the End field.

3. Click <Search Conversations>.

4. Conversations are displayed in the middle Conversations list view that occurred within the time and

date parameters entered in the Start and End fields.

Once you are viewing the conversations in the Conversations list view, you can filter the conversations by

phone number to search for a conversation with a specific phone number.

Back to Top

Search for a Conversation by Branch

1. Enter the branch number for the conversation in the Branch field. 
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2. If you want to narrow your search results by a specific phone number, enter the number in the Phone

field. Otherwise, leave it blank to show all phone numbers from the accounts in that branch.

3. If you want to limit your search to a specific time range, select a starting and ending date and time

using the Start and End fields.

4. Click <Search Conversations>.

5. Any conversations matching the search parameters are displayed in the Conversations list view.

Once you are viewing the conversations in the Conversations list view, you can filter the conversations by

phone number to search for a conversation with a specific phone number.

Back to Top

Search for a Conversation by Phone Number

1. Leave the Branch field blank.

2. Enter the phone number for the conversation in the Phone field. Note: You must include the full phone

number, including the country calling code (a "1" for a United States phone number). Also, do not use

any dashes or parenthesis.

3. If you want to limit your search to a specific time range, select a starting and ending date and time

using the Start and End fields. Tip: To search for all conversations with that phone number, set the

Start date back two or more years and put today's date in the End field.

4. Click <Search Conversations>.

5. Any conversations matching the search parameters are displayed in the Conversations list view.

Pro Tip: Sometimes it is a lot easier to perform a search and then filter the conversations by phone number

rather than to search for a conversation by phone number.

Back to Top

See also:

Client Text Notifications Screen

Client Text Notifications Screen Details

Filter Conversations by Phone

View Conversations Threads

Notification System
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Send a Text Message

You can use the Client Text Notifications screen to send text messages.

· Send a Free-form Text

· Send a Text Using a Template

· Send a Text Using a Wrapper

Send a Free-form Text

Free-form texts allow you to write whatever you would like and send it. This is how most people text on their

phones. To send a free-form text using the Client Text Notifications screen:

1. Search for a conversation. All of the conversations that match the search parameters are displayed in

the Conversations list view.

Conversations Displayed in Conversations List View

2. Select the conversation that you want to view in the Conversations list view. This displays the

conversation thread in the Message Display.
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Conversation Thread Displayed

3. Check the Free Form field to open the Text Message area.

Free Form Field Checked

4. Enter your text into the Text Message area and click <Send> to send the text to the customer.

Free Form Text Ready to Send
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5. The message is sent and displayed as one of the threads in the Message Display area. Warning:

This screen does not stop you from sending text messages within your institution's Minutes Required

Between Texts period, if you have that option set.

Free Form Text Sent and Visible in Message Display Area

Back to Top

Send a Text Using a Template

To send a text using a template on the Client Text Notifications screen:

1. Search for a conversation. All of the conversations that match the search parameters are displayed in

the Conversations list view.
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Conversations Displayed in Conversations List View

2. Select the conversation that you want to view in the Conversations list view. This displays the

conversation thread in the Message Display.
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Conversation Thread Displayed

3. Select a template from the drop-down Template field to enter the template text into the Text Message

area. 

4. Click <Send> to send the text to the customer. Warning: This screen does not stop you from

sending text messages within your institution's Minutes Required Between Texts period, if you have

that option set.

Template Text Visible in Text Message Area and Ready to Send

5. The message is sent and displayed as one of the threads in the Message Display area.
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Template Text Sent and Visible in Message Display Area

Back to Top

Send a Text Using a Wrapper

To send a text using a wrapper on the Client Text Notifications screen:

1. Search for a conversation. All of the conversations that match the search parameters are displayed in

the Conversations list view.
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Conversations Displayed in Conversations List View

2. Select the conversation that you want to view in the Conversations list view. This displays the

conversation thread in the Message Display.
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Conversation Thread Displayed

3. Select a template from the drop-down Template field to enter the template text into the Text Message

area.

Template Text Visible in Text Message Area

4. Select a wrapper from the drop-down Wrapper field to attach the wrapper to the template text in the

Text Message area.

5. Click <Send> to send the text to the customer. Warning: This screen does not stop you from

sending text messages within your institution's Minutes Required Between Texts period, if you have

that option set.
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Template Text w ith Wrapper Visible in Text Message Area and

Ready to Send

6. The message is sent and displayed as one of the threads in the Message Display area.

Template Text w ith Wrapper Sent and Visible in Message Display Area

Back to Top

See also:

Client Text Notifications Screen

Client Text Notifications Screen Details

Notification System
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View Conversation Threads

To view the conversation thread for a conversation using the Client Text Notifications screen:

1. Search for a conversation. All of the conversations that match the search parameters are displayed in

the Conversations list view.

Conversations Displayed in Conversations List View

2. Select the conversation that you want to view in the Conversations list view. This displays the

conversation thread in the Message Display.
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Conversation Thread Displayed in the Message Display

Once you are viewing a conversation thread, you can filter that thread to search for specific information and

you can send a text message. You can also view all of the conversations for that thread across all of the

branches by checking the See Conversations Across Branches field.

Back to Top

See also:

Client Text Notifications Screen

Client Text Notifications Screen Details

Search for Conversations

Filter Conversations Threads by Message

Send a Text Message

Notification System
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Manual Notification Handler Screen

Use the Manual Notification Handler screen to manually re-queue messages. Messages with errors are sent to

this screen from the Queue Error Manager screen and archived messages are sent to this screen from the

Archive Manager screen.

Anything entered in the Override Subject or Override Message fields on this screen overrides anything

previously entered in those fields.

How To Items
This screen allows you to:

· Add or change a parameter of a message

· Add the parameter and value changes to a message (render the changes to the parameters)

· Delete a parameter of a message

· Find and replace text in the body of a message

· Queue (send) a message

· Re-queue (or resend) a message

· Re-size columns and rows in the Manual Notification list view

· Select a message to modify

· View a message as it would be displayed (rendered) to customers

Right-click Menu Notification Pop-up Screen

The Right-click Notification Pop-up screen can be accessed on multiple screen throughout CIM GOLD using
the Right-click Menu. You can use this screen to set up email and text notifications to be sent to your
customers. Note: If you want to be set up to be able to sent notifications via text (SMS), please contact your
GOLDPoint Systems client solutions specialist.

To learn more about this screen, see the Right-click Menu Notification Pop-up Screen section.

Additional Information

For an example of this screen and definitions of each of the fields on this screen, see the Manual Notification

Handler Screen Details section. 

This screen is accessed by going to Notification > Manual Notification Handler in the CIM GOLD tree view.
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Manual Notification Handler Screen

See also:

Manual Notification Handler Screen Details

Right-click Menu Notification Pop-up Screen

Archive Manager Screen

Queue Error Manager Screen

Notification System
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Manual Notification Handler Screen Details

Use the Manual Notification Handler screen to manually re-queue messages. Messages with errors are sent to

this screen from the Queue Error Manager screen and archived messages are sent to this screen from the

Archive Manager screen.

Anything entered in the Override Subject or Override Message fields on this screen overrides anything

previously entered in those fields.

See the following example of this screen followed by field and button descriptions.

Manual Notification Handler Screen

Field Descriptions

Field Description

Recipient Enter the email address or phone number that the message will be

sent to in this field. If the template selected is an email template, the

address entered must be the email address of the recipient. If the

template selected is a text template, the address entered must be the

phone number of the recipient.

Override Subject Enter the new subject line of the message in this field. This subject

line will override any subject line previously entered.

Account Number Enter the account number that the message will be tied to in this field.

Priority Enter the priority number in this field. The lower the value entered, the

higher the priority of the message. If the server has many messages
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Field Description

to transmit, the highest priority messages are transmitted first. The

default priority for most messages is 100.

Release Date Enter the date to release the message. Enter the date using

MM/DD/YYYY format, or use the drop-down calendar to select the

date. The message will not be sent until the date and time indicated in

the Release Date and Release Time fields.

Release Time Enter the time to release the message. Enter the time using

HH/MM/SS format, or use the arrows to select the time. The message

will not be sent until the date and time indicated in the Release Date

and Release Time fields.

Override Message Enter the code for the new body of the message in this field. This

message will override any message body previously entered.

Template Select the template from this drop-down field. This field displays the

type and identification number of each template available. Selecting a

template automatically enters that template's parameters into the

Manual Notification list view.

Wrapper Select the wrapper from this drop-down field. This field displays the

type and identification number of each wrapper available. Selecting a

wrapper automatically enters that wrapper's parameters into the

Manual Notification list view.

Manual Notification List View This list view displays the parameters and values currently set up to

use for substitution when rendering the message. You can select the

parameters and values in this list view to update or delete them. You

can also add new parameters and values to this list view using the

<Add/Change> button to add the information in the the Parameter and

Value fields.

The following buttons affect this list view:

· <Add/Change>: Click this button to update the Manual

Notification list view with the information in the Parameter

and Value fields.

· <Delete>: Click this button to delete the parameter selected

in the Manual Notification list view.

Parameter Enter or update parameters in this field and click <Add/Change> to

modify the Manual Notification list view.

Value Enter or update values in this field and click <Add/Change> to modify

the Manual Notification list view.
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Back to Top

Button Descriptions

Button Description

<Add/Change> Click this button to update the Manual Notification list view with the

information in the Parameter and Value fields. See the Add or Change

Parameters section for more details.

<Delete> Click this button to delete the parameter selected in the Manual

Notification list view. See the Delete Parameters section for more

details.

<Find/Replace> Click this button to perform a find and replace function in the body of

the message in the Override Message field. See the Find and Replace

Text section for more details.

<Render Override> Click this button to render the message with the parameters and

values set up in the Manual Notification list view. Note: Once you

click <Render> the first time, you cannot change the parameters or

values and click <Render> again. 

The parameters and values in the Manual Notification list view are

ignored when rendering the subject if anything is entered into the

Override Subject field. They are also ignored when rendering the body

of the message if anything is entered into the Override Message field.

See the Render Changes to Parameters section for more details.

<Preview Message> Click this button to display the message as it would render (display in

an HTML renderer) if the processor uses the current effective

template. See the View Messages section for more details.

<Queue Message> Click this button to queue the message. See the Queue or Re-queue

a Message section for more details. Note: This button appears only

for new messages.

<Requeue Message> Click this button to re-queue the message. If the message being

queued had an error, the error is automatically marked as handled.

See the Queue or Re-queue a Message section for more details.

Note: This button appears for previously-created messages that you

want to send again.

Back to Top

See also:

Queue or Re-queue a Message
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Manual Notification Handler Screen

Archive Manager Screen

Queue Error Manager Screen
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Add or Change Parameters

The Manual Notification Handler screen allows you to add and change parameters and their values using the

Manual Notification list view. The parameters and values are used to automatically populate messages with

substitution data when rendering the messages. Note: Parameters and values set up for the subject are

ignored if overriding data is entered into the Override Subject field. Also, parameters and values set up for the

body of the message are ignored if overriding data is entered into the Override Message field.

· Add parameters and values

· Change parameters and values

Add Parameters and Values

To add parameters and values to the Manual Notification list view:

1. Enter a parameter into the Parameter field. In the example below, we have entered "LOANTYPE."

"LOANTYPE" Entered in Parameter Field

2. Enter a value for the parameter in the Value field, or leave the Value field blank if you do not wish to

add a specific value. In our example, we have entered "Consumer Loan."

"Consumer Loan" Entered in the Value Field

3. Click the <Add/Change> button ( ) to add the new parameter and value to the Manual

Notification list view.
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Click <Add/Change> Button to Add Parameter and Value

4. The parameter and value are added to the Manual Notification list view.

New Parameter and Value Added to the Manual Notification List View

Back to Top

Change Parameters and Values

To change parameters or values in the Manual Notification list view:

1. Select a parameter or value in the Manual Notification list view. In the example below, we have

selected "LOANTYPE."

Parameter Selected in the Manual Notification List View
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2. Once the parameter has been selected, it automatically populates the Parameter field.

3. Make the desired changes to the parameter or value using the Parameter and Value fields. In our

example, we have entered "Consumer Loan" as the value associated with the parameter, LOANTYPE.

"Consumer Loan" Entered in the Value Field

4. Click the <Add/Change> button ( ) to make the changes to the parameter and value in the

Manual Notification list view.

Click <Add/Change> Button to Change the Parameter and Value

5. The changes to the parameter and value have now been applied to the Manual Notification list view.

Now that the changes to the parameter and value have been applied to the Manual Notification list

view, you can add the new changes (render the changes) to the message.

Changes Applied to the Manual Notification List View
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6. Click the <Render> button to add the new changes to the message.

<Render> Button Highlighted

7. The changes to the parameter and value are applied to the message.

Body of the Message Before the Changes to the Parameter and Value Were Applied

Body of the Message After the  Changes to the Parameter and Value Are Applied

Back to Top

See also:

Queue or Re-queue a Message

Render Changes to Parameters

Delete Parameters

Manual Notification Handler Screen

Manual Notification Handler Screen Details
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Render Changes to Parameters

You can add changes (render the changes) made to the parameter and value fields in the Manual Notification

list view to the message using the Manual Notification Handler screen. Changes made to the the parameter

and value fields are applied to both the body and the subject of the message at the same time if the changes

apply to both. For this section, we have provided two examples of how changes can be applied to the

message.

· Render changes to the body of the message

· Render changes to the subject and body of the message

Render Changes to Body of Message

To add changes (render the changes) made to the parameter and value fields in the Manual Notification list

view to the message using the Manual Notification Handler screen:

1. Add new parameters or values to the Manual Notification list view or make changes to the

parameters and values in the Manual Notification list view.

2. Once the changes to the parameter and value fields have been applied to the Manual Notification list

view, you can add the new changes (render the changes) to the message. In our example, we

changed the value of the LoanType parameter to "Consumer Loan."

Value Changed to "Consumer Loan" and Applied to the Manual Notification List

View

3. Click the <Render> button to add the new changes to the message.
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<Render> Button Highlighted

4. The changes to the parameter and value are applied to the message.

Body of the Message Before the Changes to the Parameter and Value Were Applied

Body of the Message After the  Changes to the Parameter and Value Are Applied

Back to Top

Render Changes to Subject and Body of Message

To add changes (render the changes) made to the parameter and value fields in the Manual Notification list

view to the subject and body of the message using the Manual Notification Handler screen:

1. Add new parameters or values to the Manual Notification list view or make changes to the

parameters and values in the Manual Notification list view.

Parameter to be Changed is "Name"
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Name Parameter Selected to be Changed

2. Once the changes to the parameter and value fields have been applied to the Manual Notification list

view, you can add the new changes (render the changes) to the message. In our example, we

changed the value of the LoanType parameter to "Consumer Loan."

"Clark" Entered as New Value for Name Parameter

Value Changed to "Clark" and Applied to the Manual Notification List View

3. Click the <Render> button to add the new changes to the message.

<Render> Button Highlighted
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4. The changes to the parameter and value are applied to the message.

Subject and Body of the Message After the Changes to the Parameter and Value Were Applied

Back to Top

See also:

Queue or Re-queue a Message

Add or Change Parameters

Manual Notification Handler Screen

Manual Notification Handler Screen Details
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Delete Parameters

To delete parameters from the Manual Notification list view using the Manual Notification Handler screen:

1. Select a parameter in the Manual Notification list view.

Parameter Selected in Manual Notification List View

2. Click the <Delete> button.

<Delete> Button Highlighted

3. The parameter and its value are immediately removed from the Manual Notification list view. 

Parameter Successfully Deleted
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Back to Top

See also:

Queue or Re-queue a Message

Manual Notification Handler Screen

Manual Notification Handler Screen Details
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Find and Replace Text

To quickly find and replace text within the body of a message using the Manual Notification Handler screen:

1. Select a message to modify using the Manual Notification Handler screen, the Archive Manager

screen or the Queue Error Manager screen.

2. The selected template is now displayed on the Manual Notification Handler screen.

Message Displayed on Notification Manual Handler Screen

3. Search the body of the message for the text that you want to display.

4. Highlight the text and press <Ctrl> "C" to copy the text.

Text to be Replaced Selected in Body of the Message

5. Click the <Find/Replace> button ( ) in the lower, right-hand corner of the screen to bring up

the Notification Find and Replace dialog.
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Notification Find and Replace Dialog

6. Put your cursor in the Find what: field and press <Ctrl> "V" to paste the copied text into the field.

You can also manually enter the text into the field.

7. Enter the text that you want to use in the Replace with: field. Note: If you want to retain any

capitalization entered into the Find what: field or the Replace with: field, check the Match Case

field.

8. Use the <Find Next> and <Replace> buttons to go through the body of the message and replace each

occurrence of the text one-by-one or use the <Replace All> button to go through the body of the

message and replace all occurrences of the text instantaneously.

9. The previous text in the body of the message is replaced with the new text.

Text Replaced in Body of the Message

10. If all of the previous text has been replaced by the new text, a message appears if you click <Find

Next> or <Replace All> informing you that there are no more occurrences of the old text.

Manual Notification Handler Dialog

Back to Top

See also:

Queue or Re-queue a Message
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Select a Message to Modify

Manual Notification Handler Screen

Manual Notification Handler Screen Details
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Queue or Re-queue a Message

You can use the Manual Notification Handler screen to manually queue and re-queue a message.

· Queue a Message

· Re-queue a Message

Queue a Message

To manually queue a message using the Manual Notification Handler screen:

1. Navigate to the Notification > Manual Notification Handler screen.

Manual Notification Handler Screen

2. Enter information into the fields on the screen. You must enter a Recipient and give the message a

Priority.

3. Select a Template and a Wrapper.

Information Entered into Manual Notification Screen Fields and Template and Wrapper Selected
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4. Once a template and wrapper are selected, the Manual Notification list view contains the parameters

and values that are used in the template.

5. Enter the values for the parameters in the Manual Notification list view.

Manual Notification List View

6. Once all of the values have been entered, you can view the message using the render tool to see if the

message is set up correctly. Note: You can also enter a new message in the Override Message field if

you want to override the message in the selected template.

7. After you have viewed the message and have made sure that it is set up correctly, click the <Queue

Message> button ( ) to queue the message according to the parameters set up. The

message will be sent on the date and time set up in the Release Date and Release Time fields.

Message on the Manual Notification Handler Screen

8. Once you have clicked the <Queue Message> button, you will receive a message informing you that

the message has been queued. Click <OK> to close the Information Message dialog.
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Information Message Dialog

Back to Top

Re-queue a Message

To manually re-queue a message using the Manual Notification Handler screen:

1. Select a message to modify using the Manual Notification Handler screen, the Archive Manager

screen or the Queue Error Manager screen.

2. The selected template is now displayed on the Manual Notification Handler screen and can be

modified and re-queued.

Message Displayed on Manual Notification Handler Screen

3. Make any necessary changes to the message. The message can be modified by changing or entering

information into the fields on the screen. You can change the account number that the message is

associated with, the email address of the recipient, the level of priority, the subject line that appears in

the Subject field of the email, the date and time the message will be sent/released, and the details of

the body of the message. The message can also be modified by changing the parameters and values

associated with the message.

4. Once all of the changes have been made, you can view the message using the render tool to see if the

message is set up correctly.
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5. After all of the changes have been made and verified, click the <Requeue Message> button (

) to re-queue the message according to the parameters set up. The message will be

sent on the date and time set up in the Release Date and Release Time fields.

Re-queue Message on the Manual Notification Handler Screen

6. Once the message has been re-queued, you will receive a message informing you that the message

has been queued. Click <OK> to close the Information Message dialog.

Information Message Dialog

Back to Top

See also:

Select Message to Modify

View Rendered Messages

Manual Notification Handler Screen

Manual Notification Handler Screen Details

Archive Manager Screen

Queue Error Manager Screen
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Re-size Manual Notification List View

The Manual Notification Handler screen gives you the ability to manipulate and re-size the Manual Notification

list view.

· Re-size the width of the Manual Notification list view columns

· Re-size the height of the Manual Notification list view heading row

· Manipulate the Manual Notification list view to view data that has been cut off 

· Automatically Re-size Manual Notification List View

Re-size Column Width

To re-size the width of the columns in the Manual Notification list view:

1. Hover between the column headings of the list view to bring up the double-arrow icon.

Manual Notification List View with Double-arrow Icon

2. Press and hold down the left-click button and drag to the right or left to increase or decrease the

column width. In the following example the width of the Parameter column has been decreased.

Manual Notification List View with Column Width Decreased

Back to Top

Re-size Heading Row Height

To re-size the height of the heading row of the Manual Notification list view:

1. Hover on the bottom border of the heading row in the list view to bring up the double-arrow icon.
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Manual Notification List View with Double-arrow Icon

2. Press and hold down the left-click button and drag down or up to increase or decrease the heading row

height.

Manual Notification List View with Column Height Increased

Back to Top

Manipulate the Manual Notification List View to See Data that has been Cut Off

To view text that has been cut off:

1. Hover between the column headings of the list view to bring up the double-arrow icon.

Manual Notification List View with Text Cut Off

2. Press and hold down the left-click button and drag to the right to increase the column width. In the

following example the width of the Value column has been increased to display the value.

Column Width Increased in Manual Notification List View
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Back to Top

Automatically Re-size Manual Notification List View

To automatically re-size the Manual Notification list view:

1. Right click on the Manual Notification list view to bring up the Right-click Menu.

Manual Notification List View Right-click Menu

2. Select Auto Resize to bring up a list of options. Using the Right-click Menu you can: automatically re-

size the entire Manual Notification list view (select Auto Resize > Auto Resize Grid), automatically

re-size the columns of the Manual Notification list view (select Auto Resize > Auto Resize

Columns), and automatically re-size the rows of the Manual Notification list view (select Auto Resize

> Auto Resize Rows). In the example below, we selected Auto Resize > Auto Resize Grid. This re-

sizes the columns and rows to fit in the list view space available without any blank columns.

Manual Notification List View Automatically Re-sized

Back to Top

See also:

Queue or Re-queue a Message

Manual Notification Handler Screen

Manual Notification Handler Screen Details
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Right-click Menu Notification Pop-up Screen

Use the Right-click Notification Pop-up screen to manually queue messages. Using this pop-up screen, you
can set up email and text notifications to be sent to your customers.

This screen can be accessed on multiple screens throughout CIM GOLD using the Right-click Menu. This
screen works similarly to the Manual Notification Handler screen.

Note: Field-level security for this screen is set up on the Field Level tab on the Security > Setup screen in CIM

GOLD. You can control which employees can send alerts using the Right-click menu using the following field-

level security options:

· Right Click Email (FSNEML): This field ensures that the option to send a notification e-mail using the

right-click screen is inaccessible if the user does not have the proper security.

· Right Click Text (FSNTXT): This field ensures that the option to send a notification text using the right-

click screen is inaccessible if the user does not have the proper security.

The following alert notifications can be set up using this screen:

· Email Notifications

· Text Notifications

Email Notifications

To set up an email notification using the Right-click Menu Notification Pop-up screen:

1. Right-click on a screen in CIM GOLD to bring up the Right-click Menu.
2. Select Send Alert and then select E-Mail to send a notification as an email message.

Right-click Menu

3. This brings up the notification pop-up screen.
4. Select the template you want to use in the Template field and then set the date and time that you

want the notification sent using the Release Date and Release Time fields.

https://secure.goldpointsystems.com/gpsdocs/other/SecurityCIMGOLD/fieldlevelsecurityscreen.asp
https://secure.goldpointsystems.com/gpsdocs/other/SecurityCIMGOLD/securitysetupscreen.asp
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Notification Pop-up Screen—Send Email
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Template, Wrapper, and Release Date and Time Selected

5. Now select the person/entity that the notification should be sent to from the Recipients list view.

6. Then select the email address that the notification should be sent to from the E-Mails list view.

7. Enter the values for the parameters in the Value fields.
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Account and Email Address Selected and Parameter Values Entered

8. When the notification is ready to be sent, click <Render> to preview the notification and ensure that it
is set up correctly.
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Notification Rendered

9. Once you have finished setting up the notification, click <Queue Message> to add the notification to
the messaging queue.

10. The notification is then added to the messaging queue and will be sent according to the date and time
selected in the Release Date and Release Time fields.

Message Queued Successfully

Back to Top

Text Notifications

To set up a text notification using the Right-click Menu Notification Pop-up screen:

1. Right-click on a screen in CIM GOLD to bring up the Right-click Menu.
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2. Select Send Alert and then select Text to send a notification as a text message.

Right-click Menu

3. This brings up the notification pop-up screen.
4. Select the template you want to use in the Template field and then set the date and time that you

want the notification sent using the Release Date and Release Time fields.

Notification Pop-up Screen—Send Text

5. Now select the person/entity that the notification should be sent to from the Recipients list view.
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Template, Wrapper, and Release Date and Time Selected

6. Then select the phone number that the notification should be sent to from the Phones list view.

7. Enter the values for the parameters in the Value fields.
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Phone Number Selected and Parameter Values Entered

8. When the notification is ready to be sent, click <Render> to preview the notification and ensure that it
is set up correctly.
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Notification Rendered

9. Once you have finished setting up the notification, click <Queue Message> to add the notification to
the messaging queue.

10. The notification is then added to the messaging queue and will be sent according to the date and time
selected in the Release Date and Release Time fields.

Message Queued Successfully

Back to Top

See also:
Queue or Re-queue a Message

Manual Notification Handler Screen

Notification System
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Select Message to Modify

The Manual Notification Handler screen allows you to modify and manually queue and re-queue messages.

Messages with errors are sent to this screen from the Queue Error Manager screen and archived messages

are sent to this screen from the Archive Manager screen.

· Select a message to modify using the Manual Notification Handler screen

· Select a message to modify using the Archive Manager screen

· Select a message to modify using the Queue Error Manager screen

Select a Message Using the Manual Notification Handler Screen

To select a message to modify using the Manual Notification Handler screen:

1. Click on the Template drop-down field to display all of the message templates that are currently set up

for your institution.

Template Drop-down Field

2. Select a template from the Template drop-down field to insert the details of the template into the

fields on the screen.

Template Selected

3. The selected template is now displayed on the Manual Notification Handler screen and can be

modified and queued.
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Message Displayed on Manual Notification Handler Screen

Back to Top

Select a Message Using the Archive Manager Screen

To select a message to modify using the Archive Manager screen:

1. Perform a search on the Archive Manager screen to populate the Archive Manager list view. 

Archive Manager List View

2. Select an archived message in the Archive Manager list view.
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Archived Message Selected to Edit and/or Resend

3. Click <Edit/Resend Message> to open the message on the Notification > Manual Notification Handler

screen. Once the message is on the Manual Notification Handler screen, you can add to, change, and

re-queue the message.

Selected Message on the Manual Notification Handler Screen

Back to Top
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Select a Message Using the Queue Error Manager Screen

To select a message to modify using the Queue Error Manager screen:

1. Perform a search on the Queue Error Manager screen to populate the Queue Error Manager list view. 

Queue Error Manager List View

2. Select a message in the Queue Error Manager list view.

Message Selected to Edit and/or Re-queue

3. Click <Edit/Requeue Message> to open the message on the Notification > Manual Notification

Handler screen with all of the data populated so you can add to, change, and re-queue the message.

Note: Once the message is re-queued, the error is flagged as handled.
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Selected Message on the Manual Notification Handler Screen

Back to Top

See also:

Queue or Re-queue a Message

Manual Notification Handler Screen

Manual Notification Handler Screen Details

Archive Manager Screen

Queue Error Manager Screen
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View Rendered Messages

You can view a rendered message using the Manual Notification Handler screen. This is useful if you want

send a notification again. Using the render tool, you can view the notification to ensure that it is the correct

notification that you want sent again. You can also see if any changes need to be made before it is sent. The

render tool can also be used to see how messages will be displayed to customers when they are sent as

notifications.

To view a rendered message using the Manual Notification Handler screen:

1. Select a message to render. This can be done using the Manual Notification Handler screen,  the

Archive Manager screen, or the Queue Error Manager screen.

Message Selected on the Manual Notification Handler Screen

2. Click the <View Message> button to render the notification in a new window. Note: The <View

Message> button works only if a message is selected on the Manual Notification Handler screen.

Otherwise, you will receive an error if you click the <View Message> button.
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Rendered Message

3. Click <OK> to close the rendered message window.

Back to Top

See also:

Queue or Re-queue a Message

Select Message to Modify

Manual Notification Handler Screen

Manual Notification Handler Screen Details

Archive Manager Screen

Queue Error Manager Screen
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Queue Error Manager Screen

Use the Queue Error Manager screen to search for and display all queue error messages and queued

messages that have errors. Queue errors are for messages that the Notification Processor failed to transmit.

Note: Unless it is handled, the message could have been transmitted if it was reattempted.

This screen displays a maximum of 100 messages with errors at a time. When a message is selected, the

message details are displayed on the lower portion of the screen. You can select more than one message and

right-click to reattempt all of the selected messages. Note: You cannot re-queue more than one message

because the Manual Notification Handler can only handle one message at a time.

How To Items
This screen allows you to

· Edit and re-queue messages

· Export and print reports

· Reattempt a message

· Render a message

· Re-size the Queue Error Manager list view

· Search for queue error messages and queued messages that have errors

· Search the results displayed in the Queue Error Manager list view

· View the details of a message

Additional Information

For an example of this screen and definitions of each of the fields on this screen, see the Notification Queue

Error Manager Screen Details section. 

This screen is accessed by going to Notification > Queue Error Manager in the CIM GOLD tree view.
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Notification Queue Error Manager Screen

See also:

Notification Queue Error Manager Screen Details

Manual Notification Handler Screen

Notification System



Notification System 141

© 2021 GOLDPoint Systems. Last updated: 2/17/2021

Queue Error Manager Screen Details

Use the Queue Error Manager screen to search for and display all queue error messages and queued

messages that have errors. Queue errors are for messages that the Notification Processor failed to transmit.

Note: Unless it is handled, the message could have been transmitted if it was reattempted.

This screen displays a maximum of 100 messages with errors at a time. When a message is selected, the

message details are displayed on the lower portion of the screen. You can select more than one message and

right-click to reattempt all of the selected messages. Note: You cannot re-queue more than one message

because the Manual Notification Handler can only handle one message at a time.

See the following example of this screen followed by field and button descriptions.

Notification Queue Error Manager Screen

Field Descriptions

Field Description

Start Date Enter a beginning date to use for your search parameter. Enter the

date using MM/DD/YYYY format, or use the drop-down calendar to

select the date.
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Field Description

End Date Select an ending date to use for your search parameter. Enter the

date using MM/DD/YYYY format, or use the drop-down calendar to

select the date.

Account Enter an account number in this field to search the Queue Error

database and display messages with the account number entered in

this field.

Recipient Enter a phone number or email address for a recipient in this field to

search the Queue Error database and display messages with the

recipient entered in this field.

Template ID Enter a template ID number in this field to search the Queue Error

database and display messages with the template ID number entered

in this field.

Wrapper ID Enter a wrapper ID number in this field to search the Queue Error

database and display messages with the wrapper ID number entered

in this field.

Template Type Select a template type from this drop-down field to search the Queue

Error database and display messages with the selected template

type.

Queue Error Manager List View This list view displays all the queue error messages and queued

messages that have errors. Queue errors are for messages that the

Notification Processor failed to transmit.

The following columns appear in this list view and can be used to sort:

· Account Number: This displays the account number that the

message is tied to.

· Recipient: This displays the intended recipient of the message.

· Time Last Attempted: This displays the last time the message

was attempted.

· Template ID: This displays the identification number of the

template.

· Wrapper ID: This displays the identification number of the

wrapper.

· Template Type: This displays the type of template used to create

the message.

· Handled Date: The displays the date the message was handled in

MM/DD/YYYY format.

· Handled By: This displays the name of the person who handled

the message.
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Field Description

· Template Description: This displays the description of the

template.

Account Number This field displays the account number that the message is tied to.

Error Code This field displays the error code tied to the message.

Subject This field displays the subject line of the message.

Message This field displays the body of the message.

Template ID Display This field displays the identification number of the template.

Error Description This field displays a description of the error that occurred.

Template Type Display This field displays the type of template used to create the message.

Back to Top

Button Descriptions

Button Description

<Read> Click this button to read the Notification Processor and display all the

queue error messages and queued messages with errors that fit the

parameters entered in the Start Date and End Date fields. See the

Search for Messages with Errors section for more details.

<Reattempt Message> Click this button to reattempt the message. This forces the

notification queue Web service to increase the maximum number of

attempts on the main message and flag the error as handled. You can

select more than one error and right-click to reattempt all of the

selected messages. Note: Reattempted messages are rendered

using the currently cached template.

<View Message> Click this button to display the message as it would render (display in

an HTML renderer) if the processor uses the current effective

template. See the Render a Message section for more details.

<Edit/Requeue Message> Click this button to open the error message in the Manual Notification

Handler screen with all of the data populated so the message can be

altered and re-queued. Once the message is re-queued, the error is

flagged as handled. See the Edit And Requeue Messages section for

more details.

Back to Top
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See also:

Search for Messages with Errors

Edit and Re-queue Messages

Reattempt a Message

Notification Queue Error Manager Screen

Manual Notification Handler Screen
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Edit And Re-queue Messages

To select a message to edit and/or re-queue using the Queue Error Manager screen:

1. Perform a search to populate the Queue Error Manager list view. 

2. Select a message in the Queue Error Manager list view.

Message Selected to Edit and/or Re-queue

3. Click <Edit/Requeue Message> to open the message on the Notification > Manual Notification

Handler screen with all of the data populated so you can add to, edit, and re-queue the message.

4. Once you have made any changes that you want to make, click <Requeue Message> on the Manual

Notification screen to re-queue the message to be sent on the selected date and time. Note: Once the

message is re-queued, the error is flagged as handled.
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Selected Message on the Manual Notification Handler Screen

Back to Top

See also:

Search for Messages with Errors

Reattempt a Message

Notification Queue Error Manager Screen

Notification Queue Error Manager Screen Details

Manual Notification Handler Screen
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Export or Print a Report

You can create a report of all queue error messages and queued messages that have errors in the Queue Error

Manager list view using the Queue Error Manager screen.

This screen allows you to:

· Export a report of all the messages with errors

· Print a report of all the messages with errors

Export a Queue Error Manager Report

There are three different ways to export the Queue Error Manager Report:

1. Export to Report Manager

2. Export Selection to Tab Delimited Text File

3. Export All to Tab Delimited Text

Export to Report Manager

To export a report of the messages with errors in the Queue Error Manager list view to Report Manager:

1. Right-click on the Queue Error Manager list view.

Right-click Menu with Export to Report Manager Selected

2. Select Export > Export to Report Manager to open the Save As dialog.
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Save As Dialog

3. Enter the name of the report in the File name: field and click <Save>.

4. The report is saved and automatically opens in Report Manager.

Queue Error Manager Report in Report Manager

Back to Top

Export Selection to Tab Delimited Text File

To export a report of a single message with an error from the Queue Error Manager list view to a tab delimited

text file:

1. Select a message in the Queue Error Manager list view.

2. Right-click on the selected message to open the Right-click menu.
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Right-click Menu with Export Selection to Tab Delimited Text File Selected

3. Select Export > Export Selection to Tab Delimited Text File to open the Save As dialog.

Save As Dialog

4. Enter the name of the report in the File name: field and click <Save>.

5. The report is saved.

Queue Error Manager Selection Report in Tab Delimited Text File

Back to Top
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Export All to Tab Delimited Text File

To export a report of all the messages with errors in the Queue Error Manager list view to a tab delimited text

file:

1. Right-click on the Queue Error Manager list view.

Right-click Menu with Export All to Tab Delimited Text Selected

2. Select Export > Export All to Tab Delimited Text to open the Save As dialog.

Save As Dialog

3. Enter the name of the report in the File name: field and click <Save>.

4. The report is saved.
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Queue Error Manager Report in Tab Delimited Text File

Back to Top

Print a Queue Error Manager Report

To print a report of the messages with errors in the Queue Error Manager list view:

1. Right-click on the Queue Error Manager list view.

Right-click Menu with Printing Selected

2. Select Printing > Page Setup to open the Page Setup dialog.
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Page Setup Dialog

3. The Queue Error Manager Report is a wide report, so you will want to change the orientation to

Landscape and narrow the margins to 0.5 to fit the report on the page.

4. Click <OK> to apply the new settings.

5. Right-click on the Queue Error Manager list view again.

Right-click Menu with Printing Selected

6. Select Printing > Print to print the Queue Error Manager Report. Note: You can select Printing > Print

Preview to preview the report before actually printing it. You can also change the printer that you are

using and the printer's settings by selecting Printing > Printer Settings.

7. The Queue Error Manager Report is printed using the printer set up in Printing > Printer Settings.
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Queue Error Manager Report Example

Back to Top

See also:

Search for Messages with Errors

Edit and Re-queue Messages

Reattempt a Message

Notification Queue Error Manager Screen

Notification Queue Error Manager Screen Details
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Reattempt a Message

The Queue Error Manager screen allows you to attempt to resend queue error messages and queued

messages that have errors. When you attempt to send a message again, it forces the notification queue Web

service to increase the maximum number of attempts on the main message and flag the error as handled.

Note: Reattempted messages are rendered using the currently cached template.

This screen allows you to:

· Reattempt a message

· Reattempt multiple messages at once

Reattempt a Message

To attempt to resend a message using the Queue Error Manager screen:

1. Perform a search to populate the Queue Error Manager list view. 

2. Select a message in the Queue Error Manager list view.

Queue Error Message Selected to Attempt to Resend

3. Click <Reattempt Message> to attempt to resend the message. Note: Reattempted messages are

rendered using the currently cached template.

4. The message is sent and the Information Message dialog is displayed. Click <OK> to close the

dialog.
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Information Message Dialog

Back to Top

Reattempt Multiple Messages at Once

To attempt to resend more than one message at once using the Queue Error Manager screen:

1. Perform a search to populate the Queue Error Manager list view.

2. Select the messages you want to attempt to resend in the Queue Error Manager list view.

Multiple Messages Selected in Queue Error Manager List View

3. Right-click to bring up the Right-click dialog. 
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Right-click Menu

4. Select "Reattempt Message(s)" to attempt to resend all of the selected messages. Note:

Reattempted messages are rendered using the currently cached template.

5. The messages are sent and the Information Message dialog is displayed. Click <OK> to close the

dialog.

Information Message Dialog

Back to Top

See also:

Search for Messages with Errors

Edit and Re-queue Messages

Notification Queue Error Manager Screen

Notification Queue Error Manager Screen Details
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Render A Message

You can display the message as it would render if the processor uses the current effective template using the

Queue Error Manager screen. This is useful if you want send a notification again. Using the render tool, you

can view the notification to ensure that it is the correct notification that you want sent again. You can also see

if any changes need to be made before it is sent. The render tool can also be used to see how messages will

look looked to customers when they receive notifications.

To render a message using the Queue Error Manager screen:

1. Perform a search to populate the Queue Error Manager list view. 

2. Select a message in the Queue Error Manager list view.

Queue Error Manager List View and <View Message> Button

3. Click the <View Message> button to render a notification in a new window. Note: The <View

Message> button is enabled only if a message is selected in the Queue Error Manager list view.
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Rendered Message

4. Click <OK> to close the rendered message window.

Back to Top

See also:

Search for Messages with Errors

Edit and Re-queue Messages

Reattempt a Message

Notification Queue Error Manager Screen

Notification Queue Error Manager Screen Details
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Re-size Queue Error Manager List View

The Queue Error Manager screen gives you the ability to manipulate and re-size the Queue Error Manager list

view.

· Re-size the width of the Queue Error Manager list view columns

· Re-size the height of the Queue Error Manager list view heading row

· Manipulate the Queue Error Manager list view to view data that has been cut off 

Re-size Column Width

To re-size the width of the columns in the Queue Error Manager list view:

1. Hover between the column headings of the list view to bring up the double-arrow icon.

Queue Error Manager List

View with Double-arrow

Icon

2. Press and hold down the left-click button and drag to the right or left to increase or decrease the

column width. In the following example the width of the Template ID column has been decreased.

Queue Error Manager

List View with Column

Width Decreased

Back to Top

Re-size Heading Row Height

To re-size the height of the heading row of the Queue Error Manager list view:

1. Hover on the bottom border of the heading row in the list view to bring up the double-arrow icon.
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Queue Error Manager

List View with

Double-arrow Icon

2. Press and hold down the left-click button and drag down or up to increase or decrease the heading row

height.

Queue Error Manager

List View with Heading

Row Height Increased

Back to Top

Manipulate the Queue Error Manager List View to See Data that has been Cut Off

To view text that has been cut off:

1. Hover between the column headings of the list view to bring up the double-arrow icon.

Queue Error Manager List View

with Text Cut Off

2. Press and hold down the left-click button and drag to the right to increase the column width. In the

following example the width of the Time Last Attempted column has been increased to display the

entire date and time.
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Column Width Increased in

Queue Error Manager List View

Back to Top

See also:

Search for Messages with Errors

Edit and Re-queue Messages

Reattempt a Message

Notification Queue Error Manager Screen

Notification Queue Error Manager Screen Details
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Search for Messages with Errors

You can search for queue error messages and queued messages that have errors using the Queue Error

Manager screen.

This screen allows you to:

· Search by date

· Search by account number

· Search by template identification number

· Search by wrapper identification number

· Search by recipient

· Search by template type

· Search using multiple search criteria

· Search for all messages with errors

Search Parameters

Search by Date

To search for queue error messages and queued messages that have errors by the date they were last

attempted:

1. Enter a beginning date to use for your search parameter in the Start Date field. Enter the date using

MM/DD/YYYY format, or use the drop-down calendar to select the date.

2. Enter an ending date to use for your search parameter in the End Date field. Enter the date using

MM/DD/YYYY format, or use the drop-down calendar to select the date.

Search Parameters w ith Dates Selected

3. Click the <Read> button ( ). The system searches for any message that has a time last

attempted date within the range specified in the Start Date and End Date fields.

4. The results are displayed in the Queue Error Manager list view.
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Search Results Displayed in the Queue Error Manager List View

Back to Top

Search by Account Number

To search for queue error messages and queued messages that have errors by account number:

1. Enter the account number that you want to search for in the Account field. Note: Entering partial

account numbers searches for any messages that include the partial numbers entered.

Account Field in the Search Criteria

2. Click the <Read> button ( ). The system searches for any message that has an account

number that matches the number entered in the Account field.

3. The results are displayed in the Queue Error Manager list view.

Search by Account Results Displayed in the Queue Error Manager List View

Back to Top

Search by Template Identification Number

To search for queue error messages and queued messages that have errors by template identification (ID)

number:

1. Enter the template ID number that you want to search for in the Template ID field. Note: You must

enter the complete ID number. Partial numbers cannot be used to search.
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Template ID Field in the Search Criteria

2. Click the <Read> button ( ). The system searches for any message that has a template

ID number that matches the number entered in the Template ID field.

3. The results are displayed in the Queue Error Manager list view.

Search by Template ID Results Displayed in the Queue Error Manager List View

Back to Top

Search by Wrapper Identification Number

To search for queue error messages and queued messages that have errors by wrapper identification (ID)

number:

1. Enter the wrapper ID number that you want to search for in the Wrapper ID field. Note: You must enter

the complete ID number. Partial numbers cannot be used to search.

Wrapper ID Field in the Search Criteria

2. Click the <Read> button ( ). The system searches for any message that has a wrapper ID

number that matches the number entered in the Wrapper ID field.

3. The results are displayed in the Queue Error Manager list view.

Search by Wrapper ID Results Displayed in the Queue Error Manager List View
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Back to Top

Search by Recipient

To search for queue error messages and queued messages that have errors by the intended recipient's email

address or phone number:

1. Enter the email address or phone number that you want to search for in the Recipient field. Note: You

can enter a partial email address or phone number.

Recipient Field in the Search Criteria

2. Click the <Read> button ( ). The system searches for any message that has an email

address or phone number that matches what was entered in the Recipient field.

3. The results are displayed in the Queue Error Manager list view.

Search by Recipient Results Displayed in the Queue Error Manager List View

Back to Top

Search by Template Type

To search for queue error messages and queued messages that have errors by template type:

1. Select the template type that you want to search for from the Template Type drop-down list.

Template Type Field in the Search Criteria

2. Click the <Read> button ( ). The system searches for any message that has a template

type that matches the type selected from the Template Type drop-down list.

3. The results are displayed in the Queue Error Manager list view.
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Search by Template Type Results Displayed in the Queue Error Manager List View

Back to Top

Search Using Multiple Search Criteria

To search for queue error messages and queued messages that have errors using multiple search criteria:

2. Enter all of the search criteria that you want to use to narrow your search in the Selection Criteria

fields. In our example, we entered information in the Start and End Date fields, the Account field, and

the Template Type field.

Multiple Fields Used in the Search Criteria

4. Click the <Read> button ( ). The system searches for any message that matches all of

the search criteria entered.

5. The results are displayed in the Queue Error Manager list view. In our example the messages that

appear in the results were sent within the time frame specified by the Start and End Date fields, the

account number matches the one entered in the Account field, and the template type is "HTML

Email" which was specified using the Template Type field.

Search by Multiple Search Criteria Results Displayed in the Queue Error Manager List View

Back to Top

Search for all Messages with Errors

To search for all queue error messages and queued messages that have errors:

1. Make sure all of the Selection Criteria fields are blank and "0) Any" is selected in the Template Type

field.
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No Search Criteria Entered

2. Click the <Read> button ( ). The system searches for all queue error messages and

queued messages that have errors.

3. The results are displayed in the Queue Error Manager list view. Note: If there are a lot of results, the

system takes longer to populate the Queue Error Manager list view. To achieve quicker processing

speeds, perform a search using one or more of the Selection Criteria fields to narrow the results.

Search Results Displayed in the Queue Error Manager List View

Back to Top

See also:

Edit and Re-queue Messages

Reattempt a Message

Search the Results

Export or Print a Report

Notification Queue Error Manager Screen

Notification Queue Error Manager Screen Details
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Search the Results

To search the results in the Queue Error Manager list view using the Queue Error Manager screen:

1. Perform a search to populate the Queue Error Manager list view. 

Queue Error Manager List View

2. Right-click inside the Queue Error Manager list view to bring up the Right-click Menu.

Right-click Menu

3. Select "Find" from the menu to open the Find dialog.

Find Dialog

4. Enter the text to search for in the Search field. In the following example, we will search for the text,

"Submitted."

Enter text in the Search Field
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5. Click <Find> to populate the Find list view with the results from the search. In our example we found

all the messages that involved a "submitted" application. Note: To narrow the results, enter more

detailed or specific text in the Search field.

Find List View Populated w ith the Results of the Search

The Find list view displays all of the items that include the text entered in the Search field. It also lists what

row number they are on in the Queue Error Manager list view, the name of the column that the search text

was found in, and the field that contained the search text.

Double-clicking on an item in the Find list view closes the Find dialog and displays the Queue Error

Manager list view with that item automatically selected.

Back to Top

See also:

Search for Messages with Errors

Edit and Re-queue Messages

Reattempt a Message

Notification Queue Error Manager Screen

Notification Queue Error Manager Screen Details
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View Message Details

To view the details of a message using the Queue Error Manager screen:

1. Perform a search to populate the Queue Error Manager list view.

2. Select a message in the Queue Error Manager list view to display the details of the message in the

fields below the Queue Error Manager list view.

Details of Message Displayed

The details displayed include the account number, template ID, template type, error code and description,

subject line of the message, and the body of the message.

In addition to viewing the details of a message, you can also attempt to send the message again, render the

message or send the message to the Manual Notification Handler screen to edit and/or re-queue the message.

Back to Top

See also:

Search for Messages with Errors

Edit and Re-queue Messages

Reattempt a Message

Render a Message

Notification Queue Error Manager Screen

Notification Queue Error Manager Screen Details
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Relocation Tool Screen

Use the Relocation Tool screen to export and import notification templates and wrappers. This tool makes it

easy to export notification templates and wrappers that you were testing on your Beta machine and import

them onto your Production machine so that you don't have to re-enter any data. You simply select the the

notification templates and wrappers that you want from one machine (e.g., your Beta machine), save them as

a file on your computer, and then import that file into another machine (e.g., your Production machine).

The Relocation Tool screen also enables you to save a backup file of all your notification templates and

wrappers on your computer.

See each of the following tabs for a description of the fields and buttons that appear on that tab:

· Export Tab

· Import Tab

How To Items
This screen allows you to:

· Export Templates and Wrappers
· Import Templates and Wrappers
· Preview a File to Export
· Preview a File to Import

Additional Information

For an example of this screen and definitions of each of the fields on this screen, see the Relocation Tool

Screen Details section.

This screen is accessed by going to Notification > Relocation Tool in the CIM GOLD tree view.
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Relocation Tool Screen

See also:

Relocation Tool Screen Details

Export Tab

Import Tab

Notification System
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Relocation Tool Screen Details

Use the Relocation Tool screen to export and import notification templates and wrappers. This tool makes it

easy to export notification templates and wrappers that you were testing on your Beta machine and import

them onto your Production machine so that you don't have to re-enter any data. You simply select the the

notification templates and wrappers that you want from one machine (e.g., your Beta machine), save them as

a file on your computer, and then import that file into another machine (e.g., your Production machine). 

The following tabs are on this screen:

· Export Tab: Use the Export tab to export templates and wrappers. You can also preview files to

export. See the help for this tab for an example of this screen and definitions of each of the fields on

this screen.

· Import Tab: Use the Import tab to import templates or wrappers, preview imported files, and read files.

See the help for this tab for an example of this screen and definitions of each of the fields on this

screen.

Relocation Tool Screen

Back to Top

See also:

Export Tab

Import Tab

Relocation Tool Screen

Notification System
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Export Tab

Use the Export tab to export templates and wrappers. You can also preview files to export.

See the following example of this tab followed by field and button descriptions. 

Export Tab

Field Descriptions

Field Description

Export Templates List View The Export Templates list view displays all of the notification

templates set up for your institution. Double-click on a template in this

list view to preview the selected template. You can also use this list

view to export templates.

The following columns display information in the Export Templates

list view:

· Checkbox: Check this field to select a template. You can also

use the column header of this column to automatically select all

of the templates, all of the active templates, all of the inactive

templates, or to select none of the templates.

· ID: Displays the identification (ID) number of the template.

· Type: Displays the template type.

· Description: Displays a description of the template.
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Field Description

· Effective Date: Displays the date the template became

effective.

· Last Changed Date: Displays the date the template was most

recently updated.

· Changed By: Displays the name of the person who most

recently updated the template.

Export Wrappers List View The Export Wrappers list view displays all of the notification

wrappers set up for your institution. Double-click on a wrapper in this

list view to preview the selected wrapper. You can also use this list

view to export wrappers.

The following columns display information in the Export Wrappers

list view:

· Checkbox: Check this field to select a wrapper. You can also

use the column header of this column to automatically select all

of the wrappers, all of the active wrappers, all of the inactive

wrappers, or to select none of the wrappers.

· ID: Displays the identification (ID) number of the wrapper.

· Type: Displays the wrapper type.

· Description: Displays a description of the wrapper.

· Effective Date: Displays the date the wrapper became effective.

· Last Changed Date: Displays the date the wrapper was most

recently updated.

· Changed By: Displays the name of the person who most

recently updated the wrapper.

Back to Top

Button Descriptions

Button Description

<Preview> Select, or highlight, a file in the Export Templates list view or the

Export Wrappers list view and click this button to preview the template

or wrapper.

<Export> Check the boxes next to the templates and wrappers that you want to

export in the Export Templates or the Export Wrappers list views and

click this button to export the files.

Back to Top

See also:
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Preview a File to Export

Export Templates and Wrappers

Export Tab

Import Tab

Relocation Tool Screen Details

Relocation Tool Screen

Notification System
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Import Tab

Use the Import tab to import templates or wrappers, preview imported files, and read files.

See the following example of this tab followed by field and button descriptions. 

Import Tab

Field Descriptions

Field Description

Import Templates List View The Import Templates list view displays all of the notification

templates that you have recently imported. Double-click on a template

in this list view to preview the selected template. Note: You must

import templates to populate this list view.

The following columns display information in the Import Templates

list view:

· ID: Displays the identification (ID) number of the template.

· Type: Displays the template type.

· Description: Displays a description of the template.

· Effective Date: Displays the date the template became

effective.

· Last Changed Date: Displays the date the template was most

recently updated.
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Field Description

· Changed By: Displays the name of the person who most

recently updated the template.

Import Wrappers List View The Import Wrappers list view displays all of the notification

wrappers that you have recently imported. Double-click on a wrapper

in this list view to preview the selected wrapper. Note: You must

import wrappers to populate this list view.

The following columns display information in the Import Wrappers

list view:

· ID: Displays the identification (ID) number of the wrapper.

· Type: Displays the wrapper type.

· Description: Displays a description of the wrapper.

· Effective Date: Displays the date the wrapper became effective.

· Last Changed Date: Displays the date the wrapper was most

recently updated.

· Changed By: Displays the name of the person who most

recently updated the wrapper.

Transmission Servers List View Note: This list view is visible only to GOLDPoint Systems Editor

Users.

The Transmission Servers list view displays all of the transmission

servers that you have recently imported. Transmission servers are the

systems that are used to actually deliver the notifications. Each type

of notification (e.g., text and email) is sent using a different

transmission server. And these servers can send only that one type of

notification. Note: You must import a file server to populate this list

view.

The following columns display information in the Transmission

Servers list view:

· Import File Servers: Displays the file servers that have been

imported.

· Available Servers: Displays the available transmission servers

on the current machine. You can use the drop-down field in this

column to select a file server from those available. This allows

you to easily change templates and wrappers using the

transmission server from a previous machine (e.g., Alpha, Beta,

etc.) to the transmission server used on the current machine

(e.g., Beta, Production, etc.).

Search Enter the name of the file that you want to import in this field and click

the <Read File> button to display the file's contents on the Import tab.
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Field Description

You can also use the <Browse...> button to search your computer for

a file to import.

Back to Top

Button Descriptions

Button Description

<Browse...> Click this button to search for a file to import.

<Read File> Enter the name of a file in the Search field and click this button to

read the file and display its contents on the Import tab. Note: If the

<Read File> button isn't enabled after you enter the file name, it is

because the program can't find the file on your computer. Double

check the file name or path that you entered.

<Preview> Select, or highlight, a file in the Import Templates list view or the

Import Wrappers list view and click this button to preview the

template or wrapper.

<Import> Click this button to import the file in the Search field.

Back to Top

See also:

Preview a File to Import

Import Templates and Wrappers

Relocation Tool Screen Details

Relocation Tool Screen

Notification System
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Export Templates and Wrappers

Using the Export tab on the Relocation Tool screen, you can export templates and wrappers.

To export templates and wrappers, complete the following steps:

1. Select, or highlight, the templates and wrappers that you want to export from the Export Templates list

view and the Export Wrappers list view. In our example, we selected all of the templates and all of the

wrappers by selecting "All" from the drop-down Checkbox column headers to easily select all of the

templates and wrappers. Note: You may want to preview a template or wrapper before you export it to

make sure that it is the file that you want to export.

Select Templates and Wrappers to Export

2. Click <Export> to open the Export File dialog.

3. Select the folder where you want to save the file.

4. Enter the name of the file in the File name: field and click <Save>.
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Select Folder to Save the XML File In

5. This brings up the Save Successful dialog.

6. Click <OK>.

Saved the File

The XML file containing the templates and wrappers is now saved on your computer.
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File Saved on Computer

Back to Top

See also:

Preview a File to Export

Import Templates and Wrappers

Export Tab

Relocation Tool Screen Details

Relocation Tool Screen

Notification System
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Import Templates and Wrappers

Using the Import tab on the Relocation Tool screen, you can import templates and wrappers. You can import

templates and wrappers using two methods:

1. Use the <Browse...> Button to Find the File

2. Use the <Read File> Button to Find the File

Use the <Browse...> Button to Find the File

To import templates and wrappers using the <Browse...> button, complete the following steps:

1. Click the <Browse...> button to search your computer for a file to import.

Import Tab

2. Navigate to the folder where the file that you want to import is located.

3. Select the file and click <Open>.



Notification System 185

© 2021 GOLDPoint Systems. Last updated: 2/17/2021

XML File to Import in a File on the Computer

4. The contents of the file are now loaded onto the Import tab. You can now see all of the templates and

wrappers that you can import. Note: The Transmission Servers list view is visible only to GOLDPoint

Systems Editor Users.

5. Click <Import> to import the file. Note: You may want to preview the files before you import them to

ensure they are the templates and wrappers that you want to import.

File Loaded Onto the Import Tab
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6. Confirm that you want to import the file. WARNING: The templates and wrappers that you import will

replace existing templates and wrappers.

7. Once you have confirmed that you want to import the templates and wrappers from the file, click

<Yes> to import the file.

Confirm Import Dialog

8. The file is imported into CIM GOLD and existing templates and wrappers are overwritten with the

templates and wrappers from the file.

9. Click <OK>.

File Successfully Imported

Back to Top

Use the <Read File> Button to Find the File

To import templates and wrappers using the <Read File> button to find the file, complete the following steps:

1. Enter the name of the file that you want to import in the Search field.
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Import Tab

2. Click <Read File> to search for the file on your computer and load it onto the Import tab. Note: If the

<Read File> button isn't enabled after you enter the file name, it is because the program can't find the

file on your computer. Double check the file name or path that you entered.

XML File Name Entered in Search Field and the <Read File> Button



Notification System188

© 2021 GOLDPoint Systems.Last updated: 2/17/2021

3. The contents of the file are now loaded onto the Import tab. You can now see all of the templates and

wrappers that you can import. Note: The Transmission Servers list view is visible only to GOLDPoint

Systems Editor Users.

4. Click <Import> to import the file. Note: You may want to preview the files before you import them to

ensure they are the templates and wrappers that you want to import.

File Loaded Onto the Import Tab

5. Confirm that you want to import the file. WARNING: The templates and wrappers that you import will

replace existing templates and wrappers.

6. Once you have confirmed that you want to import the templates and wrappers from the file, click

<Yes> to import the file.

Confirm Import Dialog

7. The file is imported into CIM GOLD and existing templates and wrappers are overwritten with the

templates and wrappers from the file.

8. Click <OK>.
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File Successfully Imported

Back to Top

See also:

Preview a File to Import

Export Tab

Relocation Tool Screen Details

Relocation Tool Screen

Notification System
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Preview a File to Export

Using the Export tab on the Relocation Tool screen, you can preview a file that you might want to export. This

allows you to make sure that the template or wrapper that you are about to export is the right file.

To preview a file to export, complete the following steps:

1. Select, or highlight, a template or wrapper to preview from the Export Templates list view or the Export

Wrappers list view. In our example, we selected a template.

Template to Preview Highlighted

2. Double-click on the selected file or click the <Preview> button to preview it in a separate dialog.

Preview of Selected File

3. Once you have finished previewing the template or wrapper, close the Preview dialog.

For information on what to do after previewing a file, see how to Export Templates and Wrappers.
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Back to Top

See also:

Export Templates and Wrappers

Export Tab

Relocation Tool Screen Details

Relocation Tool Screen

Notification System
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Preview a File to Import

Using the Import tab on the Relocation Tool screen, you can preview a file that you might want to import. This

allows you to make sure that the template or wrapper that you are about to import is the right file.

To preview a file to import, complete the following steps:

1. Select, or highlight, a template or wrapper to preview from the Import Templates list view or the Import

Wrappers list view. In our example, we selected a template.

Template to Preview Highlighted

2. Double-click on the selected file or click the <Preview> button to preview it in a separate dialog.

Preview of Selected File

3. Once you have finished previewing the template or wrapper, close the Preview dialog.

For information on what to do after previewing a file, see how to Import Templates and Wrappers.

Back to Top
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See also:

Import Templates and Wrappers

Import Tab

Relocation Tool Screen Details

Relocation Tool Screen

Notification System
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Solutions by Text History Screen

Use the Solutions by Text History screen to retrieve archived text messages and view the details of those

messages. Archived text messages include any text message that has been created.

Note: This screen is used only for third-party texting. To use the Solutions by Text Mapping screen, you must
have the proper security set up for your institution and employees (see Security below).

How To Items
This screen allows you to:

· Export search results
· Perform a search

Additional Information

For an example of this screen and definitions of each of the fields on this screen, see the Notification Solutions

by Text History Screen Details section. 

This screen is accessed by going to Notification > Solutions by Text History in the CIM GOLD tree view.

Security

In order to use this screen, your institution must:

· Be set up to use the Solutions by Text Institution Option (USBT). An account manager must set

this option up for your institution.

· Subscribe to it on the Security > Subscribe To Mini-Applications screen by checking the

Notification > Solutions by Text History box and clicking <Save Changes>. The screen will then

appear in the left tree-view navigation of CIM GOLD if the user has security.

· Set up employees and/or profiles with either Inquire (read-only) or Maintain (edit) security for it

on the CIM GOLD tab of the Security > Setup screen.

https://secure.goldpointsystems.com/gpsdocs/other/SecurityCIMGOLD/index.asp?subscribetomini-applicationsscreen.asp
https://secure.goldpointsystems.com/gpsdocs/other/SecurityCIMGOLD/index.asp?cimgoldtab_secsets.asp
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Solutions by Text History Screen

See also:

Solutions by Text History Screen Details

Perform a Search

Export Search Results

Notification System
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Solutions by Text History Screen Details

Use the Solutions by Text History screen to retrieve archived text messages and view the details of those

messages. Archived text messages include any text message that has been created. This screen also allows

you to narrow your search of text messages using a variety of search parameters. When an archived text

message is selected, the details of the message are displayed in a pop-up dialog. You can also export your

data.

Note: This screen is used only for third-party texting and for those institutions with Institution Option USBT set

up.

See the following examples of this screen followed by field and button descriptions. 

Solutions by Text History Screen

Field Descriptions
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Field Description

Start Date Use the Calendar icon to select a beginning date for the date range.

The text message(s) that occurred during the selected date range

(between the Start Date and the End Date) will appear in the Results

list view.

End Date Use the Calendar icon to select an ending date for the date range. The

text message(s) that occurred during the selected date range

(between the Start Date and the End Date) will appear in the Results

list view.

Template ID Enter a template identification number in this field to search only for

text messages sent using a specific template.

Recipient Phone Enter the phone number for the customer who received the text

message to search for text messages sent to a particular individual.

You can enter a partial number that will return all results that contain

the partial number. For example, if you enter "801" in the search, the

results will return all numbers with an 801 area code and all numbers

that contain "801" anywhere in the number (e.g., 1-459-377-8011).

Note: The most effective way to search for a specific number is to

enter the entire number in the following format: 1aaaeeedddd, where

aaa is the area code, eee is the prefix, and dddd is the suffix.

Keyword Enter text from the subject or message body of the archived text

message(s) that you are searching for in this field. 

Entering upper- or lower-case letters does not affect the search

results. For example, entering "test" in this field brings up messages

that contain the words "test," "Test," "TEST," "testing," "Testing,"

"TESTING," etc. You can also enter partial words.

The text must be entered in the order in which it appears in the

message body. For example, if you enter "Just a reminder," text

messages with "Just a friendly reminder" will not appear in the results

because the word friendly does not match the text entered in the

search parameter.

This field also supports wild-card characters. You can input an

asterisk (*) to indicate that there are zero to more unknown characters

or you can input a question mark (?) to indicate that there is exactly

one unknown character. For example, if you enter "L*N," the search

retrieves all results that include any combination of "L" and "N" with

unknown characters in between, such as LOAN, LENDER, LEND,

LENDING, LEPRECHAUN, etc. However, if you enter "L?N," the

search retrieves only results that include a combination of "L" and "N"
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Field Description

with only a single unknown character in between, such as LENDER,

LEND, LENDING, etc.

Brand ID Select a brand from this drop-down list to filter your search by brand

ID (identification number of the subsidiary organization within your

principal organization). All messages that were sent using the brand

are displayed in the Results list view.

Account ID Enter an account identification number in this field to search only for

text messages sent using a specific account. The account number is

the primary identifier for ownership of an account.

Is Reply Check this field to display messages that were sent as a reply in the

Results list view. Replies are when a customer uses their phone to

reply to a message that your institution sends to them.

A message that is neither a response or a reply is a message that is

automatically generated by the system.

Results List View The Results list view displays all of the archived text messages that

match the entered search parameters. These messages are sorted

according to the date and time they were added (Start Date). Double-

click on a text message in this list view to open the Text Message

Details dialog and view all of the details for the selected text

message. You can move the columns in this list view into any order

that you want by clicking and holding on a column heading while you

move it left or right. Note: When data is exported to a file, the

columns are sent in the original order and do not reflect any changes

that you have made to the column order on the screen.

The following columns display information in the Results list view:

· Archive ID: Displays the unique identification number assigned

to the text message in the text history archives.

· Account ID: Displays the account identification number

associated with the text message. The account number is the

primary identifier for ownership of an account.

· Date Sent: Displays the date and time when the text message

was sent.

· Template ID: Displays the unique identification number

assigned to the template the text message used.

· Brand ID: Displays the unique identification number assigned to

the brand (subsidiary organization within the principal

organization) the text message used.

· Recipient Phone: Displays the phone number for the recipient.

· Message: Displays the body of the text message.
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Field Description

· Succeeded: Displays whether or not the text message was

successfully sent (Y/N).

· Is Reply: Displays whether or not the text message was a reply

(Y/N).

· Result Code: Displays the code for the type of result.

· Status: Displays the status of the text message.

· Sender Program: Displays the program used to send the text

message.

· Account Type: Displays the account type associated with the

text message.

· Transaction Ticket: Displays the transaction ticket number

associated with the text message.

· Keyword: Displays the keyword associated with the text

message.

· Is Marketing: Displays whether or not the type of text message

sent was marketing (Y/N).

· Unique ID: Displays the unique identification number assigned

to the text message.

Back to Top

Button Descriptions

Button Description

<Clear Search> Click this button to clear all of the data entered in the Search

Parameters fields.

<Export> Click this button to export the data in the Results list view. 

<Search> Click this button to search the text messages archive for the text

messages that match the search parameters entered.

<Previous> Click this button to view the previous text message.

<Next> Click this button to view the next text message.

Back to Top

See also:

Solutions by Text History Screen

Perform a Search

Export Search Results

Notification System
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Export Search Results

To save the information displayed in the Results list view into a text or other file using the Solutions by Text

History screen:

1. Perform a search.

2. Once you have the data that you want displayed in the Results list view, highlight or select the data

that you want to export. You can select as many lines of data as are displayed in the Results list

view. 

You can select multiple, sequential lines by clicking on the first item and then pressing and holding

down <Shift> as you click on the last item. You can also select multiple lines by pressing and holding

down <Ctrl> as you click on each of the lines that you want to select. You must continue to hold down

<Ctrl> the entire time you are selecting lines or you will lose your selections. Note: If no items are

selected, all items are exported.

3. After you have selected all of the data you want to save, click <Export>.

<Export> Button on the Solutions by Text History Screen

4. Clicking the <Export> button brings up the Save As dialog. Browse to the location where you want to

save the file and enter the name of the file in the File name: field.

5. Click <Save>.
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Save As Dialog

6. The file is saved onto your computer or network. To open the file, either double-click on it or right-click

on it and select "Open" from the right-click menu. The saved file contains all of the text history line

items you selected.
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File Saved on Computer or Network

Back to Top

See also:

Solutions by Text History Screen

Solutions by Text History Screen Details

Perform a Search

Notification System
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Perform a Search

To perform a search using the Solutions by Text History screen:

1. Use the Solutions by Text History fields to enter your search parameters. You can search by phone

number, keyword, date, etc. The more search parameters that you enter, the more specific your

search results will be. Clicking on the <Clear Search> button clears the fields. In our example, we

selected a Start Date and an End Date and selected a Brand ID to search for all text messages that

were sent using the brand ID "1" from the end of April to August 3rd.

2. Once you have entered all of your search parameters, click the <Search> button.

Solutions by Text History Screen - <Search> Button

3. The search results that match the parameters entered are displayed in the Results list view. For our

example, all text messages that were sent using Brand ID 1 from April to August were displayed in the

search results.
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Solutions by Text History Screen with Search Results

4. After receiving the results of your search, you can perform a new search with more search parameters

to narrow your results, view the details of specific text messages, export your search results, or exit

the screen.

Back to Top

See also:

Solutions by Text History Screen

Solutions by Text History Screen Details

Export Search Results

Notification System
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Solutions by Text Mapping Screen

Use the Solutions by Text Mapping screen to select a Solutions by Text template and map it to a specific

template within the Notification System. You can also create new mapped templates, delete mapped

templates no longer used, and modify mapped templates.

The Solutions by Text Mapping screen enables the template numbers within the Notification System to be

assigned to Solutions by Text template numbers. The Solutions by Text Mapping screen reads every template,

not just active ones. We have also added measures to ensure that if you try to delete a mapped template that

has a template tied to it, the system won’t allow you to delete the mapped template until it has been removed

from the template. Also, if a new mapping is created with a duplicate mapping ID, the description and the row

with the duplicate stay the same.

Note: This screen is used only for third-party texting. To use the Solutions by Text Mapping screen, you must
have the proper security set up for your institution and employees (see Security below).

Additional Information

For an example of this screen and definitions of each of the fields on this screen, see the Solutions by Text

Mapping Screen Details section. 

This screen is accessed by going to Notification > Solutions by Text Mapping in the CIM GOLD tree view.

Security

In order to use this screen, your institution must:

· Be set up to use the Solutions by Text Institution Option (USBT). An account manager must set

this option up for your institution.

· Subscribe to it on the Security > Subscribe To Mini-Applications screen by checking the

Notification > Solutions by Text Mapping box and clicking <Save Changes>. The screen will then

appear in the left tree-view navigation of CIM GOLD if the user has security.

· Set up employees and/or profiles with either Inquire (read-only) or Maintain (edit) security for it

on the CIM GOLD tab of the Security > Setup screen.

https://secure.goldpointsystems.com/gpsdocs/other/SecurityCIMGOLD/index.asp?subscribetomini-applicationsscreen.asp
https://secure.goldpointsystems.com/gpsdocs/other/SecurityCIMGOLD/index.asp?cimgoldtab_secsets.asp
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Solutions by Text Mapping Screen

See also:

Solutions by Text Mapping Screen Details

Notification System
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Solutions by Text Mapping Screen Details

Use the Solutions by Text Mapping screen to select a Solutions by Text template and map it to a specific

template within the Notification System. You can also create new mapped templates, delete mapped

templates no longer used, and modify mapped templates.

Note: This screen is used only for third-party texting and for those institutions with the Solutions by Text

Institution Option (USBT) set up.

See the following examples of this screen followed by field and button descriptions. 

Solutions by Text Mapping Screen

Field Descriptions

Field Description

Templates List View The Templates list view displays all of the Solutions by Text
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Field Description

templates that have been set up for your institution via the third party

Solutions by Text. Clicking on a template displays the details of the

template in the Template Preview fields and enables you to update the

mapping for that template.

Note: You can move the columns in this list view into any order that

you want by clicking and holding on a column heading while you move

it left or right.

The following columns display information in the Templates list view:

· SBT ID: Displays the unique Solutions by Text identification

number assigned to the template.

· Description: Displays a description of the template.

· Mapped ID: Displays the unique identification number of the

GOLDPoint Systems template that the Solutions by Text

template is mapped to.

· Brand ID: Displays the Brand ID (identification number of the

subsidiary organization within your principal organization) that

the template is tied to.

SBT Template ID This field displays the Solutions by Text template identification

number of the template selected in the Templates list view.

Templates Mapped ID Enter the identification number of the GOLDPoint Systems template

that you want the Solutions by Text template selected in the

Templates list view mapped to in this field. Then click <Update

Mapping> to tie those templates together.

Brand ID This field displays the Brand ID (identification number of the subsidiary

organization within your principal organization) that the template

selected in the Templates list view is tied to.

Message This field displays the body of the text message for the Solutions by

Text template selected in the Templates list view.

Mapped Templates List View The Mapped Templates list view displays all of the GOLDPoint

Systems templates that have been set up for your institution via the

Notification System. These templates can be mapped to Solutions By

Text templates so that the templates in the Notification System will

work seamlessly with Solutions by Text. Clicking on a template

displays the details of the template in the fields below and enables

you to update that template.
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Field Description

Note: You can move the columns in this list view into any order that

you want by clicking and holding on a column heading while you move

it left or right.

The following columns display information in the Mapped Templates

list view:

· Mapped ID: Displays the unique identification number of the

GOLDPoint Systems template that a Solutions by Text template

can be mapped to.

· Description: Displays a description of the template.

Mapped ID This field displays the identification number of the GOLDPoint

Systems template selected in the Mapped Templates list view. The

Mapped ID is used to map a Solutions by Text template to a

GOLDPoint Systems template using the Templates Mapped ID field.

Description Enter or update the description for the template selected in the

Mapped Templates list view. Make sure the description is unique and

accurately describes the function of the template.

Back to Top

Button Descriptions

Button Description

<Delete Mapping> Click this button to delete the mapping for the template selected in

the Templates list view. This will delete the mapped ID for the selected

template and the Solutions by Text template will no longer be mapped

to the GOLDPoint Systems template specified in the Templates

Mapped ID field.

<Update Mapping> Click this button to update the mapping for the template selected in

the Templates list view. This will update the mapped ID for the

selected template and the Solutions by Text template will now be

mapped to the GOLDPoint Systems template specified in the

Templates Mapped ID field.

<New Mapped Template> Click this button to create a new GOLDPoint Systems template that

the Solutions by Text templates can be mapped to. Clicking this

button enables both the Mapped ID and Description fields. Once you

have entered information in both those fields, click the <Save Mapped

Template> to save the newly created template. The new template will

then appear in the Mapped Templates list view.
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Button Description

<Delete Mapped Template> Click this button to delete the template selected in the Mapped

Templates list view.

<Save Mapped Template> Click this button to save any changes made to the template selected

in the Mapped Templates list view. You also need to click this button

to save a newly created mapped template.

Back to Top

See also:

Solutions by Text Mapping Screen

Notification System
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Templates Screen

Use the Notification Templates screen to search for, create, modify, or delete notification templates. You can
also use this screen to view the notification templates set up for your institution, delete notification templates,
activate inactive notification templates, and to render a test notification to ensure that the body, subject, etc. of
a notification have been set up correctly.

How To Items
This screen allows you to:

· Access a template on the Detail tab from the Summary tab
· Activate an inactive template
· Copy a template to create a new template
· Create a new template
· Delete notification templates
· Inactivate a notification template
· Modify or view an existing template
· Render a test template
· Search for templates on the Summary tab

Additional Information

For an example of this screen and definitions of each of the fields on this screen, see the Notification

Templates Screen Details section. 

This screen is accessed by going to Notification > Templates in the CIM GOLD tree view.
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Notification Templates Screen > Summary Tab

Notification Templates Screen > Detail Tab
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See also:

Notification Templates Screen Details

Notification System
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Notification Templates Screen Details

Use the Notification Templates screen to search for, create, modify, or delete notifications. You can also use
this screen to view the notification templates set up for your institution, delete notification templates, activate
inactive notification templates, and to render a test notification to ensure that the body, subject, etc. of a
notification have been set up correctly.

To learn more about the fields and buttons available on the Notification Templates screen, see the following
tabs:

· Summary Tab: Use the Summary tab to search for and view the notification templates set up for your
institution. You can also use this tab to delete notification templates, activate inactive notification
templates, and to access templates on the Detail tab.

· Detail Tab: Use the Detail tab to create, modify, or delete notifications. You can also use this tab to
render a test notification to ensure that the body, subject, etc. of a notification have been set up
correctly.

Notification Templates Screen > Summary Tab
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Notification Templates Screen > Detail Tab

Back to Top

See also:

Notification Templates Screen

Notification System
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Summary Tab

Use the Summary tab to search for and view the notification templates set up for your institution. You can also
use this tab to delete notification templates, activate inactive notification templates, and to access templates
on the Detail tab.

See the following example of this screen followed by field and button descriptions.

Notification Templates Screen > Summary Tab

Field Descriptions

Field Description

ID Enter the identification number of the notification template to display

that template in the Templates Summary list view. Entering a partial

identification number displays all templates that have those same

numbers.

Type Select the format type (Email (HTML or text) or Text (SMS)) of the

notification to display all notifications that match the selected format

type in the Templates Summary list view.
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Field Description

Note: If you want to be set up to be able to sent notifications via text

(SMS), please contact your GOLDPoint Systems client solutions

specialist.

Description Enter a partial or full description of the notification to display all

notifications that contain that description in the Templates Summary

list view.

Text Enter any text that you want to search for in this field. All notifications

that contain that text will be displayed in the Templates Summary list

view.

Show Only Active and Future

Templates

Check this field to display only currently active templates and the

templates that will activate in the future in the Templates Summary

list view. If this field is left blank, all templates are displayed.

Templates Summary list view The Templates Summary list view displays the notification

templates set up for your institution. If you check the Show Only

Active and Future Templates field, only the currently active templates

and the templates that will activate in the future are displayed. If the

Show  Only Active and Future Templates field is left blank, all

templates are displayed.

You can enter values in the search parameter fields and perform a

search to specify what notification templates are displayed in the

Templates Summary list view.

The following columns display information in the Templates

Summary list view and can be used to sort:

· Active: Displays whether or not the notification template is

active and can be used.

· ID: Displays the identification number of the notification

template.

· Type: Displays the format type of the notification (Email (HTML

or text) or Text (SMS)).

· Effective Date: Displays the date when the notification became

effective or will become effective (start being sent).

· Description: Displays a description of the notification.

· Template Category: Displays the category of the template

(transaction, marketing, etc.).

· Changed By: Displays the name of the user who last modified

the notification.

· Date/Time Modified: Displays the date (in MMDDYYYY

format) and time (in HHMMSS format in a 24-hour clock format)

when the user in the Changed By column modified the

notification.
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Back to Top

Button Descriptions

Button Description

<Search> Enter values in the search parameter fields and click this button to

perform a search to specify what notification templates are displayed

in the Templates Summary list view.

<Test> Click this button to render a test notification on the Detail tab to

ensure that the body, subject, etc. of a notification have been set up

correctly.

<Copy> Click this button to copy the format of the current template to create a

new template.

<Delete> Click this button to delete the notification currently selected in the

Templates Summary list view.

<Create New> Click this button to load a blank template on the Detail tab.

<Save Changes> Click this button to save any change made to the Notification

Templates screen.

Back to Top

See also:

Notification Templates Screen

Notification System
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Detail Tab

Use the Detail tab to create, modify, or delete notifications. You can also use this tab to render a test
notification to ensure that the body, subject, etc. of a notification have been set up correctly.

See the following example of this screen followed by field and button descriptions.

Notification Templates Screen > Detail Tab

Field Descriptions

Field Description

Template ID Enter the identification number for the notification template in this

field. If you selected a template on the Summary tab, this field

displays the identification number for the selected notification

template. Note: When creating custom templates, the template ID

must be within the range of 10000–11999.

You can load a specific notification template onto this screen by

searching for that template on the Summary tab and double-clicking

on the template in the Templates Summary list view.

Template Type Select the format type of the notification to be sent (Email (HTML or

text) or Text (SMS)) from this drop-down list. Note: If you want to be

set up to be able to sent notifications via text (SMS), please contact

your GOLDPoint Systems client solutions specialist.
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Field Description

Effective Date Enter the date when the notification should become effective (start

being sent). Enter the date using MM/DD/YYYY format, or use the

drop-down calendar to select the date.

Template Category Select from this drop-down field whether the notification will be a

transactional or marketing notification. If the notification is set up as a

marketing notification, customers who have opted out to receive

marketing texts or emails will not receive any texts or emails with

marketing templates. For more information, see the help for the

Borrower Opt Out table on the CIF tab of the Marketing and

Collections screen.

Server ID Enter the identification number of the server used for notifications in

this field.

Description Enter a description of the notification in this field. Try to be descriptive

so that others can easily tell the purpose for this notification when it is

listed in the Templates Summary list view on the Summary tab.

Send As Enter the email address (e.g.,

CustomerCare@GOLDPointsystems.com) to be used to send

notifications in this field. This is the email address that users will see

as the sender of the notification.

Reply To Enter the email address (e.g.,

CustomerCare@GOLDPointsystems.com) that emails will be sent to

when a user replies to the notification in this field.

Subject Enter the title of the notification that will appear in the subject line in

this field.

Body Enter the code and text to be used in the email or text notification in

this field. In this field you can specify the font, style, wording, etc. of

the notification.

The following special characters entered in the text of the body of the

notification could interfere with how a message is displayed in an

HTML browser: (&), (<), (>), ('), and ("). The program will substitute the

specified parameter whenever <parm:####> is entered in the code

where #### is the parameter name.

Is Active Check this field to activate the notification. If this field is not checked,

the notification will not be active and will not appear on the Summary

tab if the Show Only Active and Future Templates field is checked.

Uses Wrapper Check this field to include a wrapper on the notification. Wrappers are

the institution branding that is applied to the notifications. Wrappers

https://secure.goldpointsystems.com/gpsdocs/loans/LoansCIMGOLD/index.asp?ciftab_mac.asp
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Field Description

display your institution's logos, advertising, and selected verbiage in

the header and footer of the notification. For more information on

setting up wrappers, see the Wrappers screen.

Originators grid The Originators grid displays the originating systems that can be

used for the notification template. Check the Use box next to the

originating system that you want to use for the template. 

This can enable you to tie specific templates to loan origination, loan

servicing, etc. For example, your institution can use a different

template with a different wrapper for origination and loan servicing. The

template for origination might include a wrapper with advertising while

the template for loan servicing does not. And the system can

automatically use the correct template with the correct wrapper

depending on the system that is sending the notification.

The following columns display information in the Originators grid:

· Use: Use this checkbox to select the originating system for the

notification.

· Originator: Displays the originating systems that can be tied to

the notifications.

Change History list view The Change History list view displays who has modified the

notification and when they modified it. The following columns display

information in the Change History list view and can be used to sort:

· Changed By: Displays the name of the user who last modified

the notification.

· Date Changed: Displays the date (in MMDDYYYY format) when

the user in the Changed By column modified the notification.

· Time Changed: Displays the time (in HHMMSS format in a 24-

hour clock format) when the user in the Changed By column

modified the notification.

Back to Top

Button Descriptions

Button Description

<Test> Click this button to render a test notification on the Detail tab to

ensure that the body, subject, etc. of a notification have been set up

correctly.
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Button Description

<Copy> Click this button to copy the format of the current template to create a

new template.

<Delete> Click this button to delete the notification currently selected in the

Templates Summary list view.

<Create New> Click this button to load a blank template on the Detail tab.

<Save Changes> Click this button to save any change made to the Notification

Templates screen.

Back to Top

See also:

Notification Templates Screen

Notification System

Wrappers Screen
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Access Template on Detail Tab

To access a template on the Detail tab using the Summary tab:

1. Perform a search for the template on the Summary tab. 

2. Select a template from the Templates Summary list view.

Template Selected in Templates Summary List View

3. Double-click on the template to load the selected template on the Detail tab.

Selected Template Loaded on the Detail Tab

4. Once the template is loaded onto the Detail tab, you can modify the template, render a test

notification, and ensure that the text, body, subject, etc. of a notification have been set up correctly.

Back to Top
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See also:

Notification Templates Screen

Notification Templates Screen Details

Notification System
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Activate Inactive Templates

Inactive templates are older templates that are no longer being used. To activate an inactive template on the

Summary tab of the Notification Templates screen:

1. Uncheck the Show Only Active and Future Templates field to display all of the templates that are

active, set to become active, and inactive.

2. Perform a search for the template that you want to activate. 

3. Select the inactive template from the Templates Summary list view.

Template Selected in Templates Summary List View

4. Double-click on the template to load the selected template on the Detail tab of the Notification

Templates screen.

Inactive Template Loaded on Detail Tab

5. Check the Is Active field to activate the template.
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Check the Is Active Field

6. Make any other needed modifications to the template and click <Save Changes> to save the now-

active notification template. Note: You can also render a test notification to ensure that the text, body,

subject, etc. of the notification have been set up correctly before you save the changes by clicking the

<Test> button.

Back to Top

See also:

Notification Templates Screen

Notification Templates Screen Details

Notification System
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Copy Templates

To create a new template by copying an existing template on the Notification Templates screen:

1. Click the <Copy> button on the Summary tab or Detail tab to bring up the Copy Template dialog.

The <Copy> Button on the Summary Tab

Copy Template Dialog

2. Double-click on the template that you want to copy to load the selected template on the Detail tab.
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Select Template on Copy Template Dialog

Copied Template on the Detail Tab

3. You will be required to enter a new identification number in the Template ID field. Note: When creating

custom templates, the template ID must be within the range of 10000–11999.
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Copied Template on the Detail Tab with New Template ID

4. You can now make changes to the template by changing any of the information in the file maintainable

fields.

5. Once the template is set up the way that you want it to be, render a test notification to ensure that the

text, body, subject, etc. of the notification have been set up correctly.

6. After you have ensured that everything is set up correctly, click <Save Changes> to save your

changes and create the new template.

7. The new template is now set up and appears in the Templates Summary list view on the Summary

tab.

New Template in Templates Summary List View

Back to Top

See also:

Notification Templates Screen
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Notification Templates Screen Details

Notification System
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Create New Templates

To create a new template on the Notification Templates screen:

1. Click the <Create New> button in the lower, right-hand corner of the Summary tab or Detail tab.

<Create New> Button on Summary Tab

<Create New> Button on Detail Tab

2. Clicking the <Create New> button loads a blank template onto the Detail tab.
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Blank Template

3. Enter the information for the new notification template into the fields on the Detail tab. The Template

ID, Template Type, Effective Date, and Server ID fields are required fields and must have information

entered into them in order to save the template or render a test notification. Note: When creating

custom templates, the template ID must be within the range of 10000–11999.

4. When you have entered information into the required Template ID, Template Type, and Effective

Date fields, the <Test> button is enabled which allows you to render a test notification. After you have

entered information into the required fields and other fields (e.g., the Description field), the <Save

Changes> button is enabled allowing you to save the new template.

New Template
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5. Once you have entered in all of the information for your new template, render a test notification to

ensure that the body, subject, etc. of the notification have been set up correctly.

6. After you have ensured that everything is set up correctly, click <Save Changes> to activate and save

the new template. The new template will be activated on the system and added to the Summary tab of

the Notification Templates screen.

New Template Added to Templates Summary List View on the Summary Tab

Back to Top

See also:

Notification Templates Screen

Notification Templates Screen Details

Notification System
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Delete Templates

You can use the Notification Templates screen to easily delete notification templates that are no longer useful.

Templates can be deleted using either the Detail tab or the Summary tab of the Notification Templates screen.

· Delete a template using the Detail tab

· Delete a template using the Summary tab

Delete a Template on the Detail Tab

To delete a template on the Detail tab of the Notification Templates screen:

1. Load an existing template onto the Detail tab.

Template to be Deleted

2. Click <Delete> to delete the notification template displayed on the screen. Warning: Once a template

is deleted, it cannot be recovered. The template is completely removed from the server.

3. This brings up a Question dialog to ensure that you purposefully want to delete the notification

template.
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Delete Template Question Dialog

4. Click <Yes> to proceed to delete the notification template. An Information Message dialog appears

informing you that the template has been deleted.

Template Deleted Information Message Dialog

5. Click <OK>. The information for the template has been removed from the Detail tab and the notification

template has been removed from the Templates Summary list view on the Summary tab.

Back to Top

Delete a Template on the Summary Tab

To delete a template on the Summary tab of the Notification Templates screen:

1. Perform a search for the template on the Summary tab.

2. Select a template from the Templates Summary list view.

Template Selected in Template Summary List View



Notification System236

© 2021 GOLDPoint Systems.Last updated: 2/17/2021

3. Once a template is selected, the <Delete> button becomes active.

<Delete> Button on the Summary Tab

4. Click <Delete> to bring up the Delete Template Question dialog.

Delete Template Question Dialog

5. Click <Yes> to delete the selected template and remove it from the Templates Summary list view.

Warning: Once a template is deleted, it cannot be recovered. The template is completely removed

from the server.
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Template Removed from Templates Summary List View

Back to Top

See also:

Notification Templates Screen

Notification Templates Screen Details

Notification System
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Inactivate Templates

If your institution no longer wishes to use a template, you can inactivate the template so that those types of

notifications are no longer sent. To inactivate a template on the Summary tab of the Notification Templates

screen:

1. Perform a search for the template that you want to make inactive. 

2. Select the active template from the Templates Summary list view.

Template Selected in Template Summary List View

3. Double-click on the template to load the selected template on the Detail tab of the Notification

Templates screen.

Active Template Loaded on the Detail Tab

4. Uncheck the Is Active field to make the template inactive.



Notification System 239

© 2021 GOLDPoint Systems. Last updated: 2/17/2021

The Is Active Field is Blank

5. Click <Save Changes> to save your changes and inactivate the template.

Back to Top

See also:

Notification Templates Screen

Notification Templates Screen Details

Notification System
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Modify or View Existing Templates

To modify or view an existing template using the Summary tab of the Notification Templates screen:

1. Perform a search for the template on the Summary tab.

2. Select a template from the Templates Summary list view.

Template Selected in Templates Summary List View

3. Double-click on the template to load the selected template on the Detail tab of the Notification

Templates screen.

Selected Template Loaded on Detail Tab

4. Once the template is loaded onto the Detail tab, you can view and modify the existing template.

5. Change any of the information in the fields. Note: If you change the Template ID or Template Type

field, you will no longer be modifying the existing template but will create a new template.



Notification System 241

© 2021 GOLDPoint Systems. Last updated: 2/17/2021

6. Once you have made all of the modifications to the existing template, render a test notification to

ensure that the text, body, subject, etc. of the notification have been set up correctly.

7. After you have ensured that everything is set up correctly, click <Save Changes> to save your

changes to the existing template.

Back to Top

See also:

Notification Templates Screen

Notification Templates Screen Details

Notification System
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Render Test Templates

You can use the Detail tab of the Notification Templates screen to render a test notification for a new or

existing template.

· Render a test notification for a new template

· Render a test notification for an existing template

Render a Test Notification for a New Template

To render a test notification for a new template on the Detail tab of the Notification Templates screen:

1. Create a new template.

2. When you have entered information into the required Template ID, Template Type, Effective Date, and

Server ID fields for your new template, the <Test> button is enabled which allows you to render a test

template.

New Template Ready to Test

3. Once you have entered in all of the information for your new template, click <Test> to render a test

template.
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Test Notification

4. Ensure that the text, body, subject, etc. of the new notification have been set up correctly.

5. After you have ensured that everything is set up correctly, click <Save Changes> to activate and save

the new template. The new template will be activated on the system and added to the Summary tab.

Back to Top

Render a Test Notification for an Existing Template

To render a test notification for an existing template on the Detail tab of the Notification Templates screen:

1. Perform a search for the template on the Summary tab.

2. Select a template from the Templates Summary list view.

Template Selected in Templates Summary List View
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3. Double-click on the template to load the selected template on the Detail tab.

Existing Template Ready to Test

4. Change any of the information in the fields. Note: If you change the Template ID or Template Type

field, you will no longer be modifying the existing template but will create a new template.

5. Once you have made all of the modifications to the existing template, click <Test> to render a test

notification.
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Test Notification

6. Ensure that the text, body, subject, etc. of the notification have been set up correctly.

7. After you have ensured that everything is set up correctly, click <Save Changes> to save your

changes to the existing template.

Back to Top

See also:

Notification Templates Screen

Notification Templates Screen Details

Notification System
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Search for Templates

To search for templates using the Summary tab of the Notification Templates screen:

1. Check or uncheck the Show Only Active and Future Templates field, depending on whether or not you

want to search for inactive templates.

· Check the Show Only Active and Future Templates field to search only templates that are

active or set to become active.

· Uncheck the Show Only Active and Future Templates field to search all of the templates,

including inactive templates.

Search Parameter Fields on the Summary Tab

2. Enter values in the search parameter fields to narrow your search. For example, if you want to search

for all of your templates for email updated templates, you would type "Email Updated" in the

Description or Text field.

3. Click <Search> to search for all templates that match the data entered in the search parameters. In

our example, the system will search for all templates that have "Email Updated" in the description.

Performing a Search

4. After the system performs a search, the results are displayed in the Templates Summary list view. In

our example, the one template that is set up for updated emails is displayed in the results.

Search Results Displayed in Templates Summary List View
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5. To perform more searches, repeat the steps above. To perform other functions, see our other How To

Items.

Back to Top

See also:

Notification Templates Screen

Notification Templates Screen Details

Notification System
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Texting History Screen

Use the Texting History screen to retrieve archived text messages and view the details of those messages.

Archived text messages include any text message that has been created.

This screen also allows you to narrow your search of text messages using a variety of search parameters.

When an archived text message is selected, the details of the message are displayed in a pop-up dialog. You

can also save your data to a CSV file.

You can also access the performance metrics for the texting process. Metrics can be used for measurement,

comparison, or to track performance or production.

To find out how to send text messages on any screen in CIM GOLD, see the help for the Right-click Menu Pop
Up screen.

See each of the following tabs for a description of the fields and buttons that appear on that tab:

· Texting History Tab

· Texting Metrics Tab

How To Items
This screen allows you to:

· Perform a Texting History Search
· Retrieve Texting Metrics
· Save Texting History Data to CSV File
· Save Texting Metrics Data to CSV File
· View Text Message Details

Additional Information

For an example of this screen and definitions of each of the fields on this screen, see the Texting History

Screen Details section.

This screen is accessed by going to Notification > Texting History in the CIM GOLD tree view.
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Texting History Tab

Texting Metrics Tab

See also:
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Texting History Screen Details

Texting History Tab

Texting Metrics Tab

Notification System
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Texting History Screen Details

Use the tabs on the Texting History screen to retrieve archived text messages and view the details of those

messages. You can also access the performance metrics for the texting process. Metrics can be used for

measurement, comparison, or to track performance or production. The following tabs are on this screen:

· Texting History Tab: Use the Texting History screen to retrieve archived text messages and view the

details of those messages. Archived text messages include any text message that has been created.

This screen also allows you to narrow your search of text messages using a variety of search

parameters. When an archived text message is selected, the details of the message are displayed in

a pop-up dialog. You can also save your data to a CSV file.

· Texting Metrics Tab: Use this tab to access the performance metrics for the texting process. Metrics

can be used for measurement, comparison, or to track performance or production.

Texting History Tab

Back to Top

See also:
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Texting History Tab

Texting Metrics Tab

Texting History Screen

Notification System
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Texting History Tab

Use the Texting History tab to retrieve archived text messages and view the details of those messages.

Archived text messages include any text message that has been created. This tab also allows you to narrow

your search of text messages using a variety of search parameters. When an archived text message is

selected, the details of the message are displayed in a pop-up dialog. You can also save your data to a CSV

file.

Clicking on the ( ) button on the search parameters either clears the field or sets the field to the default.

Note: The When Added search parameter's default is from three months before yesterday's date to

yesterday's date.

The Texting History tab can be used with the default search parameters or you can click the Advanced radio

button to use the screen with the advanced search parameters. See the following examples of this tab followed

by field and button descriptions. 

Texting History Tab with Default Search Parameters
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Texting History Tab with Advanced Search Parameters

Field Descriptions

Field Description

Simple Select this radio button to display the more simplified search

parameters.

Advanced Select this radio button to display additional search parameters

beyond those used for the Simple search parameters. This is useful

when you want to be very specific in your search to really narrow

down the results.

Number of Records to Read Enter the number of records you want displayed in the Texting History

 list view. If you enter a "10" in this field, only 10 text messages will

be displayed in the Texting History list view. The maximum number

of text messages allowed by the program is 500.
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Field Description

Note: This search parameter is available only in Advanced mode.

Recipient Phone Number Enter the recipient's phone number for the text message(s) that you

are searching for in this field. Note: The number must be entered in

the following format: 1aaaeeedddd, where aaa is the area code, eee is

the prefix, and dddd is the suffix.

Sender Phone Number Select the sender's phone number for the text message(s) that you

are searching for from this drop-down list. The drop-down list is

automatically populated with the list of all numbers that have been

used to send a text message. Note: The drop-down list contains only

those numbers that have been used within the past year.

Note: This search parameter is available only in Advanced mode.

Message Body Enter text from the message body of the archived text message(s)

that you are searching for in this field. 

Entering upper- or lower-case letters does not affect the search

results. For example, entering "test" in this field brings up messages

that contain the words "test," "Test," "TEST," "testing," "Testing,"

"TESTING," etc. You can also enter partial words.

The text must be entered in the order in which it appears in the

message body. For example, if you enter "Just a reminder," text

messages with "Just a friendly reminder" will not appear in the results

because the word friendly does not match the text entered in the

search parameter.

This field also supports wild-card characters. You can input an

asterisk (*) to indicate that there are zero to more unknown characters

or you can input a question mark (?) to indicate that there is exactly

one unknown character. For example, if you enter "L*N," the search

retrieves all results that include any combination of "L" and "N" with

unknown characters in between, such as LOAN, LENDER, LEND,

LENDING, LEPRECHAUN, etc. However, if you enter "L?N," the

search retrieves only results that include a combination of "L" and "N"

with only a single unknown character in between, such as LENDER,

LEND, LENDING, etc.

When Added Use the Calendar icon to select the date range. The text message(s)

that were added to the queue within the Low and High date ranges

selected will appear in the Texting History list view. Note: The When

Added search parameter's default is from three months before

yesterday's date to yesterday's date.
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You can also change the date range by selecting parts of the date

and entering in numbers. For example, selecting the month and

entering a "1" changes the month to January. Selecting the day and

entering "15" changes the day the the 15th of the month. Selecting

the year and entering "2016" changes the year to 2016. The weekday

changes automatically according to the month, day, and year

selected.

When Sent Use the Calendar icon to select the date range. The text message(s)

that were sent within the Low and High date ranges selected will

appear in the Texting History list view. 

You can also change the date range by selecting parts of the date

and entering in numbers. For example, selecting the month and

entering a "1" changes the month to January. Selecting the day and

entering "15" changes the day the the 15th of the month. Selecting

the year and entering "2016" changes the year to 2016. The weekday

changes automatically according to the month, day, and year

selected.

Note: This search parameter is available only in Advanced mode.

Allow Empty Values on When

Sent

Check this field to allow the results to display text messages that

have an empty value for when they were sent. Text messages that are

sent as Replies always have an empty value for when they were sent.

So you must check this field to include Replies in the results.

Note: This search parameter is available only in Advanced mode.

Number of Attempts Enter a numeric range for the number of times the program attempted

to send a text message. You can also enter a value and then change

that value using the Up and Down Arrow keys on your keyboard. The

text message(s) that were sent within the Low and High numeric

range will appear in the Texting History list view. Note: The system

does not allow you to set a Low value that is higher than the High

value.

Note: This search parameter is available only in Advanced mode.

Success Select TRUE or FALSE from this drop-down field. Selecting TRUE

displays messages that were sent successfully. Selecting FALSE

displays messages that failed to send.

Back-Reference Type Enter the back-reference type (e.g., Loan, Lender, etc.) for the text

message(s) that you are searching for in this field. This is the Account
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Number type and is used to help determine the value of the branch

associated with the account. This is useful because lender numbers

and account numbers are formatted differently and format the branch

number differently.

This field also supports wild-card characters. You can input an

asterisk (*) to indicate that there are zero to more unknown characters

or you can input a question mark (?) to indicate that there is exactly

one unknown character. For example, if you enter "L*N," the search

retrieves all results that include any combination of "L" and "N" with

unknown characters in between, such as LOAN and LENDER.

However, if you enter "L?N," the search retrieves only results that

include a combination of "L" and "N" with only a single unknown

character in between, such as LENDER.

Back-Reference Value Enter the number for the back-reference value for the text message(s)

that you are searching for in this field. This is the value of the account

number in the system.

This field also supports wild-card characters. You can input an

asterisk (*) to indicate that there are zero to more unknown characters

or you can input a question mark (?) to indicate that there is exactly

one unknown character. For example, if you enter "L*N," the search

retrieves all results that include any combination of "L" and "N" with

unknown characters in between, such as LOAN, LENDER, LEND,

LENDING, LEPRECHAUN, etc. However, if you enter "L?N," the

search retrieves only results that include a combination of "L" and "N"

with only a single unknown character in between, such as LENDER,

LEND, LENDING, etc.

Back-Reference Source Enter the back-reference source (e.g., CIM, Afterhours, etc.) for the

text message(s) that you are searching for in this field. This is the

program or system that generated the message.

This field also supports wild-card characters. You can input an

asterisk (*) to indicate that there are zero to more unknown characters

or you can input a question mark (?) to indicate that there is exactly

one unknown character. For example, if you enter "L*N," the search

retrieves all results that include any combination of "L" and "N" with

unknown characters in between, such as LOAN, LENDER, LEND,

LENDING, LEPRECHAUN, etc. However, if you enter "L?N," the

search retrieves only results that include a combination of "L" and "N"

with only a single unknown character in between, such as LENDER,

LEND, LENDING, etc.
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Reason Suppressed Use the drop-down field to select the reason the archived text

message(s) that you are searching for was suppressed. You can

select one reason or a range of reasons. 

· To select one reason, select the same reason in both the Low

and High drop-down fields. 

· To select a range of reasons, select a reason from the Low

drop-down field and a different reason from the High drop-down

field. All of the reasons that are listed between those two

reasons are displayed. Note: To select a range of reasons, you

must put the reason with the lower number in the Low drop-

down field and the reason with the higher number in the High

drop-down field.

Is Reply Select TRUE or FALSE from this drop-down field. Selecting TRUE

displays messages that were sent as a reply. Selecting FALSE

displays messages that were not sent as a reply. Replies are when a

customer uses their phone to reply to a message that your institution

sends to them.

A message that is neither a response or a reply is a message that is

automatically generated by the system.

Is Foreign Select TRUE or FALSE from this drop-down field. Selecting TRUE

displays messages that were sent outside of the United States.

Selecting FALSE displays only messages that were sent within the

United States.

Note: This search parameter is available only in Advanced mode.

Is Response Select TRUE or FALSE from this drop-down field. Selecting TRUE

displays messages that were sent as a response. Selecting FALSE

displays messages that were not sent as a response. A response is

when your institution responds to a customer. For example, a

customer sends a reply back to your institution and then one of your

institution's employees sends a response back to that customer,

typically using the Client Text Notifications screen.

A message that is neither a response or a reply is a message that is

automatically generated by the system.

Texting History List View The Texting History list view displays all of the archived text

messages that match the entered search parameters. These

messages are sorted according to the date and time they were added

(When Added). Double-click on a text message in this list view to

open the Text Message Details dialog and view all of the details for

the selected text message. You can move the columns in this list
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view into any order that you want by clicking and holding on a column

heading while you move it left or right. Note: When data is saved to a

CSV file, the columns are sent in the original order and do not reflect

any changes that you have made to the column order on the screen.

The following columns display information in the Texting History list

view:

· Unique Key: Displays the unique identification number

assigned to the text message.

· Action Date: Displays the date the text message was sent,

replied to, responded to, tried to be sent, etc.

· Recipient Phone Number: Displays the phone number for the

recipient.

· Sender Phone Number: Displays the phone number of the

sender.

· Message: Displays the body of the text message.

· When Added: Displays the date and time when the text

message was added to the queue.

· When Sent: Displays the date and time when the text message

was sent.

· # Attempts: Displays the number of attempts made to send the

text message.

· Success: Displays whether or not the text message was

successfully sent (Y/N).

· BR Type: Displays the back-reference type.

· BR Value: Displays the back-reference value.

· BR Source: Displays the back-reference source.

· IsReply?: Displays whether or not the text message was a reply

(Y/N).

· IsResponse?: Displays whether or not the text message was a

response (Y/N).

· Reason Suppressed: Displays the reason the text message

was suppressed.

Back to Top

Button Descriptions

Button Description

<Retrieve> Click this button to retrieve all of the archived text messages that

meet the criteria entered in the search parameters. Note: You can

also press <Enter> or <Return> inside of any of the fields to perform a

search.
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<Previous> Click this button to view the previous page of results. This button is

useful if your selection criteria retrieves more texts than the maximum

number allowed on the screen. As you click <Previous>, a new page

of results is displayed. For example, if your search retrieves 450 texts

from the database, there would be five pages of results that you could

search through using the <Previous> and <Next> buttons.

Note: The maximum number of text messages retrieved can be set up

using the Number of Records to Read field on this screen after

selecting the Advanced radio button. The maximum number of text

messages allowed by the program is 500. 

<Next> Click this button to view the next page of results. This button is useful

if your selection criteria retrieves more texts than the maximum

number allowed on the screen. As you click <Next>, a new page of

results is displayed. For example, if your search retrieves 450 texts

from the database, there would be five pages of results that you could

search through using the <Previous> and <Next> buttons.

Note: The maximum number of text messages retrieved can be set up

using the Number of Records to Read field on this screen after

selecting the Advanced radio button. The maximum number of text

messages allowed by the program is 500. 

<Save Selection to CSV> Click this button to save the information selected in the Texting

History list view into a Comma-Separated Values (CSV) file.

Back to Top

See also:

Perform a Texting History Search

Save Texting History Data to CSV File

View Text Message Details

Texting History Screen Details

Texting History Screen

Notification System
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Texting Metrics Tab

Use the Texting Metrics tab to access the performance metrics for the texting process. Metrics can be used

for measurement, comparison, or to track performance or production.

Billing Periods
When billing information is generated on the Texting Server, it generates the data from the start of the 28th of

the previous month to the end of the 27th of the current month. This means that a billing period runs from the

28th of the prior month to the 28th of the current month. For example, if the billing date was February 1, 2017,

billing data would be generated for all text messages queued in the Texting Server between January 28, 2017

at 12:00:00.000 AM and January 27, 2017 at 11:59:59.999.

There are many reasons why billing runs from the 28th of the prior month to the 28th of the current month,

including:

· February is the shortest month of the year and consists of 28 days.

· Texts can be queued at any time of the day or night.

· Immediately after monthend, servers become heavily strained performing monthend calculations.

· The Host is frequently in offline mode during monthend processing, making it extremely difficult to

select a reliable time shortly after the end of the month when writing billing records to the Host would

be possible.

· All texts are accounted for and no texts get counted twice during billing periods.

· Makes it easy to account for the variable number of days between different months.

Custom Time Frames
Clicking the <Calculate from Custom Time Frame> button retrieves the total number of text messages queued

between the dates entered in the Low Date and the High Date fields. The custom time frame uses data from

the start of the Low Date of the previous month to the end of the High Date of the current month. This means

that the data is collected from the start of the Low Date to the end of the date just before the High Date. For

example, if the Low Date was January 1, 2017 and the High Date was March 31, 2017, data would be

generated for all text messages queued in the Texting Server between January 1, 2017 at 12:00:00.000 AM

and March 30, 2017 at 11:59:59.999.

See the following example of this tab followed by field and button descriptions. 
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Texting Metrics Tab

Field Descriptions

Field Description

Billing Information List View The Billing Information list view displays all of the billing data stored

on the Texting Server with a billing date between the dates entered in

the Low Date and the High Date fields.

The following columns display information in this list view:

· Billing Date: Displays the month the bill was generated for. If

the <Calculate from Custom Time Frame> button is used, only

dashes are displayed in this column since no actually billing

period is used.

· # Text Messages: Displays the total number of text messages

which were queued during the billing period. This includes

incoming texts from customers and outgoing texts from your

institution.

· Low Date Range: Displays the date the first text was queued

during the billing period.

· High Date Range: Displays the date the last text was queued

during the billing period.

Low Date Enter or select a beginning date to use to retrieve billing information.

High Date Enter or select an ending date to use to retrieve billing information.

Back to Top

Button Descriptions
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<Save Selection to CSV> Click this button to save the information selected in the Billing

Information list view into a Comma-Separated Values (CSV) file.

<Retrieve Billing Information> Click this button to retrieve any billing data stored on the Texting

Server with a billing date between the dates entered in the Low Date

and the High Date fields.

<Calculate from Custom Time

Frame>

Click this button to retrieve the total number of text messages queued

between the dates entered in the Low Date and the High Date fields.

This button always displays only one row of data in the Billing

Information list view because it doesn't calculate distinct billing

periods. This button is useful to retrieve the total number of text

messages for a non-standard billing period (e.g., for a quarter, six

months, a year, or multiple years).

Back to Top

See also:

Retrieve Texting Metrics

Save Texting Metrics Data to CSV File

Texting History Screen Details

Texting History Screen

Notification System
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Perform a Texting History Search

To perform a search using the Texting History tab on the Notification Texting History screen:

1. Use the Texting History fields to enter your search parameters. You can search by phone number,

message, date, etc. The more search parameters that you enter, the more specific your search

results will be. Clicking on the ( ) button on the search parameters either clears the field or sets the

field to the default. To see more search parameters, click the Advanced radio button. In our example,

we entered "Test" in the Message Body field and used the default dates in the When Added fields.

2. Click the <Retrieve> button. Note: You can also press <Enter> or <Return> inside of any of the fields

to perform a search.

Texting History Screen - <Retrieve> Button

3. The search results that match the parameters entered are displayed in the Texting History list view.

For our example, all of the messages that contained "Test" in the message body that were added

between July 13 and October 14 were displayed in the search results.
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Texting History Screen with Search Results

4. After receiving the results of your search, you can perform a new search, view the details of specific

text messages, save your search data to a CSV file, or exit the screen.

Back to Top

See also:

Save Data to CSV File

View Text Message Details

Texting History Screen Details

Texting History Screen

Notification System
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Retrieve Texting Metrics

Using the Texting Metrics tab on the Texting History screen, you can retrieve billing information and retrieve

texting metrics from a custom time frame.

Retrieve Billing Information

When billing information is generated on the Texting Server, it generates the data from the start of the 28th of

the previous month to the end of the 27th of the current month. This means that a billing period runs from the

28th of the prior month to the 28th of the current month. For example, if the billing date was February 1, 2017,

billing data would be generated for all text messages queued in the Texting Server between January 28, 2017

at 12:00:00.000 AM and January 27, 2017 at 11:59:59.999.

To retrieve billing information, complete the following steps:

1. Enter or select a beginning and ending date in the Low Date and High Date fields. The system will

retrieve any billing information that occurred between the two dates. For information on why billing runs

from the 28th of the prior month to the 28th of the current month, see the Texting Metrics tab.

Texting Metrics Tab

2. Click the <Retrieve Billing Information> button to retrieve any billing data stored on the Texting Server

with a billing date between the dates entered in the Low Date and the High Date fields.

3. The billing data is displayed in the Billing Information list view.
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Texting Metrics Tab with Billing Data

Back to Top

Calculate from Custom Time Frame

Clicking the <Calculate from Custom Time Frame> button retrieves the total number of text messages queued

between the dates entered in the Low Date and the High Date fields. The custom time frame uses data from

the start of the Low Date of the previous month to the end of the High Date of the current month. This means

that the data is collected from the start of the Low Date to the end of the date just before the High Date. For

example, if the Low Date was January 1, 2017 and the High Date was March 31, 2017, data would be

generated for all text messages queued in the Texting Server between January 1, 2017 at 12:00:00.000 AM

and March 30, 2017 at 11:59:59.999. 

The <Calculate from Custom Time Frame> button always displays only one row of data in the Billing

Information list view because it doesn't calculate distinct billing periods. This button is useful to retrieve the

total number of text messages for a non-standard billing period (e.g., for a quarter, six months, a year, or

multiple years).

To retrieve texting metrics from a custom time frame, complete the following steps:

1. Enter or select a beginning and ending date in the Low Date and High Date fields. The system will

retrieve the texting metrics that occurred between the two dates.
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Texting Metrics Tab

2. Click the <Calculate from Custom Time Frame> button to retrieve the texting metrics that occurred

between the dates entered in the Low Date and the High Date fields.

3. The texting metrics are displayed in the Billing Information list view.

Texting Metrics Tab with Custom Texting Metrics

Back to Top

See also:

Texting Metrics Tab

Save Texting Metrics Data to CSV File

Texting History Screen Details

Texting History Screen

Notification System
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Save Texting History Data To CSV File

A CSV file stores tabular data (numbers and text) in plain text. Each line of the file is a data record and each

record consists of one or more fields, separated by commas. To save the information displayed in the Texting

History list view into a Comma-Separated Values (CSV) file using the Texting History tab on the Notification

Texting History screen:

1. Perform a search.

2. Once you have the data that you want displayed in the Texting History list view, highlight or select

the data that you want to export. You can select as many lines of data as are displayed in the

Texting History list view. 

You can select multiple, sequential lines by clicking on the first item and then pressing and holding

down <Shift> as you click on the last item. You can also select multiple lines by pressing and holding

down <Ctrl> as you click on each of the lines that you want to select. You must continue to hold down

<Ctrl> the entire time you are selecting lines or you will lose your selections. Note: If no items are

selected, all items are exported.

3. After you have selected all of the data you want to save, click <Save Selection to CSV>.

<Save Selection to CSV> Button and Data Selected in Texting History List View
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4. Clicking the <Save Selection to CSV> button brings up the Save As dialog. Browse to the location

where you want to save the file, enter the name of the file in the File name: field, and make sure that

the type is a CSV file.

5. Click <Save>.

Save As Dialog

6. The CSV file is saved onto your computer or network. To open the file, either double-click on it or right-

click on it and select "Open" from the right-click menu.
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CSV File Saved on Computer or Network

7. The CSV file contains all of the text history line items you selected and displays them with column

headers.

CSV File from Texting History Screen

Back to Top
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See also:

Perform a Search

Texting History Screen Details

Texting History Screen

Notification System
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Save Texting Metrics Data To CSV File

A CSV file stores tabular data (numbers and text) in plain text. Each line of the file is a data record and each

record consists of one or more fields, separated by commas. To save the information displayed in the Billing

Information list view into a Comma-Separated Values (CSV) file using the Texting Metrics tab on the

Notification Texting History screen:

1. Retrieve texting metrics.

2. Once you have the data that you want displayed in the Billing Information list view, highlight or

select the data that you want to export. You can select as many lines of data as are displayed in the

Billing Information list view. 

You can select multiple, sequential lines by clicking on the first item and then pressing and holding

down <Shift> as you click on the last item. You can also select multiple lines by pressing and holding

down <Ctrl> as you click on each of the lines that you want to select. You must continue to hold down

<Ctrl> the entire time you are selecting lines or you will lose your selections. Note: If no items are

selected, all items are exported.

3. After you have selected all of the data you want to save, click <Save Selection to CSV>.

<Save Selection to CSV> Button and Data Selected in Billing Information List View

4. Clicking the <Save Selection to CSV> button brings up the Save As dialog. Browse to the location

where you want to save the file, enter the name of the file in the File name: field, and make sure that

the type is a CSV file.

5. Click <Save>.
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Save As Dialog

6. The CSV file is saved onto your computer or network. To open the file, either double-click on it or right-

click on it and select "Open" from the right-click menu.

CSV File Saved on Computer or Network
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7. The CSV file contains all of the texting metrics you selected and displays them with column headers.

CSV File from Texting Metrics Tab

Back to Top

See also:

Texting Metrics Tab

Retrieve Texting Metrics

Save Texting Metrics Data to CSV File

Texting History Screen Details

Texting History Screen

Notification System
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View Text Message Details

To view the details of a text message using the Texting History tab on the Notification Texting History screen:

1. Perform a search.

2. Find the message that you want to see the details of in the Texting History list view. 

Message Selected in Texting History List View

3. Double-click on the message to bring up the Text Message Details dialog.
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Text Message Details Dialog

4. The Text Message Details dialog displays all of the information for the text message. You can view the

phone numbers used, when the message was added and sent, the entire body of the message, etc.

Note: The Text Message Details dialog only allows you to view the details of the message. You

cannot change or update any of the fields.

5. Once you are done viewing the details of the message, you can view other messages using the

<Next> and <Previous> buttons, change the number in the Selected Index field, or use the Up and

Down Arrow keys on your keyboard within the Selected Index field on the Text Message Details

dialog to view the messages currently displayed in the Texting History list view. Or you can close the

Text Message Details dialog by clicking on the "X" in the upper, right-hand corner.

Back to Top

See also:

Perform a Search

Texting History Screen Details

Texting History Screen

Notification System



Notification System278

© 2021 GOLDPoint Systems.Last updated: 2/17/2021

Triggers Screen

Use the Triggers screen to build, manage, and test notification triggers. Triggers allow you to automatically

send notifications (texts, emails, and HTML emails) at scheduled times to a list of accounts. For example, you

can use this screen to send a text to all text-capable borrowers at 9:00 AM their time every time a payment is

five days late or you could set up a trigger to send an email to all borrowers every month.

Notification triggers make it so that you no longer have to worry about manually sending notifications,

everything is automatic.

This screen also allows you to test notification triggers. You can use the Test tab to see what accounts would

have received a notification based on how your trigger is set up if the trigger had been processed in the

afterhours the night before.

You can also use the History tab on this screen to view notification trigger history. This allows you to see what

trigger was used to send a notification to any client on any day in the past.

Note: The trigger process write a comment on the Customer Comments tab on the Loans > Marketing and

Collections screen in CIM GOLD for every account that is sent a notification at the time the notification is sent.

Special Note: An account can get only one triggered notification a day, so please ensure that you set your

triggers up with the correct priority order. If an account meets the logic for multiple triggers, it receives only the

notification from the trigger with the highest priority.

See each of the following tabs for a description of the fields and buttons that appear on that tab:

· Manage Tab

· Test Tab

· History Tab

How To Items
This screen allows you to:

· Create a New Trigger
· Delete a Trigger
· Export Triggers
· Modify a Trigger
· Perform a History Search
· Test Notification Triggers

Additional Information

For an example of this screen and definitions of each of the fields on this screen, see the Triggers Screen

Details section.

This screen is accessed by going to Notification > Triggers in the CIM GOLD tree view.
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Triggers Screen > Manage Tab

See also:

Triggers Screen Details

Manage Tab

Test Tab

History Tab

Notification System
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Triggers Screen Details

Use the tabs on the Triggers screen to build, manage, and test notification triggers. It also allows you to view

the history. The following tabs are on this screen:

· Manage Tab: Use the Triggers screen to build and manage notification triggers.

· Test Tab: Use this tab to test notification triggers.

· History Tab: Use this tab to view notification trigger history.

Triggers Screen > Manage Tab

Back to Top

See also:

Manage Tab

Test Tab

History Tab

Triggers Screen

Notification System
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Manage Tab

Use the Manage tab to build and manage notification triggers.

See the following examples of this tab followed by field and button descriptions. 

Manage Tab

Field Descriptions

Field Description

Manage Triggers List View The Manager Triggers list view displays all of the notification triggers

set up for your institution. Double-click on a trigger in this list view to

open the Trigger Definition Builder dialog and view all of the details for

the selected trigger.

Activate a Trigger

To activate a trigger, check the Active field in the Is Active column of

the Manage Triggers list view. To inactive a trigger, remove the

check from the Active field.

The following columns display information in the Manage Triggers

list view and can be used to sort:

· Active: Check this field to activate the trigger. Remove the

check from this field to make the trigger inactive.

· ID: Displays the identification (ID) number of the trigger.

· Name: Displays the name of the trigger.

· Description: Displays a description of the trigger.

· Template ID: Displays the identification (ID) number of the

template used by the trigger.
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Field Description

· Wrapper ID: Displays the identification (ID) number of the

wrapper used by the trigger.

· Template Type: Displays the type of template used by the

trigger.

· Errors: Displays the errors with the trigger (if applicable).

Back to Top

Button Descriptions

Button Description

<Refresh> Click this button to refresh the Manage Triggers list view.

<Copy> Select a trigger in the Manage Triggers list view and click this button

to copy that trigger's information to create a new trigger.

<Edit> Select a trigger in the Manage Triggers list view and click this button

to modify the selected trigger.

<Delete> Select a trigger in the Manage Triggers list view and click this button

to delete the selected trigger.

<New> Click this button to create a new trigger. 

<Save> Click this button to save any changes you've made to the Manage tab.

Note: This button must be clicked to save changes, even if you have

clicked the <Save> button on the Trigger Definition Builder dialog.

Back to Top

See also:

Manage Tab

Test Tab

History Tab

Triggers Screen Details

Triggers Screen

Notification System
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Test Tab

Use the Test tab to test notification triggers. You can use this tab to see what accounts would have received a

notification based on how your trigger is set up if the trigger had been processed in the afterhours the night

before.

See the following example of this tab followed by field and button descriptions. 

Test Tab

Field Descriptions

Field Description

Test Triggers List View The Test Triggers list view displays all of the triggers that were

tested. These are triggers that would have been processed in the

afterhours the night before based on how the triggers are set up.

The following columns display information in this list view and can be

used to sort:
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Field Description

· Failed: Check this field if the trigger failed.

· Trigger ID: Displays the identification (ID) number of the trigger.

· Insert Date: Displays the date the test was started.

· Transmission Date: Displays the date the transmission was

run.

· Trigger Run Time: Displays how long it took the trigger to run.

· Num of Accounts: Displays the number of accounts.

· Num of Notifications: Displays the number of notifications

sent.

· Error: Displays the error with the trigger (if applicable).

Test Account Details List View The Test Account Details list view displays all of the accounts for the

test triggers.

The following columns display information in this list view and can be

used to sort:

· Trigger ID: Displays the identification (ID) number of the trigger.

· Insert Date: Displays the date the test was started.

· Transmission Date: Displays the date the transmission was

run.

· Account: Displays the account number.

· Notifications Sent: Displays the notifications that would have

been sent.

· Errors: Displays the errors with the trigger (if applicable).

Back to Top

Button Descriptions

Button Description

<Test Triggers> Click this button to test the triggers that you currently have set up.

<Export Triggers> Click this button to export the selected triggers.

<Export All> Click this button to export all of the triggers.

Back to Top

See also:

Test Notification Triggers

Export Triggers

Triggers Screen Details

Triggers Screen

Notification System
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History Tab

Use the History tab to view notification trigger history. This allows you to see what trigger was used to send a

notification to any client on any day in the past.

See the following example of this tab followed by field and button descriptions. 

History Tab

Field Descriptions

Field Description

History Triggers List View The History Triggers list view displays notification trigger history.

This allows you to see what trigger was used to send notifications on

any day in the past. Select a date in the Date field and click <Get

History> to populate this list view.

The following columns display information in this list view and can be

used to sort:

· Failed: Check this field if the trigger failed.

· Trigger ID: Displays the identification (ID) number of the trigger.
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Field Description

· Insert Date: Displays the date the trigger was started.

· Transmission Date: Displays the date the transmission was

run.

· Trigger Run Time: Displays how long it took the trigger to run.

· Num of Accounts: Displays the number of accounts.

· Num of Notifications: Displays the number of notifications

sent.

· Error: Displays the error with the trigger (if applicable).

History Account Details List

View

The History Account Details list view displays all of the accounts for

the triggers run on the date in the Date field. This allows you to see

what accounts were sent a notification on any day in the past. Select

a date in the Date field and click <Get History> to populate this list

view.

The following columns display information in this list view and can be

used to sort:

· Trigger ID: Displays the identification (ID) number of the trigger.

· Insert Date: Displays the date the test was started.

· Transmission Date: Displays the date the transmission was

run.

· Account: Displays the account number.

· Notifications Sent: Displays the notifications that were sent.

· Errors: Displays the errors with the trigger (if applicable).

History Date Enter or select a date to use to retrieve trigger history information for.

Back to Top

Button Descriptions

Button Description

<Get History> Click this button to perform a history search for notification triggers.

<Export Triggers> Click this button to export the selected triggers.

<Export All> Click this button to export all of the triggers.

Back to Top

See also:

Perform a History Search

Export Triggers

Triggers Screen Details
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Triggers Screen

Notification System
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Create a New Trigger

Using the Manage tab on the Triggers screen, you can create a new trigger. There are two ways to create a

new trigger:

· Create a New Trigger

· Copy a Current Trigger to Create a New Trigger

Create a New Trigger

To create a new trigger using the <New> button, complete the following steps:

1. Click the <New> button on the Manage tab to bring up the Trigger Definition Builder dialog.

<New> Button on the Manage Tab

2. Enter information for the new trigger, including the Name, Description, Type, Template, etc, in the
Trigger Data and Notification Data field groups. Make sure to input information in the required fields.

The required fields are marked with an .
3. Next, select the Field Selection tab and select fields, account types, etc. for the new trigger. For

example, you could select the CFLN - Loan Master record and the CFPO - Loan Payoff. Then you
could select the LN1DUE - First Due Date field, etc. Note: The Field Selection tab contains required

fields that you must modify. The required fields are marked with an .
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Trigger Definition Builder Dialog: Field Selection Tab

4. Now, select the Logic tab and enter the logic that you would like to use for the new trigger. The
system will use the logic entered to determine who to send notifications to and when. For example,
you could use the logic to tell the system to send a notification to anyone who is over 30 days late
making a payment. The Logic tab also displays a preview of the notification that will be sent. Note:
The Logic tab is required. You must enter logic on this tab to create a new trigger.



Notification System290

© 2021 GOLDPoint Systems.Last updated: 2/17/2021

Trigger Definition Builder Dialog: Logic Tab

5. Next, select the Run Frequency tab and schedule when you want notifications sent for the new trigger.
For example, you could schedule the trigger to send notifications at the end of each month.

Trigger Definition Builder Dialog: Run Frequency Tab
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6. Then, select the SQL Preview tab to view the SQL (Structured Query Language) that you have set up
for the trigger. Make sure everything is set up correctly for the new trigger.

Trigger Definition Builder Dialog: SQL Preview Tab

7. Once you have entered in all of the data for the new trigger and have verified that it is set up correctly,
click <Save> to create the new trigger.
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<Save> Button on the Trigger Definition Builder Dialog

8. The new trigger is created and appears in the Manage Triggers list view. 
9. Click <Save> to save your changes and the new trigger.
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New Trigger Displayed in the Manage Triggers List View

Back to Top

Copy a Trigger to Create a New Trigger

To copy a current trigger to create a new trigger, complete the following steps:

1. Locate the trigger that you want to copy in the Manage Triggers list view.

2. Click on the trigger to highlight it.

3. Click <Copy> to bring up the Trigger Definition Builder dialog.
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Trigger Selected and <Copy> Button on the Manage Tab

4. The Trigger Definition Builder dialog is automatically populated with Information from the selected
trigger.
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Trigger Definition Builder Dialog with Copied Trigger's Information

5. Enter information for the new trigger, including the Name and Description in the Trigger Data field
group. You can also make changes to any of the fields automatically populated by the copied trigger.

Make sure to input information in the required fields. The required fields are marked with an .
6. Next, select the Field Selection tab and see if you wanted to change any of the fields used for the

trigger. If you want to make changes, select fields, account types, etc. for the new trigger. For
example, you could select the CFLN - Loan Master record and the CFPO - Loan Payoff. Then you
could select the LN1DUE - First Due Date field, etc.
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Trigger Definition Builder Dialog: Field Selection Tab

7. Now, select the Logic tab and enter the logic that you would like to use for the new trigger. The
system will use the logic entered to determine who to send notifications to and when. For example,
you could use the logic to tell the system to send a notification to anyone who is over 30 days late
making a payment. The Logic tab also displays a preview of the notification that will be sent. Note:
The Logic tab is required. You must enter logic on this tab to create a new trigger.
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Trigger Definition Builder Dialog: Logic Tab

8. Next, select the Run Frequency tab and see if you want to change when you want notifications sent
for the new trigger. For example, the copied trigger may have been set up to send notifications at the
end of each month but you may want the new trigger to send notifications every quarter.

Trigger Definition Builder Dialog: Run Frequency Tab
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9. Then, select the SQL Preview tab to view the SQL (Structured Query Language) that you have set up
for the trigger. Make sure everything is set up correctly for the new trigger.

10. Once you have entered in all of the data for the new trigger and have verified that it is set up correctly,
click <Save> to create the new trigger.

Trigger Definition Builder Dialog: SQL Preview Tab

11. The new trigger is created and appears in the Manage Triggers list view. 
12. Click <Save> to save your changes and the new trigger.
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New Trigger Displayed in the Manage Triggers List View

Back to Top

See also:

Modify a Trigger

Delete a Trigger

Test Notification Triggers

Manage Tab

Triggers Screen Details

Triggers Screen

Notification System
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Delete a Trigger

To delete a trigger using the Manage tab on the Notification Triggers screen:

1. Locate the trigger that you want to delete in the Manage Triggers list view.

2. Click on the trigger to highlight it.

Trigger to be Deleted Selected in the Manage Triggers List View

3. Click <Delete> to permanently delete the trigger. Note: You can make the trigger inactive instead of

deleting it if you want to keep the trigger set up but not use it.

4. The trigger is deleted and no longer displayed in the Manage Triggers list view.
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Trigger Removed from the Manage Triggers List View

Back to Top

See also:

Activate a Trigger

Manage Tab

Triggers Screen Details

Triggers Screen

Notification System
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Export Triggers

You can use both the Test tab and the History tab to export trigger data. These tabs allow you to save the data

from their test or history search to a file on your computer or network. The <Export Triggers> and <Export All>

buttons work the same on both tabs. There are two ways to export data from the Test and History tabs:

· Export Selected Triggers

· Export All Triggers

Export Selected Triggers

To export data for selected triggers on the Test or History tab, complete the following steps:

1. Perform a history search on the History tab or test the notification triggers on the Test tab.

2. Select the Triggers that you want to export the data for in the Triggers list view. In our example, we

selected Trigger 15.

3. Click the <Export Triggers> button to bring up the Save As dialog.

<Export Triggers> Button on the History Tab

4. Navigate to the folder that you want to save the file to.
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Save As Dialog

5. Enter a name for the file in the File name: field.

6. Click <Save> to save the file.

<Save> Button on the Save As Dialog
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7. The file is saved in the selected folder.

Back to Top

Export All Triggers

To export data for all of the triggers on the Test or History tab, complete the following steps:

1. Perform a history search on the History tab or test the notification triggers on the Test tab.

2. Click the <Export All> button to bring up the Save As dialog.

<Export All> Button on the History Tab

3. Navigate to the folder that you want to save the file to.
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Save As Dialog

4. Enter a name for the file in the File name: field.

5. Click <Save> to save the file.

<Save> Button on the Save As Dialog
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6. The file is saved in the selected folder.

Back to Top

See also:

Perform a History Search

Test Notification Triggers

History Tab

Test Tab

Triggers Screen Details

Triggers Screen

Notification System



Notification System 307

© 2021 GOLDPoint Systems. Last updated: 2/17/2021

Modify a Trigger

To modify (edit) a trigger using the Manage tab on the Notification Triggers screen:

1. Locate the trigger that you want to modify in the Manage Triggers list view.

2. Click on the trigger to highlight it.

Trigger Selected in the Manage Triggers List View

3. Click <Edit> to open the Trigger Definition Builder dialog with data for the selected trigger loaded.
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Selected Trigger Loaded on the Trigger Definition Builder Dialog

4. Modify any of the fields on the Trigger Definition Builder dialog for the trigger. 

5. You can add or remove fields on the Field Selection tab. You can add, remove, or edit the logic on the

Logic tab. You can change when the trigger is scheduled to run on the Run Frequency tab. And you

can preview any of the changes you have made on the SQL Preview tab and in the Preview Notification

section of the Logic tab. For our example, we are going to add another Loan Master field, CSOT - Loan

Origination Tracking, to our trigger by simply checking the field on the Field Selection tab.

6. After you have made all of your modifications, click <Save> to save your changes to the selected

trigger and return to the Manage tab of the Triggers screen. Note: You must also click <Save> on the

Manage tab of the Triggers screen to save the changes that you have made.
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Changes Made to Trigger

Back to Top

See also:

Create a New Trigger

Test Notification Triggers

Manage Tab

Triggers Screen Details

Triggers Screen

Notification System
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Perform a History Search

You can use the History tab to view notification trigger history. This allows you to see what trigger was used to

send a notification to any client on any day in the past. To perform a history search using the History tab on

the Notification Triggers screen:

1. Enter or use the Calendar icon to select the date that you want history results for in the History Date

field.

2. Click the <Get History> button to perform a search of the history for the date entered.

<Get History> Button on the History Tab

3. The results of the search are displayed on the History tab. You can see the triggers that ran for the

selected date in the History Triggers list view.

4. And you can see the accounts that were sent a notification for the various triggers in the History

Account Details list view. Note: If you want to save the results from your search, you can export the

data from the search.
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Results of History Search Displayed on History Tab

Back to Top

See also:

Export Triggers

History Tab

Triggers Screen Details

Triggers Screen

Notification System
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Test Notification Triggers

You can use the Test tab to see what accounts would have received a notification based on how your triggers

are set up if the triggers had been processed in the afterhours the night before. To test all of the triggers

currently set up for your institution using the Test tab on the Notification Triggers screen:

1. Navigate to the Test Tab.

2. Click <Test Triggers> to run the test.

<Test Triggers> Button on the Test Tab

3. The results of the test are displayed on the Test tab. You can see the triggers that ran in the Test

Triggers list view.

4. And you can see the accounts that would have been sent a notification based on the various triggers

in the Test Account Details list view. Note: If you want to save the results from the test, you can

export the data from the test.
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Tested Triggers Displayed on Test Tab

Back to Top

See also:

Export Triggers

Test Tab

Triggers Screen Details

Triggers Screen

Notification System
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Wrappers Screen

Use the Notification Wrappers screen to create, modify, or delete notification wrappers. You can also use this
screen to view the notification wrappers set up for your institution, search for a specific wrapper, activate
inactive notification wrappers, and to render a test wrapper to ensure that the header, footer, etc. of a wrapper
have been set up correctly. 

Wrappers are the institution branding that is applied to the notifications. Wrappers display your institution's
logos, advertising, and selected wording in the header and footer of the notification.

How To Items
This screen allows you to:

· Access a wrapper on the Detail tab
· Activate an inactive wrapper
· Create a new wrapper
· Copy a wrapper to create a new wrapper
· Delete notification wrappers
· Modify or view an existing wrapper
· Render a test wrapper
· Search for a wrapper
· Upload a wrapper
· Use parameters in a wrapper

Additional Information

For an example of this screen and definitions of each of the fields on this screen, see the Notification

Wrappers Screen Details section. 

This screen is accessed by going to Notification > Wrappers in the CIM GOLD tree view.

Notification Wrappers Screen, Summary Tab
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Notification Wrappers Screen, Detail Tab

See also:

Detail Tab

Summary Tab

Notification Wrappers Screen Details

Notification System
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Notification Wrappers Screen Details

Use the Notification Wrappers screen to create, modify, or delete notification wrappers. You can also use this
screen to view the notification wrappers set up for your institution, search for a specific wrapper, activate
inactive notification wrappers, and to render a test wrapper to ensure that the header, footer, etc. of a wrapper
have been set up correctly. Wrappers are the institution branding that is applied to the notifications. Wrappers
display your institution's logos, advertising, and selected wording in the header and footer of the notification.

To learn more about the fields and buttons available on the Notification Wrappers screen, see the following
tabs:

· Use the Summary tab of the Notification Wrappers screen to view the notification wrappers set up for
your institution. You can also use this screen to delete notification wrappers, activate inactive
notification wrappers, and to access wrappers on the Detail tab.

· Use the Detail tab on the Notification Wrappers screen to create, modify, or delete notification
wrappers. You can also use this screen to render a test wrapper to ensure that the header, footer, etc.
of a wrapper have been set up correctly.

Notification Wrappers Screen, Summary Tab
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Notification Wrappers Screen, Detail Tab

Back to Top

See also:

Notification Wrappers Screen

Detail Tab

Summary Tab

Notification System
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Summary Tab

Use the Summary tab of the Notification Wrappers screen to view the notification wrappers set up for your
institution. You can also use this screen to delete notification wrappers, activate inactive notification wrappers,
and to access wrappers on the Detail tab. 

Wrappers are the institution branding that is applied to the notifications. Wrappers display your institution's
logos, advertising, and selected wording in the header and footer of the notification.

See the following example of this screen followed by field and button descriptions.

Notification Wrappers Summary Tab

Field Descriptions

Field Description

ID Enter the identification number of the wrapper template to display that

template in the Wrappers Summary list view. Entering a partial

identification number displays all templates that have those same

numbers.

Type Select the format type (HTML or text) of the wrapper template to

display all wrapper templates that match the selected format type in

the Wrappers Summary list view.

Description Enter a partial or full description of the wrapper template to display all

wrapper templates that contain that description in the Wrappers

Summary list view.

Show Only Active and Future

Wrapper Templates

Check this field to display only currently active wrapper templates and

the wrapper templates that will activate in the future in the Wrappers

Summary list view. If this field is left blank, all templates are displayed

whether they are active or inactive.
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Field Description

Wrappers Summary list view The Wrapper Summary list view displays the wrapper templates set

up for your institution. If you check the Show Only Active and Future

Wrapper Templates field, only the currently active templates and the

templates that will activate in the future are displayed. If the Show 

Only Active and Future Wrapper Templates field is left blank, all

templates are displayed.

The following columns display information in the Wrapper Summary

list view and can be used to sort:

· Active: Displays whether or not the wrapper template is active.

This column contains a check if the wrapper is active.

· ID: Displays the identification number of the wrapper template.

· Type: Displays the format type of the wrapper (HTML or text).

· Effective Date: Displays the date when the wrapper template

became effective or will become effective (start being sent).

· Description: Displays a description of the wrapper.

· Changed By: Displays the name of the user who last modified

the wrapper template.

· Date/Time Modified: Displays the date (in MMDDYYYY

format) and time (in HHMMSS format in a 24-hour clock format)

when the user in the Changed By column modified the wrapper

template.

Back to Top

Button Descriptions

Button Description

<Test> Click this button to render a test wrapper to ensure that the header,

footer, parameters, etc. of a wrapper have been set up correctly.

<Copy> Click this button to copy the format of the current wrapper template to

create a new wrapper.

<Delete> Click this button to delete the wrapper template currently selected in

the Wrappers Summary list view.

<Create New> Click this button to load a blank template on the Detail tab.

<Save Changes> Click this button to save any change made to the Notification

Wrappers screen.

Back to Top
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See also:

Notification Wrappers Screen

Notification Wrappers Screen Details

Notification System
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Detail Tab

Use the Detail tab on the Notification Wrappers screen to create, modify, or delete notification wrappers. You
can also use this screen to render a test wrapper to ensure that the header, footer, etc. of a wrapper have been
set up correctly.

Wrappers are the institution branding that is applied to the notifications. Wrappers display your institution's
logos, advertising, and selected wording in the header and footer of the notification.

See the following example of this screen followed by field and button descriptions.

Notification Wrappers Detail Tab

Field Descriptions

Field Description

Wrapper ID Enter the identification number for the wrapper template in this field. If

you selected a template on the Summary tab, this field displays the

identification number for the selected notification wrapper template.

You can load a specific wrapper template onto this screen by

searching for that template on the Summary tab and double-clicking

on the template in the Wrappers Summary list view.
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Field Description

Wrapper Type Select the format type of the notification that the wrapper will be

attached to (HTML Email or Text Email) from this drop-down list.

Effective Date Enter the date when the notification wrapper should become effective

(start being used). Enter the date using MM/DD/YYYY format, or use

the drop-down calendar to select the date.

Description Enter a description of the wrapper in this field. Try to be descriptive so

that others can easily tell the purpose for this wrapper when it is listed

in the Wrappers Summary list view on the Summary tab.

Send As Enter the email address (e.g., Team@GOLDPointsystems.com) to be

used to send notifications in this field. This is the email address that

users will see as the sender of the notification in their Inbox.

Reply To Enter the email address (e.g., Replies@GOLDPointsystems.com)

that emails will be sent to when a user replies to the notification in

this field.

Group ID Enter the identification number of the group used for wrappers in this

field.

Is Active Check this field to activate the wrapper. If this field is not checked, the

wrapper will not be active and will not appear in the Wrappers

Summary list view on the Summary tab if the Show Only Active and

Future Wrapper Templates field is checked.

Originator list view The Originators list view displays the originating systems that can be

used for the notification wrapper template. Check the Use box next to

the originating system that you want to use for the template. 

This can enable you to tie specific templates to loan origination, loan

servicing, etc. For example, your institution can use a different

template with a different wrapper for origination and loan servicing. The

template for origination might include a wrapper with advertising while

the template for loan servicing does not. And the system can

automatically use the correct template with the correct wrapper

depending on the system that is sending the notification.

The following columns display information in the Originators list view:

· Use: Use this checkbox to select the originating system for the

notification.

· Originator: Displays the originating systems that can be tied to

the notifications.

Change History list view The Change History list view displays who has modified the wrapper

template and when they modified it. 
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Field Description

The following columns display information in the Change History list

view and can be used to sort:

· Changed By: Displays the name of the user who last modified

the wrapper.

· Date Changed: Displays the date (in MMDDYYYY format)

when the user in the Changed By column modified the wrapper.

· Time Changed: Displays the time (in HHMMSS format in a 24-

hour clock format) when the user in the Changed By column

modified the wrapper.

Parameter list view The Parameter list view displays the parameters set up for the

wrapper. The program substitutes a specified parameter whenever

<parm:#PARAMETER> is entered in the code where PARAMETER is

the parameter name. Using the Parameter list view you can add new

parameters and determine their value. The <Add Parameter> and

<Delete Parameter> buttons are used to modify this list view.

The following columns display information in the Parameter list view:

· Parameter: Displays the name of the parameter. This is the

name used when entering a parameter into the code for the

wrapper.

· Value: Displays the value assigned to the parameter.

Header Enter the code and text to be used in the header of the wrapper in this

field. In this field you can specify the font, style, image inclusion,

wording, etc. of the wrapper heading.

The following special characters entered in the text of the wrapper

could interfere with how the wrapper is displayed in an HTML browser:

(&), (<), (>), ('), and ("). The program will substitute the specified

parameter whenever <parm:#PARAMETER> is entered in the code

where PARAMETER is the parameter name.

Footer Enter the code and text to be used in the footer of the wrapper in this

field. In this field you can specify the font, style, image inclusion,

wording, etc. of the wrapper footer.

The following special characters entered in the text of the wrapper

could interfere with how the wrapper is displayed in an HTML browser:

(&), (<), (>), ('), and ("). The program will substitute the specified

parameter whenever <parm:#PARAMETER> is entered in the code

where PARAMETER is the parameter name. 

Back to Top
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Button Descriptions

Button Description

<Previous> Click this button to load the previous wrapper. The previous wrapper is

the wrapper whose identification number comes right before the

currently displayed wrapper's identification number.

<Next> Click this button to load the next wrapper. The next wrapper is the

wrapper whose identification number comes right after the currently

displayed wrapper's identification number.

<Add Parameter> Click this button to add a new parameter to the Parameter list view.

<Delete Parameter> Select a parameter in the Parameter list view and click this button to

delete the parameter.

<Test> Click this button to render a test wrapper to ensure that the header,

footer, parameters, etc. of a wrapper have been set up correctly.

<Copy> Click this button to copy the format of the current wrapper template to

create a new wrapper.

<Delete> Click this button to delete the wrapper currently displayed on the

Detail tab.

<Create New> Click this button to load a blank wrapper template on the Detail tab.

<Save Changes> Click this button to save any change made to the Notification

Wrappers screen.

Back to Top

See also:

Notification Wrappers Screen

Notification Wrappers Screen Details

Notification System
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Access Wrapper on Detail Tab

To access a wrapper template on the Detail tab using the Summary tab:

1. Perform a search for the wrapper template on the Summary tab. 

2. Select a template from the Wrappers Summary list view.

Template Selected in Wrappers Summary List View

3. Double-click on the wrapper template to load the selected template on the Detail tab.

Selected Wrapper Template Loaded on the Wrappers Detail Tab
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4. Once the wrapper template is loaded onto the Detail tab, you can modify the wrapper, render a test

wrapper, and ensure that the header, footer, parameters, etc. of the wrapper have been set up

correctly.

Back to Top

See also:

Detail Tab

Summary Tab

Notification Wrappers Screen Details

Notification Wrappers Screen

Notification System
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Activate Inactive Wrapper

Inactive wrapper templates are older templates that are no longer being used. To activate an inactive template

on the Notification Wrappers screen:

1. Uncheck the Show Only Active and Future Wrapper Templates field on the Summary tab to display all

of the wrapper templates that are active, set to become active, and inactive.

2. Perform a search for the template that you want to activate. 

3. Select the inactive template from the Wrappers Summary list view.

Inactive Wrapper Template Selected in Wrappers Summary List View

4. Double-click on the template to load the selected template on the Wrapper Detail tab.

Inactive Wrapper Template Loaded on the Detail Tab
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5. Check the Is Active field to activate the template.

Check the Is Active Field

6. Make any other needed modifications to the wrapper template and click <Save Changes> to save the

now-active wrapper template. Note: You can also render a test wrapper to ensure that the header,

footer, parameters, etc. of the wrapper have been set up correctly before you save the changes by

clicking the <Test> button.

Back to Top

See also:

Detail Tab

Summary Tab

Notification Wrappers Screen Details

Notification Wrappers Screen

Notification System
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Create New Wrapper

To create a new wrapper template on the Notification Wrappers screen:

1. Click the <Create New> button in the lower, right-hand corner of the Summary tab or Detail tab.

<Create New> Button on the Summary Tab

2. Clicking the <Create New> button loads a blank template onto the Detail tab.

Blank Wrapper Template

3. Enter the information for the new wrapper template into the fields on the Detail tab. The Wrapper ID,

Wrapper Type, and Effective Date fields are required fields and must have information entered into

them in order to save the template or render a test wrapper.

4. When you have entered information into the required Wrapper ID, Wrapper Type, and Effective

Date fields, the <Test> button is enabled which allows you to render a test wrapper. After you have

entered information into the required fields and other fields (e.g., the Description field), the <Save

Changes> button is enabled allowing you to save the new wrapper template.
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New Wrapper Template

5. Once you have entered in all of the information for your new template, render a test wrapper to ensure

that the header, footer, etc. of the wrapper have been set up correctly.

6. After you have ensured that everything is set up correctly, click <Save Changes> to activate and save

the new wrapper template. The new template will be activated on the system and added to the

Summary tab.

New Template Added to Wrappers Summary List View on the Summary Tab

Back to Top

See also:

Detail Tab

Summary Tab
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Notification Wrappers Screen Details

Notification Wrappers Screen

Notification System
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Copy Wrapper

To create a new wrapper template by copying an existing template on the Notification Wrappers screen:

1. Click the <Copy> button on the Summary tab or Detail tab to bring up the Copy Wrapper dialog.

The <Copy> Button on the Detail Tab

2. Double-click on the wrapper that you want to copy to load the selected wrapper on the Detail tab.

Select Wrapper in Copy Wrapper Dialog
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Copied Wrapper Template on the Detail Tab

3. You will be required to enter a new identification number in the Wrapper ID field.

New Wrapper ID

4. You can now make changes to the wrapper template by changing any of the information in the file

maintainable fields.

5. Once the template is set up the way that you want it to be, render a test wrapper to ensure that the

header, footer, type, etc. of the wrapper have been set up correctly. Note: You must save the new

wrapper before you can add or delete parameters.

6. After you have ensured that everything is set up correctly, click <Save Changes> to save your

changes and create the new wrapper template.
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New Wrapper Template Ready to be Saved

7. The new template is now set up and appears in the Wrappers Summary list view on the Summary tab.

New Wrapper Template in Wrappers Summary List View

Back to Top

See also:

Detail Tab

Summary Tab

Notification Wrappers Screen Details

Notification Wrappers Screen

Notification System
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Delete Wrappers

You can use both tabs of the Notification Wrappers screen to easily delete wrapper templates that are no

longer useful.

· Delete a wrapper using the Summary tab

· Delete a wrapper using the Detail tab

Delete a Wrapper Using the Summary tab

To delete a template using the Summary tab on the Notification Wrappers screen:

1. Perform a search for the wrapper template on the Summary tab.

2. Select a template from the Wrappers Summary list view.

Template Selected in Wrappers Summary List View

3. Once a wrapper template is selected, the <Delete> button becomes active.

<Delete> Button on the Summary Tab

4. Click <Delete> to bring up the Delete Wrapper Template Question dialog.
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Delete Wrapper Template Question Dialog

5. Click <Yes> to delete the selected template and remove it from the Wrappers Summary list view.

Warning: Once a wrapper template is deleted, it cannot be recovered. The template is completely

removed from the server.

Template Removed from Wrappers Summary List View

Back to Top

Delete a Wrapper Using the Detail tab

To delete a wrapper template using the Detail tab on the Notification Wrappers screen:

1. Load an existing wrapper template onto the Detail tab of the Wrappers screen. 
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Wrapper Template to be Deleted

2. Click <Delete> to delete the wrapper template displayed on the screen. Warning: Once a template is

deleted, it cannot be recovered. The template is completely removed from the server.

3. This brings up the Delete Wrapper Template Question dialog to ensure that you purposefully want to

delete the wrapper.

Delete Wrapper Template Question Dialog

4. Click <Yes> to proceed to delete the wrapper template. The information for the wrapper template is

removed from the Detail tab and the wrapper template no longer appears in the Wrappers Summary

list view on the Summary tab.
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Wrapper Deleted from Wrappers Summary List View

Back to Top

See also:

Detail Tab

Summary Tab

Notification Wrappers Screen Details

Notification Wrappers Screen

Notification System
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Modify or View Existing Wrappers

To modify or view an existing wrapper template using the Notification Wrappers screen:

1. Load an existing wrapper template onto the Detail tab of the Wrappers screen.

Selected Wrapper Template Loaded on Detail Tab

2. Once the wrapper template is loaded onto the Detail tab, you can view the wrapper template and see

everything that is set up for it. You can also modify the existing template.

3. To modify the template, change any of the information in the fields. In our example, we changed the

information in the Send As field. Note: If you change the Wrapper ID or Wrapper Type field, you will no

longer be modifying the existing template but will create a new template.

4. Once you have made all of the modifications to the existing template, render a test wrapper to ensure

that the header, footer, parameters, etc. of the wrapper have been set up correctly.

5. After you have ensured that everything is set up correctly, click <Save Changes> to save your

changes to the existing wrapper template.
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Modified Wrapper Template on Detail Tab

Back to Top

See also:

Detail Tab

Summary Tab

Notification Wrappers Screen Details

Notification Wrappers Screen

Notification System
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Render Test Wrappers

You can use the Notification Wrappers screen to render a test wrapper for a new or existing template.

· Render a test wrapper for a new template

· Render a test wrapper for an existing template

Render a Test Wrapper for a New Template

To render a test wrapper for a new template on the Notification Wrappers screen:

1. Create a new wrapper.

2. When you have entered information into the required Wrapper ID, Wrapper Type, and Effective Date

fields for your new wrapper template, the <Test> button is enabled which allows you to render a test

wrapper.

New Wrapper Template Ready to Test

3. Enter all of the information for your new wrapper template into the available fields.

4. Click <Test> to render a test wrapper.
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Test Wrapper

5. Ensure that the header, footer, etc. of the new wrapper have been set up correctly.

6. Click <OK> to return to the Wrappers screen.

7. After you have ensured that everything is set up correctly, click <Save Changes> to activate and save

the new wrapper template. The new wrapper will be activated on the system and added to the

Summary tab.

Back to Top

Render a Test Wrapper for an Existing Template

To render a test wrapper for an existing template on the Notification Wrappers screen:

1. Perform a search for the wrapper template on the Summary tab of the Wrappers screen.

2. Select a template from the Wrappers Summary list view.
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Wrappers Template Selected in Wrapper Summary List View

3. Click <Test> on the Summary tab or double-click on the template to load the selected template on the

Detail tab. If you click <Test> on the Summary tab, skip to step 5.

Existing Wrapper Template Ready to Test

4. At this point you can change any of the information in the fields or you can leave the wrapper template

as it is. Note: If you change the Wrapper ID or Wrapper Type field, you will no longer be modifying the

existing wrapper template but will create a new template.

5. Once the existing template is ready to be tested, click <Test> to render a test wrapper.
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Test Wrapper

6. Ensure that the header, footer, etc. of the wrapper have been set up correctly.

7. Click <OK> to return to the Detail tab.

8. After you have ensured that everything is set up correctly, click <Save Changes> to save your

changes to the existing template.

Back to Top

See also:

Detail Tab

Summary Tab

Notification Wrappers Screen Details

Notification Wrappers Screen

Notification System
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Search for Wrapper

To search for wrapper templates using the Notification Wrappers screen:

1. Check or uncheck the Show Only Active and Future Wrapper Templates field on the Summary tab,

depending on whether or not you want to search for inactive templates.

· Check the Show Only Active and Future Wrapper Templates field to search only templates

that are active or set to become active.

· Uncheck the Show Only Active and Future Wrapper Templates field to search all of the

templates, including inactive templates.

Search Parameter Fields

2. Enter values in the search parameter fields to narrow your search. For example, if you want to search

for all of your test templates, you would type "Test" in the Description field.

"Consumer" Entered in the Search Parameter Fields

3. Click <Search> to search for all templates that match the data entered in the search parameters. In

our example, the system will search for all templates that have "Test" in the description.

Performing a Search

4. After the system performs a search, the results are displayed in the Wrappers Summary list view. In

our example, the three test wrapper templates that are set up are displayed in the results.
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Search Results Displayed in Wrappers Summary List View

5. To perform more searches, repeaeat the steps above. To perform other functions, see our other How

To Items.

Back to Top

See also:

Detail Tab

Summary Tab

Notification Wrappers Screen Details

Notification Wrappers Screen

Notification System
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Upload a Wrapper

You can use the Notification Wrappers screen to upload a wrapper onto the Detail tab of the Wrappers screen.

· Upload a wrapper using the Detail tab

· Upload a wrapper using the Summary tab

Upload a Wrapper Using the Detail Tab

To upload a wrapper using the Detail tab of the Notification Wrappers screen:

1. Click on the <Previous> or <Next> button on the Detail tab to bring up the wrapper template that you

want to load. Note: If there isn't a wrapper loaded on the the Detail Tab already, the system brings up

the first wrapper when you first click the <Previous> or <Next> button.

Detail Tab - Click <Previous> & <Next> Buttons

2. Click on the <Previous> or <Next> button until the wrapper that you want is loaded onto the Detail tab.
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Wrapper Template Loaded onto Detail Tab

3. Once the template is loaded onto the Detail tab, you can modify the template, render a test wrapper,

and ensure that the header, footer, parameters, etc. of the wrapper have been set up correctly. If you

make any changes to the wrapper template, remember to click <Save Changes> to save the changes

you make.

Back to Top

Upload a Wrapper Using the Summary Tab

To upload a wrapper template on the Detail tab using the Notification Wrappers screen:

1. Perform a search for the wrapper template on the Summary tab. 

2. Select a template from the Wrappers Summary list view.
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Template Selected in Wrappers Summary List View

3. Double-click on the template to load the selected template on the Detail tab.

Selected Template Loaded on the Detail Tab

4. Once the template is loaded onto the Detail tab, you can modify the template, render a test wrapper,

and ensure that the header, footer, parameters, etc. of the wrapper have been set up correctly. If you

make any changes to the wrapper template, remember to click <Save Changes> to save the changes

you make.

Back to Top

See also:

Detail Tab
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Summary Tab

Notification Wrappers Screen Details

Notification Wrappers Screen

Notification System



Notification System 351

© 2021 GOLDPoint Systems. Last updated: 2/17/2021

Use Parameters

You can use the Notification Wrappers screen to modify and use parameters on the Detail tab of the Wrappers

screen.

· Add a parameter

· Delete a parameter

Using the Parameter list view you can add new parameters and determine their value on the Detail tab of the

Notification Wrappers screen. The <Add Parameter> and <Delete Parameter> buttons are used to modify the

Parameter list view. Parameters can be used in wrappers and in the body of emails. The default parameters

are displayed in the Parameter list view. The program substitutes a specified parameter whenever

<parm:#PARAMETER> is entered in the code where PARAMETER is the parameter name.

Parameters are generally your institution's most commonly used fields. These fields may need to be changed

at random times. Once a parameter is changed, the changes take affect in all wrappers and emails where the

parameter is used the next day. This enables your institution to make changes across the Notification System

quickly and seamlessly.

All default parameters must start with a hash tag (#). This differentiates the parameters from regular HTML

parameters. If the parameter has multiple words, these words must be divided by an underscore (_). For

example, to insert the marketing URL for your institution into the header your wrapper, you would type the

following into the Header field: 

· <a href="[parm:#MARKETING_URL]" style="color: #3E898F;">[parm:#MARKETING_URL_TEXT]</a>

Note: A work order is required for additional default parameters (strictly for tracking purposes). 

Default Parameters on the Detail Tab of the Wrappers Screen

Back to Top
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Add a Parameter

To add a parameter using the Detail tab of the Notification Wrappers screen:

1. Upload a wrapper onto the Detail tab or create and save a new wrapper.

Wrapper Uploaded onto the Detail Tab

2. Click on the <Add Parameter> button to open up a new line in the Parameter list view.
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<Add Parameter> Button

3. Enter the new parameter in the Parameter column and the value for that parameter in the Value

column. Note: Make sure to begin your parameter with a hashtag (#).
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New Parameter Added

4. You can now begin to use the new parameter in your wrapper templates.

Back to Top

Delete a Parameter

To delete a parameter using the Detail tab of the Notification Wrappers screen:

1. Upload a wrapper onto the Detail tab or create and save a new wrapper.
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Wrapper Uploaded onto the Detail Tab

2. Select the parameter that you want to delete in the Parameter list view. Note: You cannot delete

default parameters.

3. Click <Delete Parameter>.
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Select Parameter to Delete

4. The parameter is deleted and removed from the Parameter list view.
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Parameter Deleted

Back to Top

See also:

Detail Tab

Summary Tab

Notification Wrappers Screen Details

Notification Wrappers Screen
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